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Using the Primavera Cloud Service
Administrator's Guide

This guide has been specifically created for cloud administrators so that they do not need to use
the installation or configuration documents that are found in each of the Primavera product
libraries. For more information about the information options available to cloud administrators,
refer to For More Information (on page 227).

After cloud administrators receive their login credentials from Oracle, they should ensure that their
web browser is configured by using the tasks in Web Browser Setup Tasks. Then, cloud
administrators should create and provision users using the information in Identity & Access
Management Setup Tasks. After cloud administrators have completed the activities in Web
Browser Setup Tasks and ldentity & Access Management Setup Tasks, they should review the
setup tasks associated with the applications that are included in their Primavera Cloud Service.

This guide contains setup tasks and reference information for all of the Oracle Primavera
products, as well as information specific to the Identity Management & Access Suite, Bl Publisher,
and BPM. Each product is represented in this guide as a single chapter. Also, some products
might be listed as sub-chapters for other products in this guide; these sub-chapters represent
integrated solutions that have setup tasks specific to that integration (For example, P6 EPPM is
listed as a sub-chapter for Bl Publisher).
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Web Browser Setup Tasks

Features, such as exporting to Microsoft Excel and resolving null pointer exceptions, require
additional configuration settings on web browsers. Some settings are required for a feature to
work, while others are only necessary under certain conditions. You must configure your settings
on each web browser.

In This Section

Configuring Settings for Microsoft Internet EXplOrer...........coovvvviieiiieevvvieiieceee e, 10
Configuring Settings for Mozilla FirefoX ...........coovviiiiiiiiiie e 10
Configuring Settings for Apple Safari............cccciiiiis 11

Configuring Settings for Microsoft Internet Explorer

Note: Before you begin, ensure you are using the supported version of
Microsoft Internet Explorer. See the Tested Configurations document for
more information.

1) Open Microsoft Internet Explorer.

2) Goto Tools, Internet Options.

3) Inthe Internet Options dialog box, select the Privacy tab:
a. Inthe Pop-up Blocker section, deselect the Turn on Pop-up Blocker option.
b. Inthe Settings section, click Advanced.

c. Inthe Advanced Privacy Settings dialog box, deselect the Override automatic cookie
handling option.
d. Click OK to exit all dialog boxes.

Configuring Settings for Mozilla Firefox

Note: Before you begin, ensure you are using the supported version of
Mozilla Firefox. See the Tested Configurations document for more
information.

1) Open Mozilla Firefox.

2) Go to Open Menu, Options.

3) Inthe Options dialog box:
a. Select the Content tab.
b. Deselect the Block pop-up windows option.
c. Click OK.

10
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Configuring Settings for Apple Safari

Note: Before you begin, ensure you are using the supported version of
Apple Safari. See the Tested Configurations document for more
information.

1) Open Apple Safari.

2) From the Settings dropdown, select Preferences.

3) Inthe General dialog box, select Security.

4) Inthe Web Content section, deselect Block pop-up windows.
5) Close the dialog box.

11
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Oracle Identity and Access Management Setup
Tasks

Oracle Identity & Management (IDM) is the term used to describe the identity management
applications that you use to manage users in your cloud environment.

The following list describes all of the applications that are associated with IDM:

» Primavera Cloud Administration — Primavera Cloud Administration is the primary
application with which you will administer users in your cloud environment.

» Oracle Identity Manager (OIM) — OIM is an identity management application that can be used
for advanced administration tasks.

Note: Auditing and Reporting are not supported.

» Oracle Internet Directory (OID) — OID is the directory store that maintains users and groups.
All user information is stored in OID.

12
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Accessing Accounts

Depending on your company's cloud-environment configuration, you will be required to either log
in to the Primavera Cloud Portal through one of your company's web pages or through an
Oracle-provided, login webpage.

When a user logs in to the cloud environment for the first time, they will be required to reset their
password and to set their challenge questions. For more information about logging in to the cloud
environment for the first time, see Logging into an Account for the First Time (on page 13).
After a user logs in to the cloud environment, they will be redirected to the the Primavera Cloud
Portal. For more information about the Primavera Cloud Portal, see About the Primavera Cloud
Portal (on page 14).

Logging into an Account for the First Time

When users log in to the Primavera Cloud Portal for the first time using their usernames and
temporary passwords, which are provided to them by a cloud administrator, they must reset their
passwords and set their challenge questions.

Unless otherwise specified, passwords must adhere to the following default password policy:

A password can contain the following character types as long as it has met the minimum character
requirements:

English Uppercase Characters (A-Z)

English Lowercase Characters (a-z)

Base 10 Digits (0-9)

Non-alphanumeric Characters (for example, !, $, #, or )

Unicode Characters

The minimum password character requirements require a minimum of eight characters that
include at least:

» Two alphabet characters
» One Numeric Character
» One Alphanumeric Character
» One English Uppercase Character (A-Z)
» One English Lowercase Character (a-z)
» One Base 10 Digit (0-9)
A password cannot contain a user’s First Name, Last Name, or User ID.

v v v v Vv

A password expires after 180 days. A warning will be sent to a user 30 days before the expiration
date to remind them to change their password.

To log in to an account with new access information:

1) Navigate to the log in page with the link that has been provided to you by your administrator.
2) Enter your login credentials into the required fields.

3) Click Login.

4) Inthe Password Management page, update your password by doing the following:

13
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a. Inthe Old Password field, enter the password that is currently associated with your login
username.

In the New Password field, enter a new password.

In the Confirm New Password field, enter the password that you entered in the New
Password field.

5) Inthe Password Management page, register your challenge questions by doing the
following:
a. Inthe Question drop-down lists, select your challenge questions.
b. Inthe Answer fields, enter the answers to the corresponding questions.

6) Click Submit.

About the Primavera Cloud Portal

The Primavera Cloud Portal is the website with which you, and every active (enabled) user, will
use to access all of their relevant cloud content, which includes links to:

» Oracle Primavera applications, such as: Primavera Gateway, Oracle Primavera Prime, P6
Professional, P6 Team Member, P6 EPPM, Analytics, Primavera Unifier, and Primavera
Cloud Administration

» Oracle Fusion Middleware applications, such as: Bl Publisher, BPM, Oracle Business
Intelligence EE, and Oracle Identity Manager

» Web Services URLs
» Product tutorials
» Administration Documentation

Only the applications that your company licenses will display on the Primavera Cloud Portal. For
example, if your company has licenses for the P6 EPPM and Primavera Unifier applications, links
or content for Analytics, Oracle Primavera Prime, and other non-licensed applications will not
display in the portal.

Note: All of the users that have been created in your cloud environment,
regardless of provisions, will be able to view and click on the links to each
application, tutorial, or documentation. However, users must be assigned
the correct roles and account instances to access and use an application.
For more information about the roles and account instances needed for
each application in your cloud environment, see About Provisions (on
page 25).

14
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Using Primavera Cloud Administration

Primavera Cloud Administration is the main application with which you perform the following
administrative tasks:

» Create new users

» Provision users

» Deprovision users

» Unlock users

» Reset passwords

» Disabling Users

» Enabling Users

» View user information

» View user provisioning assignments
Primavera Cloud Administration contains a table and a details pane. You can perform all of the
administrative tasks (except for viewing user provisioning assignment) with the table. You can use
the details pane to view provisioning assignments for each user in the table. For more information
about the table and the details pane, refer to the following sections:

About the Table

About Importing Users (on page 18)
For more information about Primavera Cloud Administration, its features, and its procedures, see

the 5 Minutes with Oracle Primavera Cloud - Managing Users with the Administration Application
15.2 at https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.be.

About the Table

The table facilitates the creation of new users in the cloud. You can add new users in the first row
of the table one at a time, import them in bulk to the table, and edit the fields that are associated
with them in the table. If you log out of a session of Primavera Cloud Administration before you
save new users to the cloud, any information that was added to the table during that session will
be removed from the table. For more information on how to save a draft of your work,

see Exporting Changes from the Table (on page 22).

The table also displays all of the users that have been previously created in the cloud. You are
unable to edit the fields associated with created users in the table. For more information regarding
the procedures that are associated with editing user information, see Advanced Identity
Management Tasks (on page 35).

Each row in the table represents a single user and the columns in the table represent the
information that is associated with each user. For more information about each column in the
table, see the table below.

Column Name Description

Last Name The last name of the user.

15
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First Name The first name of the user.
Email The email address of the user.
User Name The user name with which a user logs in to the cloud.

Organization

The organization to which the user belongs.

User Type The type of user in the system. By default, all users are set to
Employee when they are added to the table.
Provisions The roles and or accounts that are associated with the user.

Date and Time Added

The date and time on which the user was successfully created.
The format of the date is Month - Day - Year.

Added By The user name of the administrator that created the user.

Last Action The last action applied to the user as well as the date at which
the action. The format of the date is: Month - Day - Year.

Status The status of the user. By default, users do not have a status in

the table until you attempt to save them to your cloud
environment.

If the status is Success, the user was successfully saved to your cloud
environment. Users that have been successfully saved to you cloud
environment and provisioned are able to access the applications to which
they have been provisioned.

If the status is Application provisioning failed, the user was saved to the cloud
environment but was not provisioned.

If the status is User creation failed, then the user was not saved to the cloud
environment.

16
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Use the following topics in the Primavera Cloud Administration Tasks (on page 22) to create
and provision users by manually adding them to the table:

1) Creating a User with the Table (on page 22)
2) Provision your users using one of the following topics:
» Managing the Provisions of One User (on page 27)
» Managing the Provisions of Multiple Users (on page 28)
3) Saving Users to the Cloud (on page 31)
4) Resetting User Passwords (on page 33)

Note: For a demonstration on how to create and provision users, go to 5
Minutes with Oracle Primavera Cloud - Managing Users with the
Administration Application 15.2 at
https://www.youtube.com/watch?v=o0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Adding Users and
Managing Provisions.

Table Filters

By default, the table sorts users by the most recent date in the Date Added column. As you add
users to the table, those users appear in the rows at the top of the table in the order in which they
are added. After new users are created in the cloud, Primavera Cloud Administration sorts the new
users in the table depending on your sort settings.

You can filter which users that you want to view in the table with the four filters that are located
above the table. The filters are All, Unprovisioned, Modified, and Failed. The following list
describes the behavior of each filter:

All: The All filter displays every user that exists in the table; this includes users who have been
previously created in the cloud and the users that have been added to the current session of
Primavera Cloud Administration. After you save a current session of Primavera Cloud
Administration, the users that had been added to the table will be created in the cloud and they will
be sorted.

Unprovisioned: The Unprovisioned filter displays any user that has not been provisioned; this
includes users who have been previously created in the cloud, users that have failed to be
provisioned, and users that have been added to the current session of Primavera Cloud
Administration. After you save users with provisions, those users will not appear in this filter.

Modified: The Modified filter displays the users who have not been saved and users who have
had their data modified in a current session of Primavera Cloud Administration; this includes users
that are added to the table and previously created users who are assigned provisions. After you
save your session of Primavera Cloud Administration, the users that you added or assigned
provisions will not appear in this filter.

Failed: The Failed filter displays the users who have failed to be provisioned. If a user exists in
this filter, you can attempt to provision them again. For more information about how to reattempt a
provision that failed, see Reattempting Failed Provisions (on page 30).
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Disabled: The Disabled filter displays the users who have been disabled in the cloud
environments, which means that they will be unable to log in to any Oracle Primavera
Applications. If a user exists in this filter, you can enable their account so that they can access any
Oracle Primavera application for which they have been provisioned. For more information on how
to enable or disable users, see Enabling User Accounts (on page 33) or Disabling User
Accounts (on page 34).

Locked: The Locked filter displays the users who have been locked out of their accounts. If users
exist in this filter, you can unlock them. For more information on how to unlock users,
see Unlocking User Accounts (on page 32).

The Details Pane

The details pane shows you the provisioning assignments of users in the table and it appears
empty until you select a user. When a user is selected, you can alternate between the Roles tab
and the Application Instances tab to view all of the provisions assigned to the user. The Roles tab
displays the roles with which a user is assigned. The Application Instances tab displays the
account name and the provisioning status of assigned application instance. The status of an
application instance can either be Provisioned or Provisioning. After a user has been successfully
provisioned with an application instance, that application instance will show the Provisioned
status. If a user account is being processed or if the provision fails to be assigned to the user, the
application instance will have a status of Provisioning.

About Importing Users

Use a custom Microsoft Excel template to import multiple users into your cloud environment. You
can either import a custom import template or exported changes from a previous session.

The template is a CSV file that you can download from the Primavera Cloud Administration, add
user information and provisioning assignments locally, and then import that information to your
table. The following fields that appear in every template and are required for each user to be
added to your cloud environment:
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Column Name Description

Last Name The last name of the user.

First Name The first name of the user.

Email The email address of the user.

User Name The user name with which a user logs in to
the cloud.

Organization The organization to which the user
belongs.

User Type The type of user in the system. By default,
all users are set to Employee when they
are added to the table.

When you attempt to download the template, the Select Provisions for Template dialog box will
appear. You can use the Select Provisions for Template dialog box to add a column to your
template for each of the provisioning assignments that you select. Each column is associated with
a single provisioning assignment, has the same name as the role or application instance that it
represents, and is prepended with either #R# for role or #A# for application instance. For example,
if you selected the BlAuthors role and PrimaveraP6 application instance in the Select Provisions
for Template dialog box, two columns called #R#BIAuthors and #A#PrimaveraP6 will appear in
the template.

Caution: Do not modify the header row. Modifying the header row of the
template can produce unpredictable results when importing users into
Primavera Cloud Administration.

Use the following topics in the Primavera Cloud Administration Tasks (on page 22) to create
and provision multiple users by means of import:

1) Creating a Custom Import Template (on page 23)

2) Importing Users to the Table (on page 24)

3) Saving Users to the Cloud (on page 31)

4) Resetting User Passwords (on page 33)

Note: For a demonstration on how to import users, go to 5 Minutes with
Oracle Primavera Cloud - Managing Users with the Administration
Application 15.2 at
https://www.youtube.com/watch?v=o0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Importing Users in
Bulk.
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About Notifications

Notifications are brief updates about your work within the Primavera Cloud Administration. You
receive notifications after you attempt to save any changes that you have made to the cloud.
When you receive a notification, the title of the notification will appear bold in the Notifications list
until you open it. Once you open a notification, the title of the notification will become grayed out.

Note: You can only view notifications of the actions that have been made
with the account with which you access Primavera Cloud Administration.

Notifications let you view any attempts that you made to save table changes to the cloud. For each
notification, you can:

» the number of days since the notification was sent to the account.

» view the number of users that were saved to the cloud.

» view the number of users that failed to be saved to the cloud.

» export a log with the information about users who have failed to be saved to the cloud.
» download a log file that contains information about the saving process.

Use the following topics to learn more about the tasks that are associated with the Notifications
list.

Marking Notifications as Read

After you select a notification in the list, the notification will be expanded until you mark the
notification as read. Marking a notification as read minimizes the notification.

To mark a notification as read:

1) Click & View notifications.
2) Select an open notification.
3) Click Mark as Read.

Refreshing Notifications

Refreshing your notifications ensures that you are able to view all of the notifications that are
associated with your account that you have not deleted.

To refresh your notifications:

1) Click & View notifications.
2) Click C Refresh.
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Deleting a Notification

Deleting a natification permanently removes a notification from the Notifications list.
To delete a notification:

1) Click & View notifications.
2) Select a notification that you want to delete.
3) Click X.

Downloading the Log File

You can use the Primavera Cloud Administration log to view detailed information about the
processes that occur when you attempt to save users to the cloud. If a user fails to be provisioned,
you can use the log to try and determine why the user failed to be provisioned.

To download the Primavera User Administration log:

1) Click & View notifications.
2) Select the notification that corresponds to the log file that you want to view.
3) Click Download Log.

Exporting a List of Users that Failed to be Provisioned

You can export a CSV file called Primavera_Create_User_<date>_csvV that contains a list of
the users that have failed to be provisioned for each save attempt. The file contains all of the
information that is associated with the user, such as:

» Last Name

» First Name

»  Email

» User Name

» Organization

» Provisioning Assignments

Note: Do not modify any information in the CSV file other than
provisioning assignments. If you need to modify user information, refer
to Editing a User's Attributes (on page 35).

Use the CSV file to update user provisioning information, upload it back to the table, and retry to
provision the users. For more information about reattempting to provision users that have failed to
be provisioned, see Reattempting Failed Provisions (on page 30).

To export a list of the users that failed to be provisioned:

1) Click & View notifications.
2) Select a notification that has users that have failed to be provisioned.
3) Click Export Failed Users.
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Primavera Cloud Administration Tasks

The tasks in this section document all of the tasks associated with the table in the Primavera Cloud
Administration.

Note: While the sections below might reference a filter with regards to a
specific task, you can perform any task in any filter.

Creating a User with the Table

To create a user with the table:

1) Enter the user information in the first row of the table.
» Inthe Last Name field, enter the last name of the user.
» In the First Name field, enter the first name of the user.
» In the Email field, enter the email address of the user.
» Inthe User Name field, enter the username of the user.
» Double-click the Organization field and select an organization.
» Inthe User Type field, open the list and select a user type.
2) Provision the user.

For more information about provisioning users, refer to Managing the Provisions of One
User (on page 27) or Managing the Provisions of Multiple Users (on page 28).

3) Click Save. For more information about saving users, refer to Saving Users to the Cloud (on
page 31).

Note: For a demonstration on how to add users, go to 5 Minutes with
Oracle Primavera Cloud - Managing Users with the Administration
Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Adding Users.

Exporting Changes from the Table

You can save any changes that you have made to the table by exporting your changes to a CSV
file, which can be stored locally. The CSV file contains all of the information that you added to the
table during your current session of Primavera Cloud Administration. Later, when you open a new
session in Primavera Cloud Administration, you can import the changes that were stored in the
CSV file back into the table.

To save a draft of your progress:
1) Click Export Changes.

Note: The Export Changes button appears after you alter the contents of
the table for the first time in a new Primavera Cloud Administration
session.
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Creating a Custom Import Template

To create a custom import template:

1) Select Download Template... from the drop-down list.
2) Select the provision assignments that you want to add to the template.
» Use the Search field to find a specific provisioning assignment.

» Expand Roles and Application Instances to view the lists of roles and applications
instances.

3) Click > Add column to Selected Columns.
4) Click OK.

5) Save the template locally and then open it. By default, the name of the template
is Primavera_User_Import_Template.csv.

6) Enter the user's information into the following fields:
» First Name
» Last Name
» Email
» User Name
» Organization
» User Type

7) Inthe role or application instance fields, enter one of the following inputs to a provisioning
assignment field to add that provisioning assignment to the user:

» Y

» Yes
» yes
» 1

» true
» t

Alternatively, leave the field empty if you do not want to add the provisioning assignment to a
user.

8) Save the template.

Note: For a demonstration on how to import users, go to 5 Minutes with
Oracle Primavera Cloud - Managing Users with the Administration
Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Importing Users in
Bulk.
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Importing Users to the Table

To create users by importing them to the table:

1)
2)
3)
4)

24

Click Import....
Select your CSV file and then click OK.
Ensure that there are no errors in the table.

Save the users to the cloud. For more information about uploading users, refer to Saving
Users to the Cloud (on page 31).

Note: For a demonstration on how to import users, go to 5 Minutes with
Oracle Primavera Cloud - Managing Users with the Administration
Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Importing Users in
Bulk.
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About Provisions

Provisioning is the process by which you authorize specific employees in your organization to
access specific Primavera Cloud applications. Employees who are not provisioned to your Oracle
Primavera applications will not be able to access any of your Oracle Primavera applications.

The two types of provisions in Primavera Cloud Administration are roles and accounts. Users
need a combination of roles and accounts in order to gain access to certain Oracle Primavera
applications and functionalities within those applications. Refer to the following sections for
information about which roles and accounts are needed to access the different Oracle Primavera
applications and functionalities.

Note: In addition to being assigned roles and account instances for
application access in your cloud service, you must also provide
application-specific security assignments to your users in their target
application. For more information about application-specific security
assignments that are required to use a particular product, refer to the
application administration guide that is specific to the application for which
you are provisioning users.

Accounts
Access to P6 EPPM, P6 Professional, or Analytics requires users to have P6 Account Instance.

Access to Primavera Unifier or Analytics requires users to have Primavera Unifier Application
Instance.
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Roles

The following table contains a list of the Oracle Primavera applications and the roles that can be
assigned to users for each application:

Oracle Primavera Applications Roles
P6 EPPM BI Consumer
Bl Author

BPM Project Viewer
BPM Project Creator

P6 Professional Primavera Virtual Desktop User
Primavera Unifier Bl Consumer

Bl Author
Oracle Primavera Prime Primavera Users

Partner Users

Analytics p6rdbuser
Bl Administrator

Primavera Gateway Primavera Gateway Admin
Primavera Gateway Developer
Primavera Gateway User

Primavera Cloud Administration Primavera Cloud Admin

Role Descriptions

Bl Consumer: Users who are assigned this role can run and view all of the reports that were
made available to their folders.

Bl Author: Users who are assigned this role can create, run, and view all of the reports that were
made available to their folders.

Note: By default, data sources to product schema, such as P6 EPPM,
Oracle Primavera Prime, Primavera Unifier, are preassigned to the BI
Consumer and BI Author roles.
BPM Project Creator: Users have access to BPM and can read, write, and close BPM projects.
BPM Project Viewer: Users have access to BPM and can read BPM projects.
p6rdbusers: Users have access to Analytics and can run an ETL.
p6sec: Users have access to UCM for Primavera applications.
Primavera Users: Users who are assigned this role can log in to login to Oracle Primavera Prime.

Partner Users: Partner users who are assigned this role can log in to Oracle Primavera Prime.
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Primavera Gateway Admin: Users who are assigned this role have complete access to
Primavera Gateway as a user, developer, and administrator. Assign this role to create a
Primavera Gateway administrator with complete administration privileges and access to data.

Primavera Gateway Developer: Users who are assigned this role can create new providers for
Primavera Gateway and can customize delivered providers to support their ERP.

Primavera Gateway User: Users who are assigned this role can create, run, and monitor
synchronization jobs in Primavera Gateway. Assign this role to create Primavera Gateway users
with access to data.

Primavera Cloud Admin: Users who are assigned this role can log in to Primavera Cloud
Administration and can administer users.

Primavera Virtual Desktop User: Users who are assigned this role can log in to P6 Professional
using Primavera Virtual Desktop.

Managing the Provisions of One User

The Manage Provisions dialog box contains two columns. The left column contains all of the
roles and account instances that have not been assigned to a user and the right column
represents all of the roles and application instances that have been assigned to a user. When
provisioning a user, you will open the Manage Provisions dialog box, move roles and application
instances between the left column and the right column, and then save the modification.

Note: For a demonstration on how to manage user provisions, go to 5
Minutes with Oracle Primavera Cloud - Managing Users with the
Administration Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Managing Provisions.

Provisioning a User
To provision one user using the Select Provisions dialog box:

1) Select the checkbox of a user.
2) Open the Manage Provisions dialog box by completing one of the following:
» Click Manage Provisions.

Note: The Manage Provisions button appears when you select a
checkbox.

» Click £ Actions and then click Manage Provisions.
» Right-click the table and then click Manage Provisions.
3) Click ** Select.
4) Select the roles or application Instances that are applicable to the users.
5) Click > Add provisions to Selected Provisions.
6) Click OK.

7) Save the user to the cloud. For more information about saving a user, refer to Saving Users to
the Cloud (on page 31).
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Deprovisioning a User
To remove a role or application instance from a user:

1) Select the checkbox of a user.
2) Open the Manage Provisions dialog box by completing one of the following:
» Click Manage Provisions.

Note: The Manage Provisions button appears when you select at least
one checkbox.

» Click £ Actions and then click Manage Provisions.
» Right-click the table and then click Manage Provisions.
3) Click *** Select.
4) Select the Roles or Application Instances that that you want to remove from the user.
5) Click < Remove column from Selected Columns.
6) Click OK.

7) Save the user to the cloud. For more information about saving users, refer to Saving Users to
the Cloud (on page 31).

Managing the Provisions of Multiple Users

When managing the provisions of multiple users, you will use the Manage Provisions dialog box.
The Manage Provisions dialog box offers the following functionalities:

» View the users who have been provisioned with specific roles or application instances
» Add provisions to users
» Remove provisions from users

The Manage Provisions dialog box contains the Available column and the Users Provisioned
to table.

The Available column contains all of the available roles and application instances that are
associated with your cloud environment. Depending on the number of users whom you had
selected prior to opening the Manage Provisions dialog box, the following icons will display next
to a role or application instance name:

» @ All Users Provisioned: All of the previously selected users have been provisioned with
the role or application instance.

» & Provision Selected Users: A number of users, less than all of them, that have been
provisioned with the role or application instance.

Note: For a demonstration on how to manage user provisions, go to 5
Minutes with Oracle Primavera Cloud - Managing Users with the
Administration Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.be,
click Show More in the description, and then click Managing Provisions.
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Provisioning Multiple Users

To provision multiple users:

1)
2)

3)
4)

5)
6)

Select two or more users in the table.
Open the Manage Provisions dialog box by completing one of the following:
» Click Manage Provisions.

Note: The Manage Provisions button appears when you select at least
one checkbox.

» Click £ Actions and then click Manage Provisions.

» Right-click the table and then click Manage Provisions.

In the Available Provisions column, select the role or application instance that you want to
assign to the selected users.

In the Select or Deselect Users table, select the check boxes of the users whom you want to
provision.

Click Ok.

Save the user to the cloud. For more information about saving a user, refer to Saving Users to
the Cloud (on page 31).

Deprovisioning Multiple Users

To deprovision multiple users:

1)
2)

3)
4)

5)
6)

Select two or more users in the table.
Open the Manage Provisions dialog box by completing one of the following:
» Click Manage Provisions.

Note: The Manage Provisions button appears when you select at least
one checkbox.

» Click £ Actions and then click Manage Provisions.
» Right-click the table and then click Manage Provisions.

In the Available Provisions column, select the role or application instance that you want to
remove from the selected users.

In the Select or Deselect Users table, deselect the check boxes of the users whom you want
to deprovision.

Click Ok.

Save the user to the cloud. For more information about saving a user, refer to Saving Users to
the Cloud (on page 31).
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Reattempting Failed Provisions

If users are unable to receive their provisioning assignments after you save the provisioning
assignments that you made in a current session of Primavera Cloud Administration, you can
attempt to provision them again.

Users might fail to be provisioned if they are assigned a provision that is not available to their
assigned organization, they are Primavera Unifier users who have been assigned provisions that
do not exist for a company, or if there is an issue connecting to either OID or OIM. For more
information about why a user might not be provisioned, refer to

To reattempt to provision users:

1) (Optional) Determine why users have failed to be provisioned, modify the incorrect
information, and upload them back to the table.

a.

b.

c.
d.

e

Review the log files for the save attempt in which the users failed to be provisioned. For
more information, refer to Downloading the Log File (on page 21).

Download a list of the users that have failed to be provisioned. For more information, refer
to Exporting a List of Users that Failed to be Provisioned (on page 21). Alternatively,
you can modify provisioning assignments in the table.

Modify the incorrect provisioning assignments and then save the CSV file.
Click Import... and then select the CSV file that you want to import back into the table.
Click OK.

2) Click Failed.
3) Select the check boxes of the users whom you want to try to provision.
4) Click Retry Provision.
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Notes:

= |f users fail to be provisioned because they are assigned a provision
that is not available to their assigned organizations, you can change
their organizations in OIM to an organization in which the provisioning
assignments are applicable to them. For more information about
editing user information, see Editing a User's Attributes (on page
35).

= [f users continue to fail to be provisioned after you have determined
that they are assigned to the correct organization or have been
assigned provisions that do not exist for a company, submit a Service
Request in My Oracle Support (MOS).
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Saving Users to the Cloud

After users have been added to the table with their user information and provisioning assignments,
you can save them to the cloud. Users that are saved to the cloud can access their provisioning
assignhments.

To save users:
1) Click Save.

Note: Enable the Save button by provisioning a user or adding a new user
to the table.

Deleting Users from the Table

You can only delete users if they have not been saved to the cloud.
To delete one user:

1) Select a user account.
2) Click % Actions.

3) Select Delete Row.
4) Click Yes.

To delete two or more users:

1) Select the check boxes of the users whom you want to delete.
2) Click % Actions.

3) Select Delete Rows.

4) Click Yes.

Using Cancel
The Cancel button resets all of the progress that you have made in the table that has not been
uploaded to Oracle Identity Manager during your current session.

For example, if you start a new session in Primavera Cloud Administration, add 50 new users to
the table, and then cancel your actions, all of the progress that you made in the table will be reset
and the table will be empty. However, if you start a new session in Primavera Cloud
Administration, add 50 new users and then save them, add 10 more users to the table, and then
cancel your actions, the 10 users that you added to the table after you have saved the 50 users to
the cloud will be removed from the table.

To cancel your progress:
1) Click Cancel.

Note: The Cancel button becomes enabled after you edit the table for the
first time.

2) Click Yes.
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Unlocking User Accounts

When user accounts become locked, users will be unable to log in to any of their applications until
an administrator unlocks them.

The most common reasons why users become locked out of their accounts are that they attempt
to log in with an incorrect password too many times or they do not reset their password and let it
expire.

Note: Users who let their password expire can unlock themselves by
attempting to log in to their account with their expired password.

To unlock user accounts:

1) Use the check box in the header row to deselect all users.
2) Click the Locked filter.

3) Navigate to the users that you want to unlock.

4) Select the checkboxes of the users.

5) Click Unlock.

Notes:

= The Unlock button appears when you select at least one checkbox.

= If you select the accounts of locked and unlocked users at the same
time, then the Unlock button will not appear.

= For a demonstration on how to unlock user accounts, go to 5 Minutes
with Oracle Primavera Cloud - Managing Users with the
Administration Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.b
e, click Show More in the description, and then click Unlocking
Users.
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Resetting User Passwords

You can reset user passwords using Primavera Cloud Administration. When a user password is
reset, an email will be sent to the user with a temporary password. Upon using a temporary
password to log in with Oracle Access Manager, users are required to update their passwords.

After you create new users for your cloud service, you must reset those users' passwords in order
to notify them of their account and to supply them with a temporary login password. When users
log in to an application for the first time using their temporary password, they must set their
challenge questions in addition to updating their passwords.

To reset user passwords:

1) Use the check box in the header row to deselect all users.

2) Select the check boxes that are associated with the users whose passwords you want to reset.
Alternatively, you can select all available users by selecting the check box next to the First
Name column header.

Note: There is no confirmation message for resetting passwords. Ensure
that you want to reset the passwords of all of the selected users.

3) Click Reset Password.

Enabling User Accounts

When you enable user accounts, you let the users that are associated with those accounts to
access their applications. Users that have been enabled will no longer appear in the Disabled
filter.

To disable a user account:

1) Use the check box in the header row to deselect all users.
2) Click the Disabled filter.

3) Navigate to the users that you want to enable.

4) Select the check boxes of the users.

5) Click Enable.

Notes:

= The Enable button appears when you select the check box of a
disabled user account.

= |f you select an enabled user account while you have disabled user
accounts selected, the Enable button will not appear.
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Disabling User Accounts

When you disable user accounts, the users that are associated with those accounts will not be
able to be authenticated during log in and they will be unable to access their applications.

Users that are disabled will appear in the Disabled filter and will have the
To disable a user account:

1) Use the check box in the header row to deselect all users.
2) Navigate to the users that you want to disable.
3) Select the check boxes of the users.

Note: There is no confirmation message for disabling users. Ensure that
you want to disable all of the selected users.

4) Click Disable.

Notes:

= The Disable button appears when you select the check box of an
enabled user account.

= |f you select a disabled user account while you have enabled user
accounts selected, then the Disable button will not appear.

= For a demonstration on how to disable users, go to 5 Minutes with
Oracle Primavera Cloud - Managing Users with the Administration
Application 15.2 at
https://www.youtube.com/watch?v=0p8VpaCSmgU&feature=youtu.b
e, click Show More in the description, and then click Disabling
Users.
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Advanced Identity Management Tasks

The information in this section is specific to the Oracle Identity Manager application. Use this
section if you need to do one of the following tasks:

» Modify user information

» Reset challenge questions

Note: The system takes an additional five minutes to process actions in
Oracle Identity Manager once they have been completed. For example, if
you unlock a user's account and they attempt to log in to their account
before waiting five minutes, they can lock their account again.

To log into Oracle Identity Manager:

1) Log in with Oracle Access Manager.

2) Inthe Primavera Cloud Portal, under Oracle Fusion Middleware, click Oracle Identity
Manager.

Editing a User's Attributes

To edit a user's attributes:

1) Loginto OIM as an administrator.
2) In Identity Self Service, under Administration, click Users.
3) Search for the user whose attributes you want to modify.
4) Select the user in the search results table.
5) Modify the user with one of the following ways:

» Click Edit on the toolbar.

» Select Edit from the Actions menu.

» Click the user login of the user record that you want to edit and then click Modify User on
the toolbar of the User Details page.

6) Inthe Modify User page, change the values of the attributes that you want to edit.
7) Click Submit.

Note: Changing a user's Organization or User Login can result in
provisioning errors that will prevent the user from accessing their account.
Oracle recommends that you do not change a user's User Login or
Organization.

The following list includes the name of the fields in the sections that appear on the Modify User
page as well as a description for each field:

Justification and Effective Date

» Justification: Justification for creating the user.

» Effective Date: Date on which the user must be created.
Basic User Information
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First Name: First name of the user.

Middle Name: Middle name of the user.

Last Name: Last name of the user.

Email: Email address of the user.

Manager: The reporting manager of the user.

Organization: The organization to which the user belongs. This is also known as the home
organization.

User Type: The type of employee, such as consultant, contractor, contingent worker,
employee, full-time employee, intern, non-worker, other, part-time employee, or
temporary.

Display Name: It can have localized values, which can be added by clicking Manage
Localizations, and selecting from a list of languages. Display Name is available in 33
languages.

Account Settings

4

4

4

User Login: The user name to be specified for logging in to the Administration Console.
Password: The password to be specified for logging in to the Administration console.

Confirm Password: Re-enter the password to be specified for logging in to the
Administration console.

Account Effective Dates

4

4

Start Date: The date when the user will be activated in the system.
End Date: The date when the user will be deactivated in the system.

Provisioning Dates

4

4

Provisioning Date: Date when user is provisioned into the system.
Deprovisioning Date: Date when the user is deprovisioned from the system.

Contact Information

4

4

4

4

4

Telephone Number: The telephone number of the user.
Home Phone: The telephone number of the user's residence.
Home Postal Address: The postal address of the user's residence.
Fax: The fax number of the user.

Mobile: The mobile number of the user.

Pager: The pager number of the user.

Postal Address: The postal address of the user.

Postal Code: The postal code number of the user's address.
PO Box: The post box humber of the user's address.

State: The state name of the user.

Street: The street name where the user resides.

Country: The country where user resides.

Locale: The locale code of the user.

Other Attributes

4

4

Timezone: The timezone of the user.
Common Name: The common name of the user.
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» Department Number: The department number of the user.

» Employee Number: The employee number of the user.

» Generation Qualifier: Whether the user qualifies the generation.
» Hire Date: The hiring date of the user.

» Locality Name: The name of the locality where user resides.

» Initials: The initials of the user.

» Title: The title for the user.

Resetting Challenge Questions

Users can log in to Oracle Identity Manager (OIM) to update or change their challenge questions.
To change your challenge questions:

1) Log into OIM with your username and password.
2) In Identity Self Service, under My Profile, click My Information.
3) Inthe My Information page, expand Challenge Questions.
a. Inthe Question menus, select your challenge questions.
b. Inthe Answer fields, enter an answer for each question.
4) Click Apply.
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Changing a Password

Any user can log in to Oracle Identity Manager (OIM) to change their password.

Unless otherwise specified, passwords must adhere to the following default password policy:

A password can contain the following character types as long as it has met the minimum character
requirements:

English Uppercase Characters (A-Z)

English Lowercase Characters (a-z)

Base 10 Digits (0-9)

Non-alphanumeric Characters (for example, !, $, #, or %)

Unicode Characters

The minimum password character requirements require a minimum of eight characters that
include at least:

» Two alphabet characters
» One Numeric Character
» One Alphanumeric Character
» One English Uppercase Character (A-Z)
» One English Lowercase Character (a-z)
» One Base 10 Digit (0-9)
A password cannot contain a user’s First Name, Last Name, or User ID.

v v v v Vv

A password expires after 180 days. A warning will be sent to a user 30 days before the expiration
date to remind them to change their password.

To change your password:

1) Log into OIM with your username and password.
2) In Identity Self Service, under My Profile, click My Information.
3) Inthe My Information page, expand Change Password.

4) Inthe Old Password field, enter the password that is currently associated with your login
username.

5) Inthe New Password field, enter the new password that you want associated with your login
username.

6) Inthe Confirm New Password field, enter the password that you entered in the New
Password field.

7) Click Apply.

Note: Wait five minutes before logging into an account after you have
reset your password.
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Removing User Accounts

In the Accounts tab of the User Details page, you can remove accounts from a user.
To remove accounts from a user:

1) Loginto OIM as an administrator.
2) In Identity Self Service, under Administration, click Users.

3) Search for the user from whom you want to remove a role and then click that user's login
name.

4) Open the Accounts tab.
5) Search for the account or accounts that you want to remove from the user.

6) From the Actions menu, select Remove. Alternatively, you can click Remove Accounts from
the toolbar.

7) Inthe Catalog tab, select one or more roles.
» If you select one account, click Add to Cart.
» If you select more two or more accounts, click Add Selected to Cart.
8) (Optional) To remove one or more accounts from your cart:
a. Click Edit.
b. In the Request Cart dialog box, do one of the following:
= Click Remove to remove a single account.
= Click Remove All to remove all of the accounts in your cart.

c. If you want to continue to choose the accounts that you want to remove, close the Request
Cart dialog box.

9) Click Checkout.
10) Click Submit.

Creating Partner Companies and Partner Users

Prerequisites
» The Customer has a "partner admin" user login in order to be able to create partner
companies.

» The username and password have been included in the Welcome letter sent to new
Customers.

» Customers have active Company Admin Login.

Note: If you have not received a partner username and password, you
can submit a Service Request in My Oracle Support.
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Creating a Partner Company

You must create the partner company in Unifier and a matching organization in OIM, starting with
Unifier. The OIM organization should match the partner company short name in Unifier.

To create a partner company in the cloud:

1) Create a partner Company.
a. Login to the Unifier with PARTNERADMIN user credentials.
Click Companies.
Click New.
Enter details in General and Address tabs.
For Status, select Active in the General tab.
f. Click Apply to create a new partner Company.
2) Add the partner Company to a base Company.
a. Select the appropriate base Company.
b. Click Open.
c. From the left Navigator, click Partner Companies.
d. From the log, click Add to open the Add Partner Companies window.
e. Select the partner Company and click Add Member.
3) Associate the new partner Company with the base Company.
a. Login to Unifier as Company Administrator.
b. Click the Company Workspace tab.
Switch to Administration Mode (Admin Mode).
From the left Navigator, click Partner Companies.
From the log (right-hand pane), click Add to open the Add Partner Companies window.
f. Select the partner Company and click Add Member.
4) Add the new partner organization to OIM.
a. Log into Oracle Identity Self Service as an administrator.
b. InIdentity Self Service, under Administration, click Organizations.
c. Click Create and then complete the following in the Create Organization tab:
1. Inthe Organizational Name field, enter a name.

®oo0oco

® oo

Note: Ensure that the Organization Name field contains the same value
as the one you entered in the Short Name field in Unifier (General tab).
See Creating a Partner User (on page 41).

2. In the Type drop-down list, select Company.
3. Click “ Search and then complete the following:
a. Click Search.
b. Select the organization under which other partner organizations exist.
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Caution: Setting a parent organization to Top can prevent you from
creating that organization and can result in unexpected errors

c. Click Select.
d. Click Save.

The new partner Company has now been created in both Unifier and OIM.

Creating a Partner User

You must create the partner company in both Oracle Identity Manager and Primavera Unifier,
starting with Primavera Cloud Administration.

To create a partner User in OIM:

1) Create a new user account.
For procedures to create individual user accounts, see Creating a User with the Table (on
page 22).
For procedures to bulk import user accounts, see Creating a Custom Import Template (on
page 23).

2) Provision the new user with the necessary account and roles for Primavera Unifier. For

information about provisioning users, see About Provisions (on page 25) and Managing the
Provisions of One User (on page 27).

3) Add the partner user to Unifier.
a. Login to Unifier as a company administrator.
b. Click the Company Workspace tab.
Switch to Administration Mode (Admin Mode).
From the left Navigator, open User Administration and then click Partner Users.

From the log (right-hand pane), click Partner Users to open the User/Group Picker
window.

f. From the List Names From drop-down list, select the new partner Company that you have
created.

g. Select the partner user and click Add.
h. Click OK to close the window.

® oo

The new partner User appears in the Partner Users log and is now added to the partner Company
as one of the partner Users.
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Actions that Require Service Requests

In order to complete the following actions, submit a Service Request in My Oracle Support:

4
4

42

Changing the default password policy to match your corporate password policy.

Modifying the automatically-generated email notification that is sent to users when their
account is provisioned or their password is reset.

Changing the Authorization Codes in an application.

Note: If you change the Authorization Code in your application and do not
submit a Service Request in My Oracle Support, you will experience
provisioning errors.

Changing PARTNER license counts and allocations.
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Enabling Identity Federation with Oracle Primavera

Identity federation enables companies to provide services and share identity information across
their respective security domains. The end user does not need to log in again to access a remote
entity where business is conducted. Users authenticate at their local sites, and the federation
mechanism enables this information to be shared with their Primavera Cloud Service.

The benefits of implementing identity federation for your cloud service include:

» Users do not need to supply login credentials to access each entity where business is
conducted. This also eliminates the need to remember and manage multiple
logins/passwords. Users still need accounts at the sites so that the accounts can be linked.

» Local password management (for example, resetting passwords and creating password
policies)

For more information about enabling identity federation for your cloud service, refer to Enabling
Federated Identity Single Sign-On (SSO) Through SAML 2.0 For Primavera Products Hosted In
Oracle Cloud (Doc ID 2087067.1) at My Oracle Support.
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Oracle Primavera Prime Setup Tasks

There are no additional setup tasks that you need to complete before you begin to use Oracle
Primavera Prime. For more information about using Oracle Primavera Prime, refer to the following
sections of the Oracle Primavera Prime product library at
http://www.oracle.com/technetwork/documentation/default-2172536.html.

» Administration (except for the System Administrator's Post Installation Guide)
» User Guides

» Help

» Integration Documentation
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Primavera Unifier Setup Tasks

There are no additional setup tasks that you need to complete before you can begin to use
Primavera Unifier. For more information about using Primavera Unifier, refer to the following
sections of the Primavera Unifier product library at

http://www.oracle.com/technetwork/documentation/default-1870233.html

» User Documentation
» Database Documentation
» Integration Documentation
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P6 EPPM Setup Tasks

In this chapter you will find information about all of the P6 EPPM applications and the necessary

tasks that you should complete to setup each application before users should begin to use each

application. Also, you will find information on how to setup and configure on-premises instances of
WebLogic for eventing and Primavera Risk Analysis for analyzing project risks.

After you have reviewed the content in this chapter and completed any necessary tasks, refer to
the most recent P6 EPPM User Library on Oracle Technical Network at
http://www.oracle.com/technetwork/documentation/primavera-093289.html fore more information
on how to configure user accounts and security within the P6 EPPM applications and how to use
the applications.

In This Section
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About P6 EPPM

Oracle Primavera P6 Enterprise Project Portfolio Management (P6 EPPM) is a robust and
easy-to-use integrated solution for globally prioritizing, planning, managing, and executing
projects, programs, and portfolios. It optimizes role-specific functionality to satisfy each team
member's needs, responsibilities, and skills. It provides a single solution for managing projects of
any size, adapts to various levels of complexity within a project, and intelligently scales to meet the
needs of various roles, functions, or skill levels in your organization and on your project team.

Depending on your organization's specific deployment, P6 EPPM generally consists of the
applications, functions, and databases depicted below.

P6 EPPM

Application Layer P6 Web P6 Team Member Web Services re

Mobile Web E-Mail ~ Professional
| g/ ‘—g/ —L <3 5/

Cloud Infrastructure

Functional Layer

Core Enterprise Functionality Live or controlled updates
I and timesheet entry

Pro

Reports  workflows D Integrated
Enterprise Data Services
Projects
Planning & Scheduling
Portfolios
Resources

Database Layer

gicls ~

P& EPPM

Thousands of companies rely on P6 EPPM to:

Plan, schedule, and manage the right strategic mix of projects
Make informed project, cost, and resource management decisions
Enhance team collaboration and workflow productivity

Maximize each project contributor's skills and responsibilities
Track progress and optimize capacity for maximum profitability
Deliver programs and projects on time and within budget

v v v v v Vv
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» Share data with human capital, financial management, and enterprise resource planning
systems

This deployment of P6 EPPM is hosted, deployed, and maintained by Oracle on the cloud; as a
result, typical deployment and system administration tasks that system administrators were
required to perform on premises deployments, such as creating databases, hosting servers,
configuring supporting technologies, and integrating supported applications, are almost entirely
facilitated by Oracle.P6 EPPM Applications on the Cloud

P6 EPPM Applications on the Cloud:
The following applications are included with the deployment of P6 EPPM Cloud:

P6: Most users will rely almost exclusively on the P6, which is the primary interface for
administering and managing projects.

P6 mobile: Allows team members to provide status on their tasks and to enter timesheets while
working "on the go".

P6 Team Member Web: This web interface allows team members to provide status on their tasks
and record time in timesheets.

P6 Team Member E-mail Statusing Service: This method allows team members to provide
status on their tasks using any HTML or plain text e-mail application.

P6 Professional for EPPM: The P6 web application is the main interface for all project
management functionality. You can also use the P6 Professional software to take advantage of its
core project planning and scheduling functionality. The P6 Professional application and its
features, including P6 Visualizer, run on Microsoft Windows. P6 Professional is also available for
users who need to work on their projects in an offline mode. P6 Professional is available for P6
EPPM users working in a Cloud environment.

P6 Professional Cloud Connect: Connects P6 Professional to an EPPM Oracle database on the
cloud. P6 Integration API (in remote mode) is installed by default. Using this, P6 EPPM users
working on a WAN environment can achieve performance levels comparable to compression
server installation. This is optional for on premises users.

P6 EPPM Web Services: P6 EPPM Web Services is an integration technology that extends P6

business objects and functionality. Based on open standards, including SOAP, XML and WSDL,

P6 EPPM Web Services enables developers to leverage standard interfaces to create integrated
software solutions that interoperate with a wide variety of enterprise software applications running
on a diversity of hardware and operating system platforms.

Oracle Identity Manager (OIM): OIM is an enterprise identity management system that centrally
administers user accounts and access privileges.

Bl Publisher: Bl Publisher gives you the ability to run and schedule reports in P6.

Optional Applications Delivered with P6 EPPM Cloud
The following applications can be included as optional components of P6 EPPM Cloud.

Primavera Gateway: Primavera Gateway is a highly configurable application that integrates P6
EPPM with other products for increased risk and scope management.
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User Productivity Kit (UPK): UPK is an application that can connect with P6 EPPM and allow
users to create instructions (tutorials) to demonstrate how to perform certain tasks.

Oracle Business Process Management (BPM): BPM enables you to initiate and manage
workflows.

Oracle AutoVUE: Oracle AutoVUE provides native document viewing, markup and real-time
web-based collaborative capabilities when integrated with WebCenter Content.

Oracle WebCenter Content Core Capabilities (WCCC): WCCC uploads and stores documents
to the WCCC database, categorizes documents within folders, enables version control for
documents, and allows you to review documents.

Integrated Solutions

P6 EPPM Cloud has the ability to integrate itself with other cloud applications. The following list
represents all of the currently supported integrations:

P6 EPPM and Primavera Gateway

P6 EPPM and Analytics

P6 EPPM and Primavera Unifier

P6 EPPM and Oracle Primavera Prime
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P6 Setup Tasks

There are no additional setup tasks that you need to complete before you can begin to use P6.
Refer to the P6 EPPM Application Administrator's Guide for more information about security,
assigning privileges to users, and configuring settings. However, if you want to configure eventing
for P6, refer to Configuring Eventing For P6 (on page 51).

In This Section

Configuring EVENENG FOI PO ....ovniieiiieie ettt ettt et e et e e e e e eans 51

Configuring Eventing For P6

Events can be triggered by changes that take place in the P6 database. These events can be
classified into two types of events:

» Business object events: Triggered when P6 is used to update or create objects in the P6
database.

» Special operation events: Triggered when a supported operation or job service is invoked.

When a change triggers an event, the P6 Event Notification system sends the event message to a
your configured message queue. You could, for example, launch an external workflow based on
the existence of a specific event.

Note: The content in this section details optional configuration for P6. You
do not need to configure eventing for P6 in order to enable P6 for users to
work in the application.
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Event Triggers
An event may be one of two types, a business object event or a special operation event.

» See Business Object Events for a list of business object events.
» See Special Operation Events for a list of special operation events.

Changes that trigger events

With the exception of the Timesheet object, create and update changes made to supported
objects using P6, P6 EPPM Web Services, or the P6 Integration API will trigger an event. When a
status change is made to a Timesheet object using P6, a TimesheetUpdated event will be
triggered.

Changes that do not trigger events
The following create and update changes do not trigger events:

» Create and update changes made to objects that do not support events

» Create and update changes made to objects that support events but are not configured to
send events

» Changes made in P6 Professional

Additionally, an event is triggered when you run either the Apply Actuals
or Summarize Job service from P6 Professional. Receiving either of
these events depends on administrative settings and requires that P6, P6
EPPM Web Services, or the P6 Integration APl is running on the same
database as P6 Professional.
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About the Event Messages

P6 sends the event messages to the the JMS queue in an xml format.

Sample Business Object Event Message

Sample ActivityCreated Messsage: When an activity is created, the system sends an
ActivityCreated message similar to the following message:

<?xml version="1.0" encoding="UTF-8"?>
<MessagingObjects xmIns="http://xmIns.oracle.com/Primavera/P6/V8.2/Common/Event"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<ActivityCreated>
<ld>Auto-1</Id>
<Objectld>125500</Objectld>
<ProjectObjectld>11840</ProjectObjectid>
<WBSObjectld>36320</WBSObjectld>
</ActivityCreated>
</MessagingObjects>

Sample ActivityUpdated Messsage: When an activity is updated, the system sends an
ActivityUpdated message similar to the following message:

<?xml version="1.0" encoding="UTF-8"?>
<MessagingObjects xmIns="http://xmIns.oracle.com/Primavera/P6/V8.2/Common/Event"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<ActivityUpdated>
<ld>Auto-1</ld>
<Name>t2</Name>
<Objectld>125500</Objectld>
<ProjectObjectld>11840</ProjectObjectld>
<WBSObjectld>36320</WBSObjectld>
<NewValues>
<Name>t2</Name>
</NewValues>
<OldVvalues>
<Name>Auto-1</Name>
</OldVvalues>
</ActivityUpdated>
</MessagingObjects>
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Validating Event Notification with Oracle

After you have successfully configured WebLogic for cross domain eventing and shared the
relevant information with Oracle, you should test event notification to ensure event messages are
sent when an event occurs.

To test event notification:

1) Open P6 and create a project.
2) In P6:
a. Add one or more activities to the project.
b. Summarize the project to test if an event is generated.

3) Launch the WebLogic Administration Console to verify that the event is generated and sent
to the queue.

4) In the WebLogic Administration Console, expand Services/Messaging and click JIMS
Modules in the Domain Structure pane.

5) Onthe JMS Modules page, click the module you created for the remote server.
6) On the Settings page for the module, click the queue you created for the remote server.
7) On the Settings page for the queue, click the Monitoring tab.

8) On the Monitoring tab, select the option for the remote server destination you created and
click Show Messages. The event message should be visible in the JMS Messages list.
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Configuring Your Environment to Support Event Notification

Prerequisites to Receive P6 Events

Configuring WebLogic JMS Servers to Receive P6 Events

You will need to install and configure WebLogic to receive P6 events as JMS messages from your
Oracle Primavera cloud deployment. For supported versions, see Tested Configurations. For
more information about how to install WebLogic, see the following URL:
http://www.oracle.com/technetwork/middleware/weblogic/documentation/index.html

Note: If you are using WebLogic 11g (10.3.6), you must download and
apply the following patches from My Oracle Support:

= 09923849
= 20181997

For information on how to apply your WebLogic patches, see the readme
that is located in the respective patch zip file.

After you have installed WebLogic, you must configure your administration server, managed
servers, and clusters.

Sharing Configuration Information between Domains
To enable cross domain eventing, the following information must be shared with Oracle:

DNS URL

JMS queue name

JMS connection factory name

JNDI connection factory name

JMS module security credentials

Weblogic domain server credentials that establish trust with the Oracle
<OP_ProdName_P6_Web cloud environment

» Username and password of the WebLogic domain administrator to connect the JMS servers
from the Oracle <OP_ProdName_P6_Web cloud environment

v v v v v Vv

Configuring your Environment

If you would like to receive notification when events occur, you must configure the JMS message
queue to receive P6 events.

To configure your environment to support notification:

1) Configure the WebLogic message queue:

a. Target the JMS server to a migratable target. See Targeting the JMS Server to a
Migratable Target. (on page 57)

b. Configure the WebLogic message queue. See Configuring the WebLogic Message
Queue (on page 58).
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Configuring Cross-Domain WebLogic Credentials

1)

2)
3)
4)
5)
6)

7)
8)
9)

Log in to the WebLogic Administration Console with the following URL:
http://<host_name>:<port>/console

In the Change Center pane, click Lock & Edit.

In the Domain Structures pane, click the name of the domain.

Open the Security tab and then open the General tab.

Expand Advanced.

In the Credential field, enter a password for the domain.

Notes: By default, when a domain is created, a unique credential is
generated for the domain. Creating a unique credential and sharing it with
other domains establishes trust between those domains.

In the Confirm Credential field, enter the password that you entered in the Credential field.
Click Save.
Click Activate Changes.

10) Restart the Weblogic administration server and all managed servers.
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Targeting the JMS Server to a Migratable Target.

JMS-related services are hosted on individual server instances within a cluster and for these
services, the WebLogic Server migration framework supports failure recovery with service
migration, as opposed to failover. In a clustered server environment, a recommended best
practice is to target the JMS server to a migratable target, so that a member server will not be a
single point of failure. Therefore, the following prerequisite instruction is required if configuring The
WebLogic Message Queue In A Cluster.

Note: The instruction below assumes the WebLogic domain being
configured has managed servers already created and assigned to a
cluster parameter.

1) Configure the cluster migration Basis to Consensus:
a. Login into the WebLogic Administration console.
In the Change Center of the Administration Console, click Lock & Edit.
Navigate to the following location under the Domain Structure:
Environment -> Clusters -> ClusterName -> Migration.
Locate the Migration Basis drop-down list and change its value to Consensus.
Select Save.
. Select Active Changes.
2) Configure a migratable target for one of the managed servers in the cluster:
a. Inthe Change Center of the Administration Console, click Lock & Edit.
b. Inthe Domain Structure tree, expand Environment, then select Migratable Targets.

c. On the Summary of Migratable Targets page, select the link for one of the managed
servers in the list.

d. Select the migration tab:
In Service Migration Policy, select the Auto-Migrate Exactly-Once Services migration
policy.

f. In Constrained Candidate Servers, move the user-preferred server and the additional

managed servers in the cluster you want to support failure recovery from the Available
column to the Chosen column.

g. Select Save.
h. In the Change Center of the Adiministration Console, click Active Changes.
i. Restart the Admin server and the managed servers in the cluster for changes to take effect.

-0 ao0CT
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Configuring the WebLogic Message Queue

When an event is triggered, the P6 Event Notification system sends the event message to a
message queue. To receive these notifications, you must first configure the message queue.

To set up the WebLogic JMS message queue:

1) In either a new or existing WebLogic domain, launch the WebLogic Administration Console
if it is not already open.

2) Inthe WebLogic Administration Console:

a. Create a new JMS server and persistence store. See Creating a JMS Server and
Persistence Store (on page 59).

b. Create a JMS module. See Creating a JMS Module (on page 60).
c. Create a new connection factory. See Creating a JMS Connection Factory (on page 61).

d. Create a new queue or topic. See Creating a JMS Message Queue and Subdeployment
(on page 62) to see how to create a new queue.

Note: Create a queue to deliver a message to a specific group of users.
Create a topic to distribute a message amongst several users.
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Creating a JMS Server and Persistence Store

Create a JMS server to hold queues and topics.

To create a JMS server and persistence store:

1) Ifitis not already open, launch the WebLogic Administration Console on the remote or local
server.

2) Inthe WebLogic Administration Console, expand Services/Messaging and click JIMS
Servers in the Domain Structure pane.

3) Onthe Summary of JMS Servers page, click New.
4) Onthe Create a New JMS Server page:

a.

b.
c.

d.

Under JMS Server Properties:

1. Enter a name in the Name field.

2. Click Create a New Store.

Under Select a store type, select File Store from the Type list and click Next.
Under File Store Properties:

1. Enter a name in the Name field.

2. Select a server instance from the Target list.

Note: If you are configuring the WebLogic Message Queue in a cluster,
select the migratable target you configured earlier.

3. Specify a location for the file store in the Directory field.

= This location must already exist on your computer and you must have
read/write rights to this folder. No error messages appear on the
WebLogic console if the filestore is not configured correctly.

4. Click OK.
Under JMS Server Properties, select the new store from the Persistent Store list and
click Next.

e. Under Select Targets:

= If you are deploying to a standalone server, select the administration server (e.g.,
AdminServer) as the target from the Target list and click Finish.

= |f you are deploying to a cluster, select the migratable target configured earlier.
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Creating a JMS Module

Create a JMS module to manage and configure resources.

To create a JMS module:

1) Ifitis not already open, launch the WebLogic Administration Console on the remote or local

server.

2) Inthe WebLogic Administration Console, expand Services/Messaging and click JIMS
Modules in the Domain Structure pane.

3) Onthe JMS Modules page, click New.
4) Onthe Create JMS System Module page:

a. Under The following properties will be used to identify your new module, enter a
name in the Name field and click Next.

b. Under The following properties will be used to target your new JMS system module,
select a target server in the Servers box and click Next.

Note: If you are deploying to a cluster, select the cluster from the targets
list.

c. Under Add resources to this JIMS system module, select the Would you like to add
resources to this JMS system module option and click Finish.
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Creating a JMS Connection Factory
Create a connection factory to enable connections between your JMS elements.
To create a JMS connection factory:

1) Ifitis not already open, launch the WebLogic Administration Console.

2) Inthe WebLogic Administration Console, expand Services/Messaging and click JIMS
Modules in the Domain Structure pane.

3) Onthe JMS Modules page, select the module to which you want to add the connection
factory.

4) On the Settings page, click the Configuration tab and under Summary of Resources
click New.

5) Onthe Create a New JMS System Module Resource page:

a. Under Choose the type of resource you want to create, select the Connection
Factory option and click Next.

b. Under Connection Factory Properties:
1. Enter a name for the connection factory in the Name field.
2. Enter a name in the JNDI field.
3. Click Next.

c. Under The following properties will be used to target your new JMS system
module resource, ensure the correct server is targeted and click Finish.

Note: If you are deploying to a cluster, the cluster should be selected as
the target.
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Creating a JMS Message Queue and Subdeployment
Create a message queue to act as a receptacle for event messages sent from P6.
To create a JMS message queue and subdeployment:

1) Ifitis not already open, launch the WebLogic Administration Console.

2) Inthe WebLogic Administration Console, expand Services/Messaging and click JIMS
Modules in the Domain Structure pane.

3) Onthe JMS Modules page, select the module to which you want to add the queue.
4) On the Settings page, click the Configuration tab.

5) On the Configuration tab under Summary of Resources, click New.

6) On the Create a New JMS System Module Resource page:

a. Under Choose the type of resource you want to create, select the Queue option and
click Next.

b. Under JMS Destination Properties:
1. Enter a name for the queue in the Name field.
2. Enter a name in the JNDI field.
3. Click Next.

c. Under The following properties will be used to target your new JMS system module
resource, click Create a New Subdeployment.

7) On the Create a New Subdeployment page, enter a name in the Subdeployment
Name field and click OK.

8) On the Create a New JMS System Module Resource page:
a. Select the new subdeployment from the Subdeployments list.

b. Select the JMS server you created when creating the Persistence Store as the target from
the JMS Servers box.

c. Click Finish.
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Validating Event Notification with Oracle

After you have successfully configured WebLogic for cross domain eventing and shared the
relevant information with Oracle, you should test event notification to ensure event messages are
sent when an event occurs.

To test event notification:

1) Open P6 and create a project.
2) In P6:
a. Add one or more activities to the project.
b. Summarize the project to test if an event is generated.

3) Launch the WebLogic Administration Console to verify that the event is generated and sent
to the queue.

4) In the WebLogic Administration Console, expand Services/Messaging and click JIMS
Modules in the Domain Structure pane.

5) Onthe JMS Modules page, click the module you created for the remote server.
6) On the Settings page for the module, click the queue you created for the remote server.
7) On the Settings page for the queue, click the Monitoring tab.

8) On the Monitoring tab, select the option for the remote server destination you created and
click Show Messages. The event message should be visible in the JMS Messages list.
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P6 Team Member Setup Tasks

This chapter covers the tasks for P6 mobile and E-mail Statusing Service.

In This Section
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About P6 Team Member

The P6 Team Member is designed for individual contributors, or team members, to record their
statuses and report their time using timesheets. Team members can also use E-mail Statusing
Service and P6 mobile to status their tasks. P6 mobile allows access to P6 Team Member Web
functionality. P6 Team Member Web, E-mail Statusing Service and the P6 mobile apps provide
quick, convenient, and easy access to assigned tasks using the platform or device that
accommodates your line of work.

Your project manager uses P6 to create and update the project schedule and task list. Depending
on the project preferences the manager selected when creating the project in P6, the updates you
make in the P6 Team Member Web, E-mail Statusing Service or P6 mobile will either apply
immediately or require approval before they are applied to the project.

Work assignments in P6 Team Member are based on work distribution filters, or a team member
being named as a resource assignment or an activity owner. As a team member, the P6 Team
Member interfaces and the P6 mobile apps enable you to:

» View only your assigned tasks.

» Provide status on your tasks. The project manager customizes the status fields in your view.
These fields can include time spent, time left, % complete, remaining duration, start date, and
finish date.

Timesheets enable project team members to use the web to communicate timesheets and activity
statuses directly to their organization's database, regardless of their location. this ensure that
project managers are always working with the most up-to-date project information, making it
easier to plan resources or resolve conflicts.
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P6 Team Member Web

You can use P6 Team Member Web to:

4

Modify your view to display your task list by project and by current status, including Active,
Due, Overdue, Starred, or Completed. You can refine your task list even further by filtering on
the basis of specific parameters, entering a term by which to filter, or providing a sort order for
your list.

Mark a task with a star to signify its importance to you. You can view all your starred tasks in
one list when you select the Starred task list view in the app menu.

View a list of all your steps for a task. Add, edit, or delete steps to more accurately reflect your
work, if you are given the privileges by your project manager. You can enter the % complete to
show progress and mark a step as complete when you finish a step.

View the codes and UDFs associated with a task for additional information about the task.
Update codes and UDFs if your project manager requires you to update task status using
these fields.

View predecessor and successor tasks related to a task and contact resources associated
with related tasks.

Communicate with the project manager or other team members through e-mail.

Communicate with the project manager about a task by viewing and posting messages in the
Discussion dialog box. All messages are saved with the selected task.

View and edit notebook topics associated with a task to see or provide more information about
the task.

View documents associated with a task and contact resources associated with project
documents.

Enter up-to-the-minute information about your assignments and to record the time you spent
working on each one, by submitting timesheets. Timesheets helps you to focus on the work at
hand with a simple cross-project to-do list of your upcoming assignments.

E-mail Statusing Service

You can use E-mail Statusing Service to:

»

Request a list of your current tasks through e-mail using the e-mail account associated with
your P6 user account. You can request a filtered list of tasks by project; time frame; current
status, including Active, Due, Overdue, Completed, or Starting; or by all the tasks that you
starred.

Reply to the e-mail you receive with your task list, record your progress, and send your
updates.

Project managers can use E-mail Statusing Service to:

4
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Send a Welcome e-mail to new E-mail Statusing Service users, which includes the e-mail
address to the E-mail Statusing Service, and instructions for requesting a task list and
updating the list through e-mail.

Send team members an e-mail request for status updates. Project managers can customize
the task list sent to team members using the available filter options. Team members can
provide status by replying to the e-mail with their updates.
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Configuring the Default Language of the P6 Team Member Web User Interface
The default language of the user interface is English.
To change the default language of your application's user interface:

1) Enter the URL for the application in your browser.
2) Atthe end of the URL, enter: ?locale=<locale_code>
The locale codes are as follows:

» Brazilian Portuguese = pt BR

= French =fr

= German =de

= |talian =it

= Japanese =ja

= Korean = ko

= Russian=ru

= Spanish =es

= Simplified Chinese = zh_CN

= Traditional Chinese = zh_TW

For example, to change the language to German, the URL would be
http://yourserver/p6tmweb/?locale=de.

Note: The users will need to know their SSO username and password.

Tips:
Bookmark this URL for future access.
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Downloading P6 mobile Apps
To download the P6 mobile apps, do one of the following:

» If you are using an iOS device, go to the App Store to download the mobile application.

» If you are using an Android device, go to the Google Play App Store to download the mobile
application.

Configuring Login and Authentication Settings to Use P6 for iOS

Follow these steps to start the app for the first time. When you return to the app after working in
other apps, the last page you were on will appear. Once you configure these settings, you won't
need to perform these steps again unless your SSO cookies expire. If your cookies expire, you will
need to enter your user name and password again.

Note: You may need to activate your device's VPN feature to access your
company's deployment of P6. Contact your administrator for more
information.

To start the app:

1) On your device's Home screen, tap B pe.
2) Onthe Welcome to P6 Team Member page, slide the Single Sign On (SSO) switch to ON.
3) Tap the URL field and enter the URL to your server (for example, http://server:port/p6tmws).
a. Tap Authenticate.
b. Enter your SSO username and password.
4) Tap Sign In.

Tips

To access server information in the app—which includes the SSO setting, the URL to access the
server, and your user nhame—navigate to the app menu, and then tap Settings.

» You can modify the settings for the app from the Settings page on your iPhone. See the P6
Team Member User's Guide for more information.
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Configuring Login and Authentication Settings to Use P6 for Android

Follow these steps to start the app for the first time. When you return to the app after working in
other apps, the last page you were on will appear. Once you configure these settings, you won't
need to perform these steps again unless your SSO cookies expire. If your cookies expire, you will
need to enter your user name and password again.

Note: You may need to activate your device's VPN feature to access your
company's deployment of P6. Contact your administrator for more
information.

To start the app:

1) On your device's Home screen, tap & pe.
2) Onthe Welcome to P6 Team Member page, slide the Single Sigh On (SSO) switch to ON.
3) Tap the URL field and enter the URL to your server (for example, http://server:port/p6tmws).
a. Tap Authenticate.
b. Enter your SSO username and password.
4) Tap Sign In.

Tips
» To access server information in the app—which includes the SSO setting, the URL to access
the server, and your user name—navigate to the app menu, and then tap Settings.

» You can modify the settings for the app from the Settings button in the app. See the P6 Team
Member User's Guide for more information.
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Setting P6 to Support P6 mobile Users
For users to perform tasks in P6 for iOS or P6 for Android, you will need to:

1) Ensure the users you want to use the P6 mobile apps have a valid account in P6.

Note: Each user with a valid user account can be assigned to activities as
a resource assignment if the account is associated with a labor resource,
as an activity owner, or by being assigned a Team Member work
distribution filter.

2) Assign users to at least one module access option.
3) Assign users to one or more activity assignments (or tasks) for at least one active project. P6

mobile apps will show tasks that have not yet started, active tasks, and tasks completed in the
last 30 days.

Note: OBS access to a project is not required for resource assignments or
activity owners using P6 Team Member Web, E-mail Statusing Service, or
P6 mobile to view and update their assigned tasks. OBS access is
required for each user with a Team Member work distribution filter
assigned.

Have your P6 mobile app users download and install P6 for iOS from the Apple App Store or P6 for
Android from the Google Play Store to their mobile device.

Note: Users will need to know the P6 server and their SSO username and
password.

Known Issues

» If users are in a time zone that observes daylight savings time, the hours displayed in their
tasks may be incorrect by one hour.
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Setting P6 to Support E-mail Statusing Service Users

Projects may require that P6 users temporarily work in remote locations without access to the
private network where the P6 server resides. Diverse project teams may also exist with some
members updating their tasks using P6, and others using e-mail.

Note: Timesheet users can request a list of their tasks using E-mail
Statusing Service; however, timesheet users can only update their tasks
using P6 Team Member Web.

To support updating assignment status by e-mail, you will need to:
1) Ensure the users you want to use E-mail Statusing Service have a valid account in P6.

Note: Each user with a valid user account can be assigned to activities as
a resource assignment if the account is associated with a labor resource,
as an activity owner, or by being assigned a Team Member work
distribution filter.

2) Assign users to at least one module access option.
3) Ensure the user's account specifies their unique e-mail address.

4) Assign users to one or more activity assignments (or tasks) for at least one active project.
E-mail Statusing Service will show tasks that have not yet started, active tasks, and tasks
completed in the last 30 days.

Note: OBS access to a project is not required for resource assignments or
activity owners using P6 Team Member Web, E-mail Statusing Service, or
P6 mobile to view and update their assigned tasks. OBS access is
required for each user with a Team Member work distribution filter
assigned.

5) Ensure your users download and install an e-mail client application or browser to access web
mail.

6) Have your teams and managers plan their e-mail process. For example, consider details such
as the timing of updates by e-mail versus updates made in P6 to avoid conflicts, network
access hot spots, and what equipment or mobile devices you will be using.

Known Issues

Yahoo and Hotmail web clients are not supported. If the user's e-mail address is assigned to one

of these accounts, have them access their account within an SMTP e-mail client.

Error Messages

Users may receive error messages when updating tasks if their e-mail application is set to return
e-mail messages in HTML format.

One of the following situations will occur:

» An e-mail will be returned with the message "Date or unit format specified was invalid or
missing.".
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» Ifthereis an error in the Time Spent, Time Left, or Remaining Duration fields, an e-mail will be
returned with a message that the updated value is incorrect because only part of the updated
value was parsed by the E-mail Statusing Service.

The following methods can be used to avoid this issue:

» When entering task updates, delete the original value in its entirety before entering an updated
value.

» Set the e-mail application to reply to messages in text format.
» Click the Update this task link to update tasks individually.

P6 EPPM Web Services Setup Tasks

There are no additional setup tasks that you need to complete before you can begin to use P6
EPPM Web Services. Refer to the the P6 EPPM Application Administrator's Guide for more
information about assigning module access rights to users for P6 EPPM Web Services.
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P6 Professional Setup Tasks

Depending on your company's P6 EPPM Cloud Service configuration, you will either use P6
Professional Cloud Connect or Primavera Global Desktop for P6 Professional.

About ClickOnce

ClickOnce simplifies the deployment process for your P6 Professional applications while providing
you with a secure runtime environment. ClickOnce is configured and provided to you by your
Oracle support representative. It contains all of the information that you need to install or upgrade
your P6 Professional client application and to enable P6 Professional Cloud Connect to
communicate with your P6 EPPM cloud database.

In order to use P6 Professional with your Oracle Primavera cloud environment, you must install P6
Professional using ClickOnce from the the Primavera Cloud Portal. Instances of P6 Professional
that have been installed using ClickOnce connect to the P6 EPPM database in the cloud using
P6 Professional Cloud Connect. As patches and upgrades become available for your P6
Professional instance, you will be prompted to accept or decline the patch upon logging in to P6
Professional.

For more information about P6 Professional Cloud Connect, see Using P6 Professional with P6
Professional Cloud Connect (on page 75).

ClickOnce Prerequisites
Ensure that you have required prerequisites before you attempt to run ClickOnce:

» A Windows operating system
Note: ClickOnce is only supported for Windows operating systems.
» Java Runtime Environment (JRE)

» .NET Framework

You must have administrator privileges on your computer to install some of the ClickOnce
prerequisites. If you do not have the required version of .NET or JRE and do not have
administrator privileges on your computer, then the ClickOnce installation will fail and you should
contact your system administrator.
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Installing P6 Professional with ClickOnce

P6 Professional ClickOnce installation performs the following:

= |Installs a supported version of .NET onto the computers of users who
either do not have .NET or have a version of .NET that is not
supported for ClickOnce.

= |nstalls a supported version of JRE onto the computers of users who
either do not have a JRE or have a version or JRE that is not
supported for ClickOnce.

» Installs and upgrades the P6 Professional client application software.

» Configures the connectivity between the client software and the P6 Professional Cloud
Connect server.

Installation Scenarios

Installing P6 Professional for the First Time

If you have never installed P6 Professional, click Install to begin the P6 Professional ClickOnce
installation. ClickOnce will check and install any missing prerequisites before beginning
installation.

Upgrading P6 Professional with ClickOnce Installation

If you have installed P6 Professional with ClickOnce installation, you will be notified when a new
version is available. Click Install to proceed with the upgrade.

Working Offline

After you install or upgrade P6 Professional with ClickOnce, if you want to work offline (not
connected to theP6 EPPM database) you can create a P6 Professional Standalone (SQLite)
database, work on P6 Professional, and then upload the changes to the P6 Professional Cloud
Connect database.
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Using P6 Professional with P6 Professional Cloud Connect

In high-latency environments, performance can be affected by the amount of data that needs to be
transferred between P6 Professional and the P6 database on the cloud. To optimize the amount of
data that flows between P6 Professional on your desktop and the P6 cloud server, ensure that you
have a stable, wired connection to the P6 cloud server and follow the guidelines described in the
sections below.

Improving Login Performance

Login performance is affected by the amount of data that gets loaded during the login process.
You can control this data by following the tips described below:

» Evaluate user privilege assignments to ensure that your users have access to only relevant
data.

» Remove unused global objects from the system, including unused UDFs or Code
assignments.

» Set the startup filters to load Current Projects Only Data and turn off loading for Resource
Summary Data.

Enabling the Welcome Dialog

Enable the Welcome dialog from User Preferences dialog box to select the project at application
startup. Selecting a project at startup ensures that you do not automatically open a project during
startup. If you do not select the Welcome dialog option and a project that you did not intend to
open automatically opens, you would need to close the project and open another.

Note: You should only enable the Welcome dialog if you work on different
projects.

To configure the Welcome dialog:

1) Log into P6 Professional.

2) From the toolbar, select Tools and then click User Preferences.

3) Inthe Application Startup Window menu, under the Application tab, select None.
4) Select the Show the Welcome dialog at startup checkbox.

5) Exit the User Preferences dialog box.
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Creating and Selecting a Portfolio with Only the Required Projects

Oracle recommends that you do not use the All Projects portfolio because doing so will load all the
projects in the database to which the user has access. Instead, you can either create a new
portfolio with your required projects or you can open the No Projects portfolio when logging in to
the application.

To create a new portfolio:

1) Login to P6 Professional.

2) From the toolbar, select Enterprise and then click Project Portfolios.
3) Click Add to create a new portfolio.

4) Add the required projects to the portfolio.

5) From the toolbar, select File and then click Select Project Portfolio.
6) Select the portfolio.

Note: Ensure that the EPS bands only for projects in current
portfolio option is selected when opening a portfolio.

Configuring Startup Options
To configure the startup options:

1) Loginto P6 Professional.
2) From the toolbar, select Tools and then click User Preferences.
3) Under the Startup Filters tab, deselect the Resource Summary Data checkbox.

4) Select the current project data; this only applies to for Resources, Roles, OBS, Activity Codes,
and Cost Accounts.

Improving Functional Performance
» When possible, use filters to reduce the amount of data that is loaded or displayed.

» P6 Professional commits data whenever a new row is added. If your network or internet
connection is subject to high latency, it will take longer for the data to be committed.To reduce
the time it takes for your data to be committed, create a local Excel file and then import then
data using XLS import. Alternatively you can use a local SQL Lite database to enter the data
and use XML export/import to move the data to the P6 EPPM database.

» For more information about SQL Lite and P6 Professional, refer to the P6 Professional
Installation and Configuration Guide (Standalone) in the P6 Professional library on OTN.

» Import layouts separately from projects when doing XML import; this will allow the import to run
in background.

» Use P6 Web to schedule recurring tasks like summarizer, apply actuals, scheduler, and so on,
during off peak hours.

Avoid scheduling projects frequently.

Use the Refresh (F5) feature only when necessary, as doing so will force P6 Professional to
reload data from the server.
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About P6 Professional with Primavera Virtual Desktop

Primavera Virtual Desktop enables you to run P6 Professional over a secure network connection.

The following sections contain information about the prerequisites that are required to run
Primavera Virtual Desktop as well as behavior that differs from typical on-premises deployments
of P6 Professional.

Prerequisites to Use Primavera Global Desktop
Prior to accessing P6 Professional, users must have completed following prerequisites:
» Install a PDF viewer on your local computer. If you do not have a PDF viewer installed on your

computer, you can get Adobe Reader at https://get.adobe.com/reader/.

» Assign users the Primavera Virtual Desktop User role and P6 Account Instance in
Primavera Cloud Administration.

Assign users P6 Professional module access rights in P6.
Assign users project privilege rights in P6.

Notes:
= For more information about assigning module and project privilege
rights in P6, see the P6 EPPM Application Administrator's Guide.

= For additional supported client configuration details, such as
supported browsers and Java JRE, see
http://docs.oracle.com/cd/E51728_01/E51729/html/reqs-client.html.

Accessing P6 Professional

Note: Ten minutes after closing the browser or logging out of Primavera
Virtual Desktop, the P6 Professional session times out. If you log back in
within ten minutes, the session remains active.

To access P6 Professional with Primavera Virtual Desktop:

1) Log in to the Primavera Cloud Portal.

2) Click Primavera Virtual Desktop for P6 Professional. The Login to Primavera P6
Professional dialog box opens.

3) Inthe Login to Primavera P6 Professional dialog box, complete the following:
a. Inthe Login Name field, enter your username.
b. Inthe Password field, enter your password.
c. Click OK.

After you have been authenticated, a virtual desktop for P6 Professional will launch.
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Exporting Project, Roles, and Resources

When you attempt to export projects, roles, and resources with P6 Professional on Primavera
Virtual Desktop, you must select a location on one of your network drives.

Caution: If you attempt to export projects, roles, or resources to a network
drive on the virtual desktop, you might not be able to access the exported
data.

To export project, roles, or resources:
0 export project, roles, or resources:

1) From the File menu, select Export. The Export wizard opens.

Note: Click Next after you have completed the steps for each screen of
the Export wizard.

2) On the Export Format screen, select an export format.
3) Onthe Export Type screen, select one of the following:
» Project
» Resource Only
» Role Only

Note: If you select Resource Only or Role Only, you can skip the next
step.

4) On the Projects To Export screen, select the projects that you want to export.

5) On the File Name screen, browse to a location on your local network that you want to export
your projects, resources, or roles.

6) Click Finish.
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Importing Projects, Roles, and Resources

When you attempt to import projects, roles, and resources to P6 Professional on Primavera Virtual
Desktop, you must select a file from a location on one of your local network drives.

To import projects, roles, or resources:

1) From the File menu, select Import. The Import wizard opens.

Note: Click Next after you have completed the steps for each screen of
the Import wizard.

2) Onthe Import Format screen, select an import format.
3) Onthe Import Type screen, select one of the following:
» Project
» Resource Only
» Role Only
4) On the File Name screen, select a project, resource, or role on your local network drive.
5) Click Finish.

Printing Using Primavera Virtual Desktop

When using the print option in P6 Professional using Primavera Virtual Desktop, you have the
option to print directly to your computer's default PDF viewer or printer.

To print:

1) From the File menu, select Print. The Print dialog box opens.

2) Inthe Name menu, select one of the following:

» Universal PDF Viewer to open a PDF of your P6 Professional screen in your local PDF
viewer.

» Universal PDF Printer to print a PDF of your P6 Professional screen using the default
printer for your network.

Note: After you choose to print using the Universal PDF Viewer or
Universal PDF Printer setting, the action occurs immediately without
additional prompts on your computer.

3) Click OK.

Using Claim Digger

Claim Digger is used to compare the current version of a project against its baseline so that you
can access a report that displays the differences between added, deleted, or changed information
between projects.

When you use Claim Digger, you must designate a location to which your project comparison will
be exported. You must export Claim Digger reports to your local network drive.
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Primavera Risk Analysis Setup Tasks

Primavera Risk Analysis can read project data from a P6 EPPM database in the cloud. By
integrating Primavera Risk Analysis with P6 EPPM you can enable P6 users to analyze risks in
their projects.

In This Section
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Primavera Risk Analysis and User Access Privileges

Primavera Risk Analysis uses P6 EPPM's security when it connects to a P6 EPPM database.
Users that have been provisioned to use P6 EPPM applications can only use Primavera Risk
Analysis for the projects to which they have access. For more information about user security and
access privileges, see the P6 EPPM Application Administrator's Guide.

Connecting Primavera Risk Analysis to a P6 EPPM Cloud Database

To connect Primavera Risk Analysis to a P6 EPPM cloud database:

1) Open Primavera Risk Analysis.

Note: If you have Primavera Risk Analysis open, you must close any open
plans before you can connect to a P6 EPPM Cloud Database.

2) Click File.
3) On the File menu, select Primavera and then click Connection Wizard.
4) Inthe Primavera P6 Connection Wizard dialog box, complete the following:
a. Select P6 Cloud and then click Next.
b. Enter the required information in the following fields:
= Apache CFX Location:The path to the Apache CXF application.

Note: You must install the services framework Apache CXF version 2.2.7
in order to connect to P6 EPPM Web Services. You can download Apache
CXF from http://archive.apache.org/dist/cxf/2.2.7. After launching the site,
you must select the download files that correspond to the windows
operating system (for example, apache-cxf-2.2_7_zip). Extract the
file to a folder on your computer.

» Java JRE Location: The file path to a version of JRE that is supported byP6 EPPM.
For more information about supported versions of JRE, see Tested Configurations.

= Web Services URL: The Web Services URL that can be found on the Cloud
Welcome page.
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= Proxy Host: Enter the proxy host address if your company uses a proxy to connect
to the internet. If you do not use a proxy, leave this field empty.

= Proxy Port: Enter the proxy port number if your company uses a proxy to connect to
the internet. If you do not use a proxy, leave this field empty.

= Authentication Method: Select either Username Token Profile or HTTP Cookie.
You can determine which authentication method that you need to select based on
the P6 EPPM Web Services URL from Web Services Instructions... on the
Primavera Cloud Portal.

If the URL is https://pgbu-vbe2-p6.oracleindustry.com/p6ws-token,
select Username Token Profile.

If the URL is https://pgbu-vbe2-p6.oracleindustry.com/péws, select HTTP Cookie.
Click Next.
. If necessary, complete the following:

= Set the Java Heap Size. Java Heap Size is an optional setting to define the Java
Heap Size when importing large projects. By default this is set to 512Mb and should
remain on this setting unless errors occur importing large projects.

= Select Always display import log.
= Select Use these connection setting for all Primavera Risk Analysis users.

. Click Next.

Click Finish.
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Configuring Oracle BPM to Work with P6

The Oracle Business Process Management (BPM) Suite provides an integrated environment for
developing, administering, and using business applications centered around business processes.
BPM supports BPM and Business Process Execution Language (BPEL) standards from modeling
and implementation to run-time and monitoring.

P6 integrates with BPM which lets you initiate and manage workflows. You can use a sample
project initiation workflow for P6 sample database that is available on OTN.

You can expand your investment in BPM to include workflows representing more stages of your
application, program, project, or product development life cycle from design-time and
implementation to run-time and application management.

The Oracle BPM Suite enables you to:

» Create and customize business processes, models, and standards using pre-defined
components for web-based applications.

Collaborate between process developers and process analysts.
Expand business process management to include flexible, unstructured processes.
Integrate your applications with Web Services.

Add dynamic tasks and support approval routing using declarative patterns and rules-driven
flow determination.

v v v Vv

Unify different stages of your development life cycle by addressing
end-to-end requirements for developing process-based applications.
Oracle BPM unifies the design, implementation, run time, and monitoring
stages based on a Service-Oriented Architecture (SOA) infrastructure.
This allows different personas to participate through all stages of the
workflow life-cycle.

In This Section
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Assigning the TestConfig Role to Users

To use this workflow, you need to assign a BPM role for the user to initiate the test and receive the
confirmation the test was successful.

To assign the role:

1) Login to the BPM Workspace as a user with administrative rights.
2) Click Administration on the top right toolbar.
3) Onthe Organization Roles list, select P6ConfigValidator.TestConfig.

4) On the Details pane, make one or more BPM users or user groups a member of
the TestConfig role. The BPM users or user groups assigned to the TestConfig role must
match a P6 username for the workflow to be visible from P6.

5) Click Apply to save these changes.
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BPM Workflows in P6

The following sections detail information about workflows and how to work with them.

In This Section
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About Workflows

A workflow is an automated business process that routes information and tasks between
participants according to a defined set of procedures or rules designed to coordinate a specific
business goal. Workflows are primarily characterized by their level of procedural automation
involving one or more dynamic related series of processes, and their combination of human and
machine-based tasks involving interaction with software and systems.

The following industry segments, marked by relatively high office labor costs and transaction
volume, have demonstrated successful workflow implementations:

Insurance

Banking

Legal

General & Administrative
Design

Engineering
Manufacturing

v v v vV v v Vv

Business process modeling and workflow automation allow transactions to be conducted
electronically without the need for manual intervention such as conducting certain validations or
re-keying data. When workflow IT systems are processing repetitive, mundane, and often
error-prone work, talented staff resources become available to handle activities that add real value
to the enterprise.
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Working with Workflows in P6

You can use workflows to route business processes such as project initiation requests through
your organization to gather information and visibility before a go/no go decision is made. Template
data, routing designators, and approval rules can be set for each stage of a workflow. To illustrate
these options, pretend we have a workflow involving five key approval managers. You can define
the workflow such that all five must approve and even specify a particular sequence, if any. A
much more relaxed approval rule would require only one out of the five to approve. The following
are just some example of how you can use workflows.

Workflows are defined, deployed, and configured in BPM where your workflow designer defines
the workflow tasks involved and assigns them to specific users, roles, or groups. Then, in P6, a
business need kicks off an instance of the workflow and its required tasks are automatically routed
to their users, roles, or groups.

When a specific user or any user assigned to a role or group logs into P6, the Workflows portlet on
their dashboard will display their relevant tasks at this stage of the workflow, as authenticated by
BPM. As a workflow participant, you can select a task in the workflow instance and claim
ownership for it. This means you will be responsible for performing the task. The application
refreshes itself to show only the actions permitted for this stage of the workflow for you (the
currently logged in user).

After your administrator sets up BPM for P6, they can configure a dashboard to display the
Workflows portlet. The following list represents a list of the key Workflow elements that you can
observe in the portlet depending on your configuration.

» Action Required Tab: This tab shows the tasks that are important to you (the currently logged
in user).

» My Workflows Tab: This tab enables you to view all workflows according to role and status
filters you can set.

» Initiate a Workflow: Click Initiate a Workflow to start a new instance of a workflow based on a
predesigned template.

» BPM Workspace: Use the BPM Workspace to update the progress of tasks, initiate a change,
request a project, and retrieve project information. You are also able to apply a bulk action to
multiple work items.

» Sample Workflow: A basic workflow image with tasks for a business user, two project offices,
and a project manager

» Workflow History: View a chronological sequence of all the previous actions, users, and
stages in the current workflow.
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Primavera Analytics Setup Tasks

This chapter provides a general overview of Primavera Analytics and the Primavera Data
Warehouse.

» Oracle Primavera Analytics provides an in-depth and comprehensive method for analyzing
and evaluating project performance, project history, resource assignments and utilization,
business processes, cash flows, and cost sheets.

» The Primavera Data Warehouse works with the P6 EPPM database and the Primavera Unifier
database to provide a robust and powerful reporting solution.

In This Section
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About Primavera Analytics

Primavera Analytics consists of a Repository Definition, a sample catalog containing sample
analyses and dashboards, as well as a sample Primavera Data Warehouse. Primavera Analytics
is built upon the industry leading Oracle Business Intelligence Suite. The Primavera Analytics
Repository Definition contains all of the information Oracle Business Intelligence needs to allow
end users to create purposeful analysis based on data contained within the Primavera Data
Warehouse. The Repository Definition contains information such as how Oracle Business
Intelligence connects to the Primavera Data Warehouse, how security is applied to each user, and
how to join the Primavera Data Warehouse fact and dimension tables. The Primavera Analytics
sample catalog, also built upon Oracle Business Intelligence, contains over 300 pre-built analysis
and dashboards, organized in a catalog structure, used to help facilitate the capabilities available
combining P6 EPPM and/or Primavera Unifier with Oracle Business Intelligence. The sample
Primavera Data Warehouse can be restored and connected as the back-end for the sample
Primavera Analytics catalog.
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About the Primavera Data Warehouse

The Primavera Data Warehouse collects and stores data from P6 EPPM and Primavera Unifier. It
contains a process called STARETL, which is the mechanism by which data

is extracted, transformed, and loaded (ETL) from a P6 EPPM and/or Primavera Unifier database
into the Primavera Data Warehouse. The Primavera Data Warehouse accumulates data over time
with each run of the STARETL process.

The Primavera Data Warehouse separates data into facts and dimensions. Fact tables contain
business facts or measures (for example, Actual Total Cost, Workflow Duration, and so on).
Dimension tables contain descriptive attributes or fields (for example, Activity Name, Cost
Breakdown Structure, and so on). As the Primavera Data Warehouse schema accumulates
project and cash flow data, it provides baselines for tracking trends and for advanced business
intelligence. It also provides key metrics on current data, which allow you to drill through root
cause analysis.

You can connect the Primavera Data Warehouse to Oracle Business Intelligence (OBI) using
Primavera Analytics.

Overview of OBI

Oracle Business Intelligence (OBI) is a comprehensive suite of business intelligence foundation
and applications designed to enable the insight-driven enterprise. It integrates data from multiple
enterprise sources, and transforms it into key insights that enable strategic decision-making, drive
continual business process improvements, and promote alignment across the enterprise.

Primavera Analytics provides the following default dashboards:
Main

Business Processes

Cash Flow

Cost Sheet

Portfolio Analysis

Project Earned Value

Project Health

Resource Analysis

Industry Samples

vV vV vV vV vV vV v v v

For information about the Business Intelligence & Data Warehousing Technology Center, go to
the following website:

http://www.oracle.com/technetwork/topics/bi/index.html

For information about the Business Intelligence & Data Warehousing documentation, go to the
following website:

http://www.oracle.com/technetwork/middleware/bi-foundation/documentation/bi-dac-087220.html
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Configuring Primavera Analytics

Primavera Analytics includes three components that will use for configuration.

»

Primavera Analytics Repository Definition: The Repository Definition contains all of the
mappings and metadata that are needed to create meaningful Oracle Business Intelligence
analysis. This is considered a main component of Primavera Analytics because it is the only
component that is needed if using Primavera Analytics and Primavera Data Warehouse with
Oracle Business Intelligence. The Primavera Analytics Repository Definition tells Oracle
Business Intelligence what Primavera Data Warehouse fact and dimension tables to join, and
how to join them. The Primavera Analytics Repository Definition also contains the calculations
that are used for certain Key Performance Indicators (KPIs) that end users can use to create
more meaningful analysis. The Primavera Analytics Repository Definition is segmented into
two layers:

» The Business Model Layer, which describes the metadata mapping and configurable
KPIs.

» The Presentation Layer, which is what the end user will see when creating analysis within
Oracle Business Intelligence.

Note: You cannot access the Repository Definition natively with the web
application. To access or modify the Repository Definition, you must
submit a service request to My Oracle Support.

Primavera Analytics Catalog: The catalog is used by Oracle Business Intelligence to store in
a single location the collection of analysis, dashboards, and filters that are created and stored
by users of the system. Primavera Analytics includes a sample Oracle Business Intelligence
catalog, which includes sample dashboards, analysis and filters. These samples can be used
out of the box or tailored to meet your organizations specific needs. This sample catalog was
built on top of and using the third component of Primavera Analytics, the sample Primavera
Data Warehouse.

Sample Primavera Data Warehouse Schema: This sample schema was created in
conjunction with the sample P6 EPPM and Primavera Unifier databases. The sample
Primavera Data Warehouse contains sample fact and dimension tables, including daily history
captures, used to demonstrate the capabilities of Oracle Business Intelligence dashboards,
analysis and filters. This sample Primavera Data Warehouse schema can be configured in
conjunction with the other two components: the sample catalog and the Repository Definition.

The following topics explain how to configure the three components of Primavera Analytics.

88



Primavera Analytics Setup Tasks

Configuring Primavera Analytics

This section describes the setup tasks for using Primavera Analytics.

In This Section
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Web-Based Configuration Utility

You can use the web-based Configuration Utility to configure P6 EPPM Codes and UDFs. The
web-based Configuration Utility can be used to run and schedule runs of the STARETL process,
and view the history and logs from previous runs of the STARETL process directly from within the
web-based Configuration Utility interface. The web-based Configuration Utility also allows
administration of the Primavera Data Warehouse from any location in the application.

Using the Web-Based Configuration Utility

After successfully deploying the web-based Configuration Utility in WebLogic, you can now use
this utility to schedule and run STARETL processes, view the history and log information of
previously run STARETL processes, and configure P6 EPPM Codes and UDFs for loading into the
Primavera Data Warehouse.

The web-based Configuration Utility contains a series of parent/child/sub-child tabs which are
used to control, monitor, and change various components of the Primavera Data Warehouse
configuration. The parent level tabs contain a Home Tab and a tab for each STARETL process
configuration for the Primavera Data Warehouse. Primavera Data Warehouse data source. The
child level tab contains subordinate information (Schedule, Status, Codes, UDFs) for the parent
tab that is selected. The sub-child tabs are used on the UDF screen to configure and select the
UDF types.

The following topics give more details about the available tabs within the web-based Configuration
Utility.
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Home Tab (Parent Tab)
Complete the following steps to view the home tab of the web-based Configuration Utility:

1) Log in to to Primavera Analytics.
2) Select the Home tab.
3) Inthe Current Running ETLs section, view ETLs that are running or have run.

4) If you want to stop an ETL, see Stopping STARETL Process Runs in the Web-Based
Configuration Utility (on page 94).

Note: If you have never run a STARETL process, the Home tab will not
contain information about STARETL process that have been run.

STARETL Tab (Parent Tabs)

The STARETL tab will contain information about each configuration of Primavera Data
Warehouse that you have set up in your organization. If you have multiple data sources (P6 EPPM
and/or Primavera Unifier), then you will have multiple STARETL parent tabs (named differently but
containing the same child level tabs).
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Schedule (Child Tab)

The Schedule child tab is used to run and/or set up a schedule of runs for the STARETL process,
for the particular data source (STARETL parent tab) that is selected.

To run and/or set up a schedule of runs for the STARETL process for this particular data source
(STARETL parent tab), complete the following steps:
1) Log into Primavera Analytics.

2) Select the STARETL parent tab for the data source you want to configure and click the
Schedule child tab.

3) If you want to run the STARETL process immediately, click Run ETL.
4) If you want to schedule an ETL, in the Schedule ETL section:

a. Inthe Schedule Frequency field, select the frequency at which you want to schedule
STARETL process runs to occur (select Daily or Weekly).

1. If you select Daily in the Schedule Frequency field, the Run ETL at dialog will appear
allowing you to specify a time that you want the STARETL process to be run every day.

2. If you select Weekly in the Schedule Frequency field, the Run ETL at dialog will
appear allowing you to specify a time that you want the STARETL process to be run
every day as well as a series of checkboxes to select which day(s) of the week you
want to recurrently run the STARETL process.

3. If you select None in the Schedule Frequency field, then you are saying you do not
want to set up a schedule for this STARETL process.

b. Inthe Log Level section, select what information you want the application to log when the
ETL runs. You can choose the following:

= Errors and Warnings: Logs errors and warnings.

= General Information: Logs errors, warnings, and informational messages on the
progress of each step. This is the default value.

= Debug and Trace Information: Logs all general information, errors and warnings,
and detailed output of each executed script, query, and connection.

= Errors Only: Logs only errors and no other information.

= Extra Debug Information: Logs all general information, errors, and warnings. It
provides more fine grained information on each executed step and script.

5) Click Save to save the configured schedule information for this STARETL process.
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Codes (Child Tab)

Use the Codes (Child) tab if the STARETL parent tab contains a P6 EPPM data source. If the
STARETL parent tab contains a Primavera Unifier data source you can skip this topic.

The Codes child tab is used to configure the Project, Activity, and Resource Codes that will be
used for the particular P6 EPPM data source (STARETL parent tab) that is selected.

Note: Primavera Unifier code configuration is done within Primavera
Unifier. See the Primavera Unifier documentation for details.

The Codes child tab has three child tabs as well. Each Code type (Project, Activity, and Resource)
have their own individual tabs, and the codes available in each of these tabs will only be for that
particular code type.

Use the Codes child tab, and Project, Resource and Activity sub-child tabs to choose the available
codes that can be extracted from P6 EPPM and loaded into the Primavera Data Warehouse.

Notes:

= Based on the P6 EPPM data source that is chosen on the STARETL
parent tab, the list of available codes will be populated.

=  Primavera Data Warehouse has a limit of 240 codes for EACH
supported type (Project, Activity, and Resource).

On each Codes sub-child tab (Project, Activity, Resource), the left hand list box contains the list of
available Project, Activity, and Resource codes that can be extracted from P6 EPPM and loaded
into Primavera Data Warehouse. The right hand list box contains the list of selected Project,
Activity, and Resource codes that have been selected to be extracted from P6 EPPM and loaded
into Primavera Data Warehouse.

To move codes from the available list box to the selected list box, simply click on the code you
want to move in the available list box and click the -> button (located between the available and
the selected list boxes) to place the selected code from available list to selected list.

Alternatively, if you want to deselect a code, that is move the code from the selected list box back
to the available list box, simply click on the code you want to move in the selected list box and click
the <- button (located between the available and the selected list boxes) to place the selected
code from selected list box to the available list box.

Additional Information on Codes

The Selected Codes list box contains two additional columns (Scope and Index). The Scope
column is used only for Activity Level Codes. Due to the fact that activity codes within P6 EPPM
can be configured at different levels (Global, EPS, and Project), the Primavera Data Warehouse
enables you to define the Scope at which you will use these activity codes.

The Scope column determines at which level an activity code exists in the event that the same
code name is mapped at different levels (Global, EPS, and Project). For example, if you have a
global activity code called MyCode, and a project activity code called MyCode, the scope setting
would determine which activity code value to use.
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The final column in the Selected Code list box is the Index column. The Index column is simply
used to determine the placement of the selected code type (Project, Activity and Resource) within
the Primavera Data Warehouse code table.

All codes configured in the Configuration Utility are available as hierarchies in the Primavera Data
Warehouse. Full path values or specific node level values are available for each code. Code
Hierarchies apply to only Project, Activity (Global only), and Resource codes. Hierarchies do not
apply to Activity codes in Project or EPS codes. There are no additional configuration steps
required to use code hierarchies.

When you are finished selecting Codes, click Save Changes to save the code mappings that you
have selected.

Status (Child Tab)

You can view STARETL process reports and logs from the Status page for each recently run
STARETL process.

To view information regarding the status and log for the STARETL process for this particular data
source (STARETL parent tab), complete the following steps:
1) Log into Primavera Analytics.

2) Selectthe STARETL parent tab for the data source you want to configure and click the Status
child tab.

3) Onthe Recent running ETLs page:

This page contains a table structure that allows you to view key information about STARETL
processes that have been run for this data source (STARETL parent tab). The information
contained in this table includes:

ETL Id: The unique identifier for the STARETL process

ETL Start Date: Contains the date that this run of the STARETL process started. This date is
based on the server time where the STARETL process was run.

ETL End Date: Contains the date that this run of the STARETL process ended. This date is
based on the server time where the STARETL process was run.

Status: Indicates the status for this run of the STARETL process. Statuses can include:
OK indicates that this run of the STARETL process completed successfully.
Running indicates that this run of the STARETL process is still running.

Failed indicates that this run of the STARETL process has failed. If the status is Failed for
a particular run of the STARETL process, click the View Report and View Log links next
to that particular run in the Status table to get more information on why this run of the
STARETL process has failed.

Report: Provides a link to the job report for this run of the STARETL process.
Log: Provides a link to the STARETL process log for this run of the STARETL process.
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UDFs (Child Tab)

Use the User-Defined Fields page to choose the Project, Activity, Resource, Resource
Assignment, and WBS level UDF fields from P6 EPPM that will migrate to the Primavera Data
Warehouse. The Primavera Data Warehouse supports Cost, Non-Cost, Date, and Text UDF

types.

Notes:
= The Primavera Data Warehouse has a limit of approximately 240
UDFs for each supported type (Cost, Non-Cost, Date, and Text).

= Number and Integer UDF types are displayed in the 'Non-Cost'
folders.

To configure the UDFs for the STARETL process for this particular data source (STARETL parent
tab), complete the following steps:
Log in to Primavera Analytics.

1) Selectthe STARETL parent tab for the data source you want to configure and click the UDFs
child tab.

2) Select the Project, Activity, Resource Assignment, Resource, or WBS tab.

3) Select the Cost, Date, Non-Cost, or Text tab.

4) Move the UDFs that you want to use from the available column to the enabled column.
5) Select Save Changes.

Stopping STARETL Process Runs in the Web-Based Configuration Utility
The web-based Configuration Utility has the ability to stop currently running STARETL processes.

To stop STARETL process runs that were initiated through the web-based Configuration Utility,
complete the following steps:

1) Log in to Primavera Analytics.

2) Select the Home tab.

3) Inthe Current Running ETLs section, locate the STARETL process run you want to stop and
select the Stop button next to it.

4) Click OK when you are asked "Are you sure you want to Stop ETL process for STARETL?".
The Home tab changes to show the ETL is not running.
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P6 EPPM and Primavera Unifier Privileges

The Primavera Data Warehouse adheres to the same user privileges and access rights as P6
EPPM and Primavera Unifier. Additional privileges may need to be granted to specific P6 EPPM
and Primavera Unifier users. These privileges include Organizational Breakdown Structure
(OBS), Cost access, and Resource access. Refer to the P6 EPPM Application Administrator's
Guide for details about user privileges.

The following table briefly describes the Primavera Data Warehouse and P6 EPPM privileges:

Type Description

OBS Access Users who have OBS access in P6 EPPM will have OBS
access in OBI.

Edit EPS Costs/Financials |Users who have access to projects in the P6 EPPM
database and who have this privilege set will have the
same privilege in the Primavera Data Warehouse
database.

Resource Access Resource access can be set to one of the following:

All resource access: The user will have unrestricted
access to resources.

None: The user cannot access any resources.

Specific resource access: The user can only access a
specific resource.

Note: After modifying any P6 EPPM security privilege that affects the
Primavera Data Warehouse, it is required that the "Publish Security"
Global Scheduled Service be run prior to running the STARETL process.
This ensures that the correct privileges have been applied to the user
account.

Primavera Unifier user privileges are controlled both at the Company and the Project level. See
the Primavera Unifier documentation for details.
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About Oracle Primavera Analytics

Oracle Primavera Analytics provides an in-depth and comprehensive method for analyzing and
evaluating project performance, project history, resource assignments and utilization, business
processes, cash flows, and cost sheets.

Built upon the Oracle Business Intelligence (OBI) suite, Primavera Analytics delivers a catalog of
analyses that provide an interactive way of viewing, analyzing, and evaluating P6 EPPM and
Primavera Unifier data. In addition, Primavera Analytics provides a repository definition that
contains the data mappings between the physical data and the presentation layer of OBI.

The dashboards provide detailed insight into your P6 EPPM and Primavera Unifier data through
analytical charts, tables, maps, and graphics. Dashboards allow you to navigate to other analyses
to provide precise root-cause analysis. OBI allows you to configure individual analyses with P6
EPPM and Primavera Unifier Action Links, enabling you to navigate directly to your P6 and Unifier
site for true "Insight to Action" capabilities. You can save analysis created with OBI in the OBI
Presentation Catalog and integrate the analysis into any OBl dashboard. You can enhance results
through options such as charting, results layout, calculations, and drill-down features.

Use Primavera Analytics to:

» Perform root-cause analysis and employ management-by-exception.

» Gather critical insights into current and historical performance of all projects, programs, and
portfolios.

Drill down from aggregated metrics to examine the root-cause of a problem
Make better decisions to eliminate project failure.

Quickly visualize critical project performance in early stages.

Identify and predict cost sheet and cash flow trends early in the project life cycle.
Gain visibility into resource performance through s-curve analysis.

Show staffing needs by portfolio with early warning indicators for upcoming under-staffed
project work.

Roll-up business processes to understand trends and trends by various dimensions.

Use geospatial visualization to view project, activity, and resource data metrics by geographic
location with full drill-down capabilities.

v v v v v Vv

v v

Primavera Analytics provides a repository definition to use with the OBI suite. The repository
definition contains:

» A physical representation of the Primavera Data Warehouse.
» A business layer to perform customized calculations.

» A presentation layer that groups all the calculated business layer fields into logical subject
areas.

The repository definition delivers an extensive list of key performance indicators (KPIs) from both
P6 and Primavera Unifier. Depending on the data source, this list includes (but is not limited to)
Earned Value, Costs, Units, Percent Completes, Counts, Business Processes, Cash Flow, and
Cost Sheets. It also enables data to be sliced by various dimensions, including time, EPS,
portfolios, projects, activities, resources, project hierarchies, cost breakdown structures, and
business processes.
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Primavera Analytics delivers a sample dataset, consisting of the Primavera Data Warehouse data,
where the dashboards and analyses in the catalog were built. You can use this sample data to
view the power of dashboard and analyses delivered in the catalog, and see how you can
integrate the catalog with your data.

Adding P6 EPPM Users for Primavera Data Warehouse

If you are using only Primavera Unifier, you can skip this topic. See Adding Primavera Unifier
Users for Primavera Data Warehouse (on page 98) instead.

In order for a P6 EPPM user to access data in the Primavera Data Warehouse, you must set up
the correct user security in P6 EPPM prior to running the STARETL process.

To configure a new P6 EPPM user to access the data within the Primavera Data Warehouse,
complete the following steps:

1) Loginto P6 EPPM with a user account that has Administrator privileges.

2) In P6 EPPM, go to the Administer menu link, and select User Access.

3) From the User Access window, create or modify the user accounts that will need access to
data within the Primavera Data Warehouse.

4) Select the user account, and in the lower section of the screen, click the Module Access tab.

5) Inthe module access panel, place a check mark (double click in the checkbox so it becomes
selected) in the access column next to the P6 Analytics module to grant this users access to
data in the Primavera Data Warehouse.

6) Click the Save icon on the toolbar to save the module access settings for this user.

7) Repeat these steps for each user account that will need to access data from the Primavera
Data Warehouse.

8) Once all the user privileges and access in P6 EPPM are set up and complete, the "Publish
Security" Global Schedule Service needs to be run.

Note: You can schedule this service to run immediately or later, but it must
run to successful completion prior to running the STARETL process.
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Adding Primavera Unifier Users for Primavera Data Warehouse

For a user to access data in the Primavera Unifier through OBI, you must set up security in both P6
EPPM and OBI.

To add a new user:

1) In Primavera Unifier, go to the Company Workspace tab and switch to Admin mode.
2) Click Access Control in the left Navigator.

3) On the right pane, select Administration Mode Access > Analytics. The Permission
Settings window opens. Here you can add, modify, or remove permission settings.

4) Click Add. Another Permission Settings window opens.
5) Click Add Users/Groups. The Users/Groups window opens.
6) Select users and groups you want to add and click Add.
7) Click OK to return to the Permission Settings window.
8) Do the following to set permissions:
a. Select the users and groups in Select Users/Groups (in the upper portion of the window).
b. Select the appropriate level of access in Permissions Settings (in the lower portion of the
window):
= View: Allows users and groups to open and view the contents in Analytics node.
Users with View permission cannot make any changes.

= Modify: Allows users and groups to configure and modify the data required for
Analytics. This setting also includes View permission. Users are also able to set
schedule for publishing data, for various areas in Unifier, to the Oracle Business
Intelligence (OBI) server. The View option must be selected for the users with
Modify permissions.

c. Click OK.

9) Click Apply to save changes and keep the window open or click OK to save changes and
close the window.

Note: The Permissions tab enables access to permission templates. You
can copy a permission template to quickly set up the permissions for a
new user or group. You can also save an existing user or group’s
permission settings as a new template for later use.

Adding Additional Financial Periods

The Primavera Data Warehouse can use two additional financial periods. To add additional
financial periods, submit a service request to My Oracle Support.
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Including Inactive Resources from P6 EPPM in the Primavera Data Warehouse Tables

By default, the Primavera Data Warehouse tables filter out inactive resources. If you include
inactive resources, the spread data and other dimension tables will also include them. You may
not need to process this extra resource assignment information.

If you want to include inactive resources in the Primavera Data Warehouse tables, submit a
service request in My Oracle Support.

Log Files

The Primavera Data Warehouse creates extensive log files that provide information about the
installation and daily operations. These log files are accessible in the Web-Based Configuration
Utility on the Status tab.

Using History Settings for P6 EPPM Data

P6 EPPM provides the ability choose the level (Project, WBS, Activity) and interval (Yearly,
Quarterly, Monthly, Daily) of history data to be captured and stored in the Primavera Data
Warehouse.

Note: Primavera Unifier also provides the ability to capture and store
history data, however data can be captured only at the Weekly level, so no
additional settings are required.
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Creating History Data for P6 EPPM

In P6, you can define history level and interval settings on a per project basis. Use P6 to configure
the type of data stored in Primavera Analytics and in what time interval.

To configure history settings:
1) Logininto P6.

Note: A user must have the Edit Project Details Except
Cost/Financials profile to edit the history settings.

2) Click Projects.
3) On the Projects navigation bar, click EPS.
4) On the EPS page:

a. Select a project.

b. Click the Actions + menu and select (@ Set Project Preferences.
5) Inthe Project Preferences pane, click Analytics.
6) On the Analytics page:

a. Select the History Level and History Interval settings.

You can choose one of the following for History Level:
= None (the default)

= Project
= WBS
= Activity

You can choose one of the following for History Interval:
= Month (the default)

= Week
= Quarter
= Year

= Financial Period
b. Click Save to continue working or click Save and Close if you are finished.

Note: If you select Activity as the History Level, this will automatically
set the History Interval for Activity and Resource Assignment history

to Daily. Use caution when selecting which projects you choose to have
daily history captures as this can affect the amount of time and the volume
of data processed when running the ETL process. You still need to set the
history interval level when selecting Activity level history, which will apply
to project and WBS-level history only.

7) Run the publication services to publish the changes you made.
8) To create history data, run the ETL process with the Web-based Configuration Utility.
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Using Slowly Changing Dimensions and Daily Snapshot Fact Tables for P6 EPPM Data

Slowly changing dimensions (also known as Type 2 dimensions) preserve an attribute's history of
values by capturing non-fact or dimensional data and associating that data with the correct version
of the fact row. Captured data includes project, resource, activity, resource assignment
dimensional data, and more. Slowly changing dimensions are used when is it important to
preserve the historic context of facts.

When source data elements change or when the STARETL process is run, a new row is added to
the dimension table and the previous row is left unchanged. Previously recorded facts remain
associated with the old dimension row and new facts are associated with the new dimension row.
These rows show the changes to an attribute over time. For example, if the Planned Start Date for
an activity has changed between the current capture and the previous capture, the old and new
date would both be recorded in the dimension table.

Dimension rows in the dimension table are distinguished by the Effective Start Date, Effective End
Date, and Current Flag. The date and time the STARETL process starts becomes the Effective
Start Date for the new dimension row. The new version of a dimension Effective End Date defaults
to 01-Jan-3000 00:00:00. When the STARETL process is run again, the Effective End Date for the
latest version of the attribute then becomes the Effective Start Date for the current version minus
one second. For example, if the Effective Start Date for the current version of the attribute is
17-Nov-2014 08:00:00, then the Effective End Date for the previous version becomes
17-Nov-2014 07:59:59. The most recent dimension row in the dimension table has a value of "1"in
the Current Flag column. All other rows have "0" in the Current Flag column.

Daily snapshot fact tables enable the daily capture of metrics at the Resource Assignment and
Activity Levels. Daily snapshot fact tables are used in conjunction with slowly changing
dimensions. For example, when the Activity History daily snapshot is recorded, new fact rows will
be updated with the most current version of each record in the activity dimension. Previously
recorded facts remain associated with the old dimension row version.

The daily snapshot makes it easy to determine what metrics such as Remaining Units looked like
at any point in time across all projects that have been opted into this level of data capture.
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Enabling Daily History Snapshots and Slowly Changing Dimensions
To enable slowly changing dimensions and daily history snapshots for a project:

1) Loginto P6 EPPM.
2) In P86, click Projects.
3) On the Projects screen navigation bar, click EPS.
4) On the EPS page:

a. Select a project.

b. Click the Actions + menu and select [ Set Project Preferences.
5) Inthe Project Preferences dialog box:

a. Ensure the project is configured for Publication Services.

1. Onthe Project Preferences pane, click Services.

2. On the Services page, select the Enable Publication option in
the Publication section.

b. Configure the project's History Level setting.
1. Inthe Project Preferences pane, click Analytics.
2. On the Analytics page, click the History Level drop-down and select Activity.

Note: You should still configure the History Interval setting, but it will only
apply to Project and WBS-level history metrics.

c. Click Save and Close.

Turning Off Slowly Changing Dimensions

If you turn off the slowly changing dimensions for a field, the current dimensional row can be
updated with a new value without the addition of a new dimensional row.

For example, if slowly changing dimensions have been enabled for the Activity Description field,
then changes made to this field will cause a new row to be added to the dimensional table the next
time the STARETL process is run. If slowly changing dimensions have not been enabled for the
EPS Name field, then the STARETL process will not update the dimensional table with a new row.
Modifying slowly changing dimensions for each field can prevent cascading updates to fact tables.
For example, if a change is made to the EPS table, that change would cause a new row to be
added to the dimension table for all of the activities affected by the change.

Note: To modify slowly changing dimensions for each field, submit a
service request in My Oracle Support.
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Using Burn Down for P6 EPPM Data

Primavera Data Warehouse and Primavera Analytics contain an additional way that data can be
analyzed outside of the standard P6 EPPM methods. Primavera Data Warehouse and Primavera
Analytics include additional tables and configuration for Burn Down. In the simplest of terms, Burn
Down is a set of calculations that display how a project will progress if everything goes "according
to plan”. Primavera Analytics includes metrics and Key Performance Indicators (KPIs) for both the
current project data, as well as any point in the past for which the data was captured. These
metrics and KPlIs include both current and historical activity counts, units, and costs. Primavera
Analytics and Primavera Data Warehouse has the ability to track and monitor how the current
schedule is executing in relationship to how it was supposed to progress at the start of the project
(T-0). This includes, but is not limited to, any new activities that were added to the current project
that did not exist at the start of the project (emergent), activities that have been removed in the
current schedule that existed in the point in time capture of the project (deleted), and activities
whose start or finish has changed since the point in time capture of the project.

Use the sections in this chapter to learn more about the additional functionality, how to set it up in
P6 EPPM, and how to work with the data in Primavera Analytics.

Note: Primavera provides several white papers that detail aspects of Burn
Down:

= Burn Down Detail Data Flow:
http://www.oracle.com/webfolder/technetwork/tutorials/primavera/Onl
ineLearning/WhitePapers/BurnDown_Details_DataFlow.pdf

= Burn Down Units Details:
http://www.oracle.com/webfolder/technetwork/tutorials/primavera/Onl
ineLearning/WhitePapers/BurnDown_Details_Units.pdf

= Burn Down Counts Details:
http://www.oracle.com/webfolder/technetwork/tutorials/primavera/Onl
ineLearning/WhitePapers/BurnDown_Details_Counts.pdf

Creating Project UDFs for Burn Down Subject Areas

Only P6 EPPM projects can be manually included to take advantage of the Oracle Primavera Burn
Down tables and functionality. This section describes how to create and configure the necessary
P6 EPPM project level user-defined fields (UDFs) that the STARETL process needs to include
project(s) in Burn Down.

To create the project UDFs, complete the following steps:

1) Loginto P6 EPPM with a user account that has the privilege to change enterprise data (for
example, admin).

2) Click the Administer = menu and select Enterprise Data.

3) Onthe Enterprise Data page, expand Projects and select Project UDFs.

4) On the Project UDFs page:
a. Add a sys_workdown UDF with a data type of Text.
b. Add asys_workdown_date UDF with a data type of Start Date.
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Selecting the Project for the Burn Down Subject Area

For a project to be included in the Burn Down tables and subject area, you must configure specific
project UDF and History Level settings in P6.

To select which P6 EPPM project will be included in Burn Down tables and metrics, complete the
following steps:
1) Loginto P6 EPPM.
2) In P86, click Projects.
3) On the Projects navigation bar, click EPS.
4) On the EPS page:
a. Select a project.
b. Click the Actions + menu and select (@ Set Project Preferences.
5) Inthe Project Preferences dialog box, in the Project Preferences pane, click Analytics.
6) On the Analytics page, click the History Level drop-down and select Activity.
7) Inthe Project Preferences dialog box, click Save and Close.
8) On the Projects navigation bar, click EPS.
9) On the EPS page, add the sys_workdown and sys_workdown_date UDF columns to the
page.
10) For the projects you want to add to the Burn Down subject area:
a. Enter project inthe sys_workdown column.

b. Enter a date value (for example, 09/30/2015) in the sys_workdown_date column. This
value is used as the snapshot date for comparison to actual project values. If no value is
entered here, the Project Start Date is used.

Note: The date used for the initial Burn Down data capture is one day
before the date entered for this UDF. For example, if

the sys_workdown_date is 09/30/2015, then the STARETL process
uses 09/29/2015 for the Burn Down comparison.

Burn Down and Work Planning with the STARETL Process

After adding P6 EPPM projects for inclusion in the Burn Down and/or Work Planning subject
areas, it is important that the date/time period specified in P6 EPPM

under Administer, Application Settings, Services in the Publication Period section is later
than the latest project finish for ALL project(s) that will be included for Burn Down and/or Work
Planning. For example, in P6 EPPM Publication Services settings, if you specify a start date of
October 1, 2015 and the finish date is current date plus setting is two years, the finish date for all of
the Burn Down/Work Planning project(s) must have a finish date before September 30, 2017. If a
project extends past the finish date setting in the publication services settings, the Burn
Down/Work Planning portion of the STARETL process generates an error.

Note: Setting a finish date range that is too long will affect the STARETL

process run time. Each day the publication services are run, the finish
date range also extends by one day.
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Scheduling a Burn Down Project

A project can have activities scheduled and completed before a burn down begins. This gives
users the flexibility to begin the project burn down on the date specified in
the sys_workdown_date UDF rather than the Project Start Date.

In a Burn Down project, the initial snapshot of the project's activities and assignments is taken the
day before the date entered in the sys_workdown_date UDF. This shapshot is used as a
baseline to compare against actual values. For example, the Baseline Remaining Units Burned
can be compared to the Remaining Units Burned. The STARETL process must be run one day
before the sys_workdown_date (or the Project Start Date if this UDF is not used) to capture this
initial snapshot.

Burn Down Scheduling and ETL Sequence

Burndown Start
Burndown (sys_workdown_date)
Snapshot Capture
| I |
| T o I — |
1. Data Date | 2. Run ETL 1. Update Schedule I 3. Run ETL 1. Update Schedule | 3. Run ETL
Pre-Burn Down 9122012 1:00 pm 21212013 2. Advance Data Date 27312013 2. Advance Data Date 91412013
Activities | 9/3/2013 1:00pm | 2/4/2013 1:00 pm |
| I |
Day 0 (2/72/2013) Day 1 (2/22013) Day 2 (%/4/2013)

Remaining Units Burned

Baseine  [VAGHEAI
100
Units 50 Baseline
Remaining !
Units Baseline
Remaining
~ Units Baseline
Remaining
Units
0 .
Day 0 (972/2013) Day 1(9/372013) Day 2 (9/4/2013)
(e Time
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About the STARETL Process and Burn Down Metrics

When using Burn Down Metrics, you must update the schedule and run the STARETL process.
Each daily STARETL process updates two sets of daily metrics:

» Metrics for ‘Today’: All work completed today through the latest schedule update and data
date change is recorded as work completed for the current date when the STARETL process
occurs.

» Metrics for ‘Yesterday’: Since the data from yesterday is only current through the latest
schedule update and data date change, any additional work completed yesterday but AFTER
the update is now added to the daily metrics for ‘yesterday’.

For example, a project is updated at 6pm daily and the STARETL process is then executed. The
next day, these become metrics for ‘yesterday’ and initially reflect work only through 6pm
yesterday. When the STARETL process is executed today, any additional work completed
between 6pm and midnight is now included under the metrics for ‘yesterday’.

Calculating Metrics in the Burn Down Subject Area

To capture daily trending information, complete the following steps each day to calculate the
metrics in the Burn Down subject area:

1) Update the status of activities in the projects you configured in P6 to be included in the Burn
Down subject area. For example, update the Actual and Remaining Units and which activities
are completed.

2) Adjust the data date to correspond to the latest status update.

3) Runthe STARETL process.

Note: The STARETL run must occur within each calendar date to properly
capture daily metrics.

Using Work Planning for P6 EPPM Data

Primavera Analytics supports Work Planning for P6 EPPM data. Work Planning is a method of
tracking how work is progressing based on a set of user-determined points in time. Similar to Burn
Down, Work Planning also uses project-level user-defined fields (UDFs) to select the P6 EPPM
projects included in the Work Planning calculations and metrics and also the point in time you want
to use for the comparison.
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Creating Project UDFs for Work Planning Subject Areas

You can manually include P6 EPPM projects to take advantage of the Work Planning tables and
functionality.

You must create and configure the necessary P6 EPPM project-level user-defined fields (UDFs)
that the STARETL process needs to include projects in Work Planning. To do this, complete the
following steps:
1) Loginto P6 EPPM.
2) Click the Administer + menu and select Enterprise Data.
3) Onthe Enterprise Data page, expand Projects and select Project UDFs.
4) On the Project UDFs page:
a. Add a sys_workprocess UDF with a data type of Text.
b. Add asys_scope_freeze UDF with a data type of Text.
c. Add asys_schedule_freeze UDF with a data type of Text.
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Selecting a Project for the Work Planning Subject Area

The Work Planning subject area is designed for ongoing project work typical of routine and online
maintenance projects. In these projects, planning metrics are tracked week over week and
workweek metrics are tracked daily. There are specific Project UDF and History Level settings
required in P6 to include a project in the Work Planning subject area.

Complete the following steps to select the P6 EPPM projects for the work planning subject area:

1) Loginto P6 EPPM.
2) In P86, click Projects.
3) On the Projects navigation bar, click EPS.
4) On the EPS page:
a. Select a project.
b. Click the Actions + menu and select LE Set Project Preferences.
5) Inthe Project Preferences dialog box:
a. Ensure the project is configured for publication services.
1. Click Services in the Project Preferences pane.
2. On the Services page, select the Enable Publication option in the Publication pane.
b. Configure the project's History Level setting.
1. Click Analytics in the Project Preferences pane.
2. On the Analytics page, select Activity from the History Level drop-down list.
c. Click Save and Close.
6) On the Projects navigation bar, click EPS.

7) On the EPS page, add the sys_workprocess, sys_scope_freeze,
and sys_schedule_freeze UDF columns to the page.

8) For the projects you want to add to the Work Planning subject area:
a. Enter workweek in the sys_workprocess column.

Note: Use the format T-<x>w (where <x> equals the number of weeks
prior to scope freeze and schedule freeze) must be followed exactly when
entering the sys_scope_freeze and sys_schedule_freeze UDF values.

b. Enter a value in the sys_scope_freeze column. This is a relative value for each week in a
project's schedule. For example, if you enter T-2w, scope freeze for each week in a project
is calculated as two weeks prior to the Planned Start Date of that week. Scope freeze
metrics, such as Scope Freeze New or Scope Freeze Lost, are captured for each week in a
project schedule from each week's calculated scope freeze date up to and including its
completion.

c. Enteravalueinthe sys_schedule_freeze column. This is a relative value for each week in
a project's schedule. For example, if you enter T-1w, schedule freeze for each week in a
project is calculated as one week prior to the Planned Start Date of that week. Schedule
freeze metrics, such as Schedule Freeze New or Schedule Freeze Lost, are captured for
each week in a project schedule from each week's calculated schedule freeze date up to
and including its completion.
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Scheduling a Work Planning Project

Scope freeze, schedule freeze, and actual metrics are captured for each week of planned work in
a project that has been opted into the Work Planning subject area. Each individual week in the
schedule will have these metrics captured leading up to that week’s execution, allowing users to
monitor their planning performance on a weekly basis for an upcoming week of work.

The sys_scope_freeze and sys_schedule_freeze UDFs control the amount of history or the
number of weeks these metrics capture for each individual week leading up to the execution week.

The diagram below illustrates how the ETL process would capture Work Planning metrics for the
week 12/17/2012 to 12/23/2012 given the following P6 settings:

» The sys_scope_freeze equals T-2w
» The sys_schedule freeze equals T-1w
» The Starting Day of Week equals Monday (this is set in the P6 Application Settings)

In this scenario, the Scope Freeze for the week starting on Monday 12/17/2012 occurs two weeks
prior (T-2w) to that week’s planned start date. Schedule Freeze occurs one week prior (T-1w) to
that week’s planned start date. Daily Actual Start and Finish metrics are captured throughout the
week.

Once the STARETL process has run on these respective freeze dates, any changes in the
schedule for an upcoming week (such as adds, deletes, or planned date changes) are recorded
the next time the STARETL process runs.

Work Planning ETL Metrics captured for 1 week - (12117 = 12/23)
. Scope Freeze Metrics Schedule Froezo Matrics Actual Matrics
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Using Graded Approach to Schedule Adherence

Graded approach to schedule adherence is a method for tracking adherence using four distinct
levels of work scheduling (A, B, C, and D).

The levels of work scheduling are:

» A (Hourly): Used when you require the most control, adherence, and management oversight.
Reasons include risk (probability safety analysis/risk assessment), personnel safety, or other
significant concerns. Users must finish Level A activities within one hour of the target planned
finish date.

» B (Daily): Used for work requiring multi-discipline coordination, significant tagouts, or risk
significant work. Users must finish Level B activities on the same day as the target planned
finish date.

» C (Weekly): Used for non-risk significant and routine work that does not require support from
other work groups. Users must finish Level C activities within the week of the target planned
finish date.

» D (No Tracking): Used for housekeeping, shop work, and other types of work that have no
impact to the plant. Level D activities are considered “fill-in" work and are not tracked for
schedule adherence.

To configure graded schedule adherence:

1) Ensure you have enabled a project for Work Process:

The sys_workprocess=WORKWEEK, sys_scope_freeze, and sys_schedule_freeze
UDFs are populated and History Level are set to Activity.

2) Ensure history exists for the project as of the scheduled freeze date and T-0 baseline date for
the week the STARETL process will run.

3) Code activities using an Activity Code or UDF to identify the adherence grade (A, B, C, D).
For example, in the sample data, Activity Code 11 (Schedule Adherence Priority) is used.

Note: Ensure the Activity Code or UDF used is set up correctly both in the
Primavera Data Warehouse database and the repository definition.

During T-0 for a given week when you run the STARETL process, the Baseline Planned Finish
Date (as of T-0) and the Schedule Freeze Planned Finish Date (as of schedule freeze UDF) for the
activities will be captured. You can use these dates along with the assigned adherence grade to
calculate the graded schedule adherence in Primavera Analytics.

Using Location Data

Both P6 EPPM and Primavera Unifier can store location information for projects. In addition, P6
EPPM can also store location information for activities and resources. Primavera Analytics can
create intelligent analysis to evaluate measures using the geographical location data entered in
P6 EPPM and Primavera Unifier. You will need spatial boundary data and maps. Primavera
Analytics comes with access to Oracle eLocation services. Oracle eLocation service is a
cloud-based map data service that provides mapping, geocoding, and routing capabilities. For
more information, see the Oracle Business Intelligence documentation on mapping and spatial
information.
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Entering P6 EPPM Data for Mapping

P6 EPPM supports the ability to enter location data at the dictionary level that can be assigned to
Projects, Activity, and Resources and then extracted, transformed, and loaded into the Primavera
Data Warehouse for use in Oracle Business Intelligence analysis.

To create location data in P6 EPPM, complete the following steps:

1) Loginto P6 EPPM with an account that has the privilege to change enterprise data (for
example, admin).

2) Click the Administer = menu and select Enterprise Data.

3) Inthe Enterprise Data pane, expand Global and select Locations.

4) Enter the location data as appropriate for your specific needs.

5) Assign locations data to projects, activities, and resources as needed.

Note: See the P6 help for information about entering and assigning
location data.

6) After all of the location data is entered and assigned where appropriate for your environment,
run all of the Global publication services to ensure that the data in the publication tables is up
to date. After Publication Services have run to successful completion, run the STARETL
process to extract, transform, and load the data from P6 EPPM to the Primavera Data
Warehouse.

Preparing Primavera Unifier Data for Mapping

There are some additional steps required to integrate Primavera Unifier location data with map
data. The Primavera Unifier staging tables store columns for State and Country name (for
example, United States), however some of the MapViewer layers rely on State and Country code
for the mappings. Run the included script at the end of the STARETL process to ensure that the
State Code and Country Code columns are populated correctly for use with map data.

To enter location data in Primavera Unifier:

1) Log into Primavera Unifier.

2) Assign locations to your projects.

3) From the Company Admin screen, select the Analytics module.

4) Inthe Shell mapping configuration, ensure that the Country and State columns are mapped to
values that represent country and state codes rather than names.

After you have entered and assigned all of the location data where appropriate for your
environment, run all of the Publication Services to ensure that the data in the publication tables is
current. After Publication Services have run successfully, run the STARETL process to extract,
transform, and load the data from Primavera Unifier to the Primavera Data Warehouse.
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Primavera Gateway Setup Tasks

Primavera Gateway is an application that facilitates sharing and synchronizing project and
resource information data between Primavera applications and other enterprise applications. By
creating providers, which are used as a channel to connect with the corresponding software

application, Primavera Gateway enables you to combine management and scheduling

functionality of Primavera applications with other enterprise software. Providers can reside on

either side of a data flow connecting a source application with a destination application.
This chapter provides guidance for planning integrations between:

» P6 EPPM and Primavera Unifier
» P6 EPPM and Oracle Primavera Prime

Also in this chapter is a section that includes the business objects for each product.

In This Section

Sharing Data between P6 and Primavera UNifier.............cccooooiiiiiiniinieeeeeeenn 112
Sharing Data Between Oracle Primavera Prime and P6 EPPM.............cc.cccc........ 126
BUSINESS ODJECIS...ceiiiiiiii it 156
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Sharing Data between P6 and Primavera Unifier

Data can be exchanged between P6 and Unifier directly from the P6 EPPM application user
interface. For more details on how this is accomplished, refer to the P6 EPPM user
documentation. Alternatively, a Gateway administration user can also set up a data exchange flow
through the Gateway user interface. This guide describes the available business flows, associated
field mapping templates, synchronizations, source and destination parameters for a data
exchange flow that can be setup in the Gateway user interface.

The following providers are delivered with Primavera Gateway:

» Unifier provider
The Unifier provider enables you to get data for the cost modules, Cost Sheet, Cash Flow, and
earned value data from P6 application. P6 schedules activity data can also be exchanged
between the two applications. It also enables exchange of P6 schedules' activity data between
the two applications (data can be sent from P6 and returned back to P6) Primavera Gateway
supports this integration with the P6 provider.

» P6 provider

The P6 provider enables you to share activity data and summarized schedule data for duration
based schedules, resource loaded schedules and cost loaded schedules with Primavera
Unifier. Primavera Gateway supports this integration with the Unifier provider.

Integrating P6 with the Unifier provider enables sharing of cost details for projects scheduled in P6
EPPM. The Gateway application facilitates the integration process.

This chapter describes how to setup the environment to enable data exchange between P6 and
the Unifier providers.

In This Section

Installation Prerequisites for INtegration..............eeveevereeeeeieeieeeiiiieiiieeiieeeeeeeeneenees 113
Setting up the Integration ENVIFONMENT............ccooiiiiiiiiiii e 114
Adding User-Defined Fields (UDFs) and Codes to P6 EPPM ..........cccccceiiiiiiiiins 125

Installation Prerequisites for Integration

To set up an environment for data exchange through Primavera Gateway, you should have
access to the following applications:

» Primavera Unifier
» P6 EPPM
» Primavera Gateway selecting the Unifier and P6 providers.

For integration purposes the following must be set:

» Only existing projects in P6 and Unifier can be integrated.
» The projects which need to be linked must have the same Project Number and Project ID in
the respective products.
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Setting up the Integration Environment

In This Section

Configuring the P6 User INterface ... 114
Configuring the Unifier User INterface..........cooooo i 114
Configuring the Primavera Gateway User Interface.........ccccccuvvveeiviceivveiiiiin e, 115
Supported Field Mapping TEMPIAtES ......vveiii e 119

Configuring the P6 User Interface

To set up the integration environment, in the P6 EPPM user interface, enter the following
information in the Gateway Settings tab of the P6 EPPM Administer Application Settings:

»

The Primavera Gateway API URL and valid credentials to enable P6 to connect to Unifier
through Gateway. For example, http://<hostName>:<portNumber>/gateway

The P6 deployment name created in Primavera Gateway for the P6 instance

The synchronizations to be executed to exchange data with Unifier.

The Project Number and Project ID must be identical in P6 EPPM and Primavera Unifier
applications.

Before sending any project data from P6 ensure that the Scheduled Type is selected for that
project.

The project that needs to be integrated in Unifier must be linked to a P6 project. For more
information on linking projects, see the relevant application's documentation.

Configuring the Unifier User Interface

To set up the integration, enter the following information in the Primavera Unifier user interface:

For Activity Sheet integration, specify the following information on the Integration Settings
screen in the Unifier user interface:

»

In the API URL field, enter the URL to access the Gateway application. For
example, <host>:<port>/gateway
In the User Name field, enter the name of the Gateway administrator.

In the Password field, enter the administrator's password for the Primavera Gateway
application.

Select Test Connection to ensure connectivity with Primavera Gateway.

In the Unifier Deployment enter a short name for the Unifier deployment.

In the Import Synchronization field, select the default import synchronization to be applied in
Unifier.

In the Export Synchronization field, select the default export synchronization to be applied in
Unifier.

For Summary Sheet integration, ensure that the Project Number and Project ID are identical in
P6 EPPM and Primavera Unifier applications.
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Configuring the Primavera Gateway User Interface

This section describes how to configure the Gateway user interface.

Adding an Application Deployment Connection

To move data between applications, you must first add application deployment connections for
Primavera Unifier and P6 EPPM so Primavera Gateway knows where to retrieve and send
information.

To add an application deployment connection you must specify the Endpoint URL:

1) Login to Primavera Gateway with administration credentials.
2) Select Configuration.

3) Select Deployments.

4) Select Add.

5) Follow the steps in the Add Deployment wizard to name the deployment and set its
parameters. Select Save.

Using Business Flows Delivered in Gateway
The following flow types are available to transfer data between Prime and P6:

» Master Data Flow Type
» Project Data Flow Type

Exporting Project Data from P6

To export project data from P6 to Primavera Unifier, you can use the following default business
flows and synchronizations in the Gateway user interface. You can also create your own business
flows and synchronizations if these don't fit your needs.

Note: All Gateway settings described below will be overridden by the flow
invoked from the P6 user interface.

Default Business Flows

Use the Send to Primavera Unifier default business flow and synchronization to export the
following objects from P6 with the appropriate default field mapping template after the name:

» Export a Schedule Type attribute for a project to link the projects in the two application using
the field mapping template, "Sync P6 and Unifier Projects"

Note: The Sync P6 and Unifier Projects is a mandatory template to
include in the Send to Primavera Unifier business flow. All other
templates are optional depending on what data is being sent to Unifier.

Export a WBS object using the field mapping template, "Send WBS Hierarchy to Unifier"

Export a CBSDurationSummary object using the field mapping template, "Send CBS
Summary Data to Unifier"

» Export a CBSResourceSpread object using the field mapping template, "Send Resource
Summary and Spread Data to Unifier"
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» Export a CBSExpenseSpread object using the field mapping template, "Send Expense
Summary and Spread Data to Unifier"

Use the Get Activity Data from P6 default business flow and synchronization to to export an
Activity object from P6 with the appropriate default field mapping template after the name:

» Export an Activity object to create a new Activity sheet using the field mapping template,
"Create Activity Sheet from P6" or update an existing Activity sheet using the field mapping
template, "Update Activity Sheet from P6".

Source Application Default Settings
The following source parameters are available by default. Users with the Gateway administrator
roles can access and view all hidden parameters. You can also change these settings.

Note: Unless specified in parentheses, all parameters listed below are
hidden from a non-administration users.
P6 Filter

Use this setting to specify Projects with specific fields and values to be exported from P6 EPPM.
Select Add row to specify additional values and export multiple project IDs from P6.

Spread Period Type

Use this setting to select the default spread period type to be exported P6 EPPM. Options include,
Week, Month, Day, and Financial Period.

Activity Filter

Use this setting to specify Activities with specific fields and values to be exported from P6 EPPM.
Select Add row to specify additional values and export multiple activities from P6.

Resource Assignment Filter

Use this setting to specify ResourceAssignments with specific fields and values to be exported
from P6 EPPM. Select Add row to specify additional values and export multiple resource
assignments from P6.

Baseline Ids

Use this setting to specify multiple baseline IDs to be exported from P6 EPPM as
comma-separated values.

Delete Data that no longer exists in Primavera?

Use this setting to determine whether data that no longer exists in P6 is deleted.
Summarize project(s) before synchronization?

Use this setting to determine whether to schedule projects before a synchronization.
Synchronize WBS Hierarchy

Use this setting to determine whether to synchronize a complete, partial, or a leveled WBS
hierarchy. The P6 setting for WBS will override the setting in Gateway.
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Destination Application Default Settings

None

Importing Project Data to P6

To import project data from Primavera Unifier to P6, you can use the following default templates in
the Gateway user interface. You can also create your own if these templates don't fit your needs.
Default Business Flows

The following business flows are available:

» Use the Update from Primavera Unifier default business flow and synchronization to import
CBS codes from Primavera Unifier using the field mapping template, "Pull CBS Codes from
Unifier".

» Use the Send Activity data to P6 business flow and synchronization to import an activity from
Primavera Unifier using the field mapping template, "Send Activity data to P6".

Note: All Gateway settings described below will be overridden by the flow
invoked from the P6 user interface.

Source Application Default Settings
The following source parameters are available by default. Users with the Gateway administrator
roles can access and view all hidden parameters. You can also change these settings.

Note: Unless specified in parentheses, all parameters listed below are
hidden from a non-administration users.
Unifier Project Filter (Optional)

Use this setting to filter Unifier projects by objects, fields, and values to be imported from
Primavera Unifier. Select Add row to specify additional values and export multiple project IDs
from Uniifer.

Destination Application Default Settings

The following destination application parameters are available by default. Users with Gateway
administrator roles can access and view all hidden parameters. You can also change these
settings.

Note: Unless specified in parentheses, all parameters listed below are
hidden from non-administration users.
EPS Location
Use this setting to define the EPS node where the projects are located in P6.
Resource Destination

Use this setting to define the resource ID where the imported resources from Unifier are to be
created in P6. Enter the location in the destination provider where the resource object is to be
created.
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Role Destination

Enter the location in the destination provider where the resource object is to be created.
Calculate Cost from Units

Use this setting to determine whether to calculate costs from the units.

Auto Compute Actuals

Use this setting to determine whether the actuals are to be auto-computed.

Delete data that no longer exists in 3rd party application?

Use this setting to determine whether data that no longer exists in a third-party application is
deleted.

Schedule project(s) after synchronization?

Use this setting to determine whether to schedule projects after a synchronization.
Summarize project(s) after synchronization?

Use this setting to determine whether to summarize projects after a synchronization.
Save data to P6 if there are errors

Use this setting to determine whether to save the data in P6 although errors were encountered
during the import.

Synchronize one project at atime

Use this setting to determine whether to synchronize one project at a time.
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Supported Field Mapping Templates

The following tables show field mappings supported in each field mapping template:

Note: If you link the P6 and Unifier projects using

the uuu_int_p6_project_id field, then if you update the Project ID
field in P6, you must manually update the P6 Project ID field
(uuu_p6_project_id) in the corresponding Unifier shell.

Sync P6 and Unifier Projects

This is a mandatory export project template which must be included in the business flow to export
summary data from P6 to Unifier. However, this template is not mandatory for Send Activity data
from P6 to Unifier. Use this template to establish a link between a Unifier and P6 projects. This
template creates a new Activity Sheet in Unifier projects.

P6 Primavera Unifier

ID ProjectNumber

Name ProjectName
ProjectScheduleType uuu_int_schedule_type

Create Activity Sheet from P6

Use this field mapping template in an export project as well as an import project business flow to
create an activity data sheet from P6.

Notes: With editing data mapping templates in Primavera Gateway:

= To map Unifier elements to Activity Sheet attributes, ensure that the
data types of P6 Activity elements match the data definition of Unifier
activity attributes.

= To map an Indicator type field from Unifier to a P6 UDF, ensure you
specify the data type as String.
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P6 Unifier

Id uuu_P6Activityld
Name uuu_P6ActivityName
WBSCode uuu_P6WBSCode
WBSName uuu_P6WBSName
WBSPath uuu_P6WBSPath
Status uuu_P6ActivityStatus
Type uuu_P6ActivityType

PercentComplete

uuu_P6PercentComplete

PlannedTotalCost

uuu_P6PlannedTotalCost

ActualTotalCost

uuu_P6ActualTotalCost

AtCompletionTotalCost

uuu_P6AtCompletionTotalCost

RemainingTotalCost

uuu_P6RemainingTotalCost

PlannedStartDate

uuu_P6PlannedStart

PlannedFinishDate

uuu_P6PlannedFinish

ActualStartDate

uuu_P6ActualStart

ActualFinishDate

uuu_P6ActualFinish

StartDate

uuu_P6Start

FinishDate

uuu_P6Finish

RemainingEarlyStartDate

uuu_P6RemainingEarlyStart

RemainingEarlyFinishDate

uuu_P6RemainingEarlyFinish

PlannedDuration

uuu_P6PlannedDuration

ActualDuration

uuu_P6ActualDuration

AtCompletionDuration

uuu_P6AtCompletionDuration

RemainingDuration

uuu_P6RemainingDuration
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Update Activity Sheet from P6

Use this export project field mapping template to update P6 activity data elements in Unifier from
P6.

Note: Do not include fields that are common to this template and the
'Send Activity Data to P6' template. Otherwise incorrect data will be
moved across applications.

P6 Unifier

Id uuu_P6Activityld
Name uuu_P6ActivityName
WBSCode uuu_P6WBSCode
WBSName uuu_P6WBSName
WBSPath uuu_P6WBSPath
Status uuu_P6ActivityStatus
Type uuu_P6ActivityType

PercentComplete

uuu_P6PercentComplete

PlannedTotalCost

uuu_P6PlannedTotalCost

ActualTotalCost

uuu_P6ActualTotalCost

AtCompletionTotalCost

uuu_P6AtCompletionTotalCost

RemainingTotalCost

uuu_P6RemainingTotalCost

PlannedStartDate

uuu_P6PlannedStart

PlannedFinishDate

uuu_P6PlannedFinish

StartDate

uuu_P6Start

FinishDate

uuu_P6Finish

RemainingEarlyStartDate

uuu_P6RemainingEarlyStart

RemainingEarlyFinishDate

uuu_P6RemainingEarlyFinish

PlannedDuration

uuu_P6PlannedDuration

ActualDuration

uuu_P6ActualDuration

AtCompletionDuration

uuu_P6AtCompletionDuration

RemainingDuration

uuu_P6RemainingDuration
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Send Activity Data to P6

Use this import project template to send activity data sheet to P6. This template maps fields of
‘Activity Sheet Attributes’ form to P6 ‘Activity’ object which get updated in Unifier through business
process records.

Notes:

Do not include fields that are common to this template and the 'Update
Activity Data from P6' template. Otherwise incorrect data will be
moved across applications.

If an Activity Type in a schedule is a “Start Milestone”, then you cannot

update the Actual Finish Date in P6. So, do not update the Actual
Finish Date for this activity in Unifier and try to send it to P6.
Otherwise, incorrect data will be moved between applications.

= |f an Activity Type in a schedule is a “Finish Milestone” then you
cannot update the Actual Start Date in P6. So, do not update
the Actual Start Date for this activity in Unifier and try to send it to P6.
Otherwise, incorrect data will be moved between applications.

= Project filter conditions must always be defined in the synchronization.
If you define the condition in the business flow, instead of the
synchronization, Gateway will not know which projects to send the

data from.

Unifier P6
uuu_P6Activityld Id
uuu_P6ActualStart ActualStartDate

uuu_P6ActualFinish

ActualFinishDate

Send WBS Hierarchy to Unifier

Use this export project template to map P6 WBS attributes to Unifier CBS codes such that cost

codes can get created in a Unifier Cost Sheet.

P6 Unifier
Code Code
item item
SequenceNumber orderid
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Use this export project template for a Duration-based Schedule Type, to create or update the
master as well as the baseline Summary Sheets in Unifier.

From P6

To Unifier

ProjectName

Title

BaselineType

BaselineType

DataDate

DataDate

SummaryPlannedStartDate

PlannedStart

SummaryPlannedFinishDate

PlannedFinish

SummaryActualStartDate

ActualStart

SummaryActualFinishDate

ActualFinish

SummaryRemainingStartDate

RemainingStart

SummaryRemainingFinishDate

RemainingFinish

SummaryPlannedDuration

PlannedDuration

SummaryRemainingDuration

RemainingDuration

SummaryActualDuration

ActualDuration

SummaryPercentComplete

PercentComplete

Send Resource Summary and Spread Data to Unifier

Use this export project template for a Resource-loaded Schedule Type or a Cost-loaded Schedule
Type to create or update Master as well as baseline Summary Sheets in Unifier using the

Resource by CBS summary data from a P6 Schedule.

P6

Unifier

BaselineType

BaselineType

Currencyld currencyld
DataDate DataDate
StartDate StartDate
EndDate EndDate
ProjectName Title
Resourceld uuu_role_id
ResourceName uuu_role_name
ResourceType uuu_role_type
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P6 Unifier

UnitName UnitName
UnitAbbreviation uuu_role_uom
SummaryActualCost SummaryActualCost

SummaryActualFinish

SummaryActualFinish

SummaryActualStart

SummaryActualStart

SummaryActualUnits

SummaryActualUnits

SummaryAtCompletionCost

SummaryAtCompletionCost

SummaryAtCompletionUnits

SummaryAtCompletionUnits

SummaryPlannedCost

SummaryPlannedCost

SummaryPlannedFinish

SummaryPlannedFinish

SummaryPlannedStart

SummaryPlannedStart

SummaryPlannedUnits

SummaryPlannedUnits

SummaryRemainingCost

SummaryRemainingCost

SummaryRemainingFinish

SummaryRemainingFinish

SummaryRemainingStart

SummaryRemainingStart

SummaryRemainingUnits

SummaryRemainingUnits

PlannedUnits

PlannedUnits

ActualUnits

ActualUnits

RemainingUnits

RemainingUnits

AtCompletionUnits

AtCompletionUnits

PlannedCost

PlannedCost

ActualCost

ActualCost

RemainingCost

RemainingCost

AtCompletionCost

AtCompletionCost

124




Primavera Gateway Setup Tasks

Send Expense Summary and Spread Data to Unifier

This is a project data field-mapping template for a Resource-loaded Schedule Type or a
Cost-loaded Schedule Type to create or update the master as well as baseline summary sheets in
Unifier using the Expense by CBS summary data from the P6 schedule.

P6

Unifier

BaselineType

BaselineType

DataDate DataDate

StartDate StartDate

EndDate EndDate
ProjectName Title
ExpenseCategoryName ExpenseCategory
SummaryActualCost SummaryActualCost

SummaryActualUnits

SummaryActualUnits

SummaryAtCompletionCost

SummaryAtCompletionCost

SummaryAtCompletionUnits

SummaryAtCompletionUnits

SummaryPlannedCost

SummaryPlannedCost

SummaryPlannedUnits

SummaryPlannedUnits

SummaryRemainingCost

SummaryRemainingCost

SummaryRemainingUnits

SummaryRemainingUnits

PlannedUnits

PlannedUnits

ActualUnits

ActualUnits

RemainingUnits

RemainingUnits

AtCompletionUnits

AtCompletionUnits

PlannedCost

PlannedCost

ActualCost

ActualCost

RemainingCost

RemainingCost

AtCompletionCost

AtCompletionCost
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Adding User-Defined Fields (UDFs) and Codes to P6 EPPM

You have the option to add User-Defined Fields (UDFs) and codes to P6 EPPM and to prepare the
P6 EPPM database for synchronizing the data.

For example, if your application has UDFs or codes that P6 EPPM does not have, you can add
these UDFs or codes.

Adding P6 User-Defined Fields and Codes to Providers
You can have additional P6 UDFs and codes available for synchronization and field mapping
templates for a selected provider (for example, Primavera Unifier).

Note: If you want to add UDFs or codes to your providers, submit a
Service Request to My Oracle Support.

Sharing Data Between Oracle Primavera Prime and P6 EPPM

Integrating Oracle Primavera Prime with P6 EPPM enables you to share data for the following
purposes:

» Project details related to budget, costs, schedule, and scope

» Perform quantitative risk analysis in Prime and send the data to P6

» Resource and Role information can be imported to Oracle Primavera Prime from P6

The Gateway integration tool facilitates the integration process. Data can be shared between the
two applications using any of the following workflows:
» Using the P6 EPPM or the the Oracle Primavera Prime user interface

You can create projects in P6 EPPM and send the data to the Oracle Primavera Prime
application from the P6 EPPM user interface, and vice-versa.

For more details refer to the P6 EPPM online help for sending P6 EPPM data to Oracle
Primavera Prime.

» Using the Primavera Gateway user interface

You can log in to the user interface as a Gateway administrator and set up and schedule data
synchronization jobs between the two applications. For more details, refer to the Primavera
Gateway online help.

In This Section

Configuring the Oracle Primavera Prime User Interface..........ccccccoceeiiieeiiiiiniinnnnnn. 127
Configuring the P6 EPPM User INterface ..........ccovvvviiiiiiiieciiici e 127

Using Business Flows Delivered in GateWay ............ocouuueiiiiiieiiiiiiiiiiieeeeeeeeeeeiieennn 127
Supported Field Mapping Templates for Capital Plan Management...................... 134
Supported Field Mapping Templates for All Prime Data...........cccccoeeeeieeeevveiviinnnnnn. 137
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Configuring the Oracle Primavera Prime User Interface

To set up the integration environment, specify the default synchronizations that are to be executed
in the Primavera P6 Integration section of the Application Settings page in the Oracle
Primavera Prime interface.

The fields include:

» Send Projects to P6

» Update Projects from P6

» Update Resources from P6
» Update Roles from P6

Configuring the P6 EPPM User Interface

To set up the integration environment, specify the following settings in the P6 EPPM user
interface:

» Specify the information in the Gateway Settings tab of P6 EPPM Administer Application
Settings.

» Setup the Workspace structure which will be sent from Prime to P6 using the Master Data flow.
If the workspace is not created in Prime, you can alternatively specify the workspace location
as a P6 Provider parameter value in Gateway.

Using Business Flows Delivered in Gateway

The following flow types are available to transfer data between Prime and P6:

» Master Data Flow Type
» Project Data Flow Type

Exporting Master Data

To export master data from P6 to Prime from the Primavera Gateway interface, you can use the
following default template. You can also create your own if this template don't fit your needs.

Default Business Flow

Use the "Create EPS Code in Prime" default business flow to export the following master data
from P6 to Prime with the appropriate default field mapping templates after the name:

» Export an EPS business object using the field mapping template “Sync EPS to EPS Code".

» Export a Location business object using the field mapping template "P6 Location to Prime".

» Export an UDFType business object using the field mapping template "Synchronize UDF
Fields from P6".

Source Application Parameter Settings

The following source application parameters are available by default. Each business flow will have
the same defaults for the parameters as follows. All parameters are set to Hidden in the Gateway
user interface. Only users with Gateway Administrator roles can access and change the
parameter display settings and indicate if each is Required, Optional, or Read-only.
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Note: Unless specified in parentheses, all parameters listed below are
hidden from non-administration users.

» P6 UDF Type Filter

When you choose to export an UDFType business object, use this parameter to determine
which P6 UDF Types you will send to Oracle Primavera Prime. Options include: Activity,
Activity Expense, Project, Resource, Resource Assignment, and WBS.

Default Destination Application Parameter Settings

The following destination application parameters are available by default. Each business flow will
have the same defaults for the parameters as follows. All parameters are set to Hidden in the
Gateway user interface. Only users with Gateway Administrator roles can access and change the
parameter display settings and indicate if each is Required, Optional, or Read-only.

» Workspace Location (Required)

Use this setting to specify the default workspace and populate it in the default synchronization.
If the value is set in Primavera Gateway, the Prime provider will check the Prime Workspace
field value for the project being exported in the P6 user interface.

P6 must send all global data assigned to the project with the project flow and all of that global
data must be assigned to the workspace to determine where the project will be created in
Prime.

Importing Master Data

To import data from Prime to P6, you can use the following default templates. You can also
create your own if these templates don't fit your needs.

Default Business Flows

Use the "Create Workspace Code in P6" default business flow with the following field mapping
templates after the name:

» Import Project Code business objects using the field mapping, “Sync workspaces to Prime
Workspace Code".

» Import Project Code Type business objects using the field mapping, "Create Project Code
Type Fields in P6".

Default Source Application Parameter Settings

Set the following parameter:

» Delete data that no longer exists in 3rd party application?
Use this setting to delete redundant data that no longer exists in any third-party application.
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Default Destination Application Parameter Settings

The following destination application parameters are available by default. All parameters are set
to Hidden in the Gateway user interface. Only users with Gateway administrator roles can access
and view all hidden parameters. You can also change these settings. and indicate if each

is Required, Optional, or Read-only.

Note: Unless specified in parentheses, all parameters listed below are
hidden from non-administration users.

» Resource Destination
Use this setting to specify the location of the resource objects imported into P6.
» Role Destination
Use this setting to specify the location of the role objects imported into P6.
» Calculate Costs from Units
Use this setting to determine whether to calculate costs from the units.
» Auto Compute Actuals
Use this setting to determine whether the actuals are to be auto-computed.
» Save Datato P6 if there are errors
Use this setting to determine whether to save the imported data in P6 with errors.
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Exporting Project Data

To export data from P6 to Prime from the Primavera Gateway interface, you can use the following
default templates. You can also create your own if these templates don't fit your needs.

Default Business Flows

These are the names of the default business flows with the appropriate default field mapping
template after the name:

» Create Projects from P6 to Prime with field mapping template “Create Projects from P6 to
Prime”.

» Synchronize Planned Budget and Plan Dates from P6 to Prime with field mapping template
“Synchronize Planned Budget and Plan Dates from P6 to Prime”.

» Synchronize Project Actual Cost and progress from P6 to Prime with field mapping template
“Synchronize Project Actual Cost and progress from P6 to Prime”.

» Sync P6 data to Prime with the following field mapping templates:
» "Sync P6 data to Prime".
» "Prime Project Actual Total Cost Spread from P6"
» "Prime Project Planned Total Cost Spread from P6"
» "Prime Project At Completion Total Cost Spread from P6"
» "Sync activity data for risk for Prime"
» "Sync calendar data for Prime"
» "Sync relationship data for Prime"
» "Sync Resource data for Prime"
» "Sync risk data for Prime"
»  "Sync risk threshold data for Prime"
» "Sync risk threshold level data for Prime"
» "Sync risk impact data for Prime"
» "Sync risk matrix data for Prime"
» "Sync risk matrix score data for Prime"
» "Sync risk matrix threshold data for Prime"
» "Sync risk response plan data for Prime"
» "Sync risk response action data for Prime"
» "Sync risk response action impact data for Prime"
» "Sync Role data for Prime"
» "Sync activity risk assignment data for Prime
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Default Source Application Parameter Settings

The following source application parameters are available by default. Each business flow will have
the same defaults for the parameters as follows. All parameters are set to Hidden in the Gateway
user interface. Only users with Gateway Administrator roles can access and change the
parameter display settings and indicate if each is Required, Optional, or Read-only.

Note: Unless specified in parentheses, all parameters listed below are
hidden from non-administration users.

» P6 Filter (Required)

Use this setting to determine which P6 projects you will send to Prime. Select Add row to
specify additional values and export multiple Project IDs, EPS IDs, Project Code Type
Name, or Project Code Value from P6.

» Spread Period Type

Use this setting to select the default spread period type to be exported P6 EPPM. Options
include, Week, Month, Day, and Financial Period.

» Activity Filter

Use this setting to specify an Activity business object with specific fields and values to be
exported from P6 EPPM. Select Add row to specify additional values and export multiple
activities filtered by specific Activity IDs, Activity Type, Activity Status, or Activity Code
from P6.

» Resource Assignment Filter

Use this setting to specify ResourceAssignment business objects with specific fields and
values to be exported from P6 EPPM. Select Add row to specify additional values and export
multiple resource assignments filtered by specific Resource IDs or Resource Type from P6.

» Baseline lds

Use this setting to specify multiple baseline IDs to be exported from P6 EPPM as
comma-separated values.

» Delete Data that no longer exists in Primavera?

Use this setting to determine whether data that no longer exists in P6 is deleted.
» Summarize project(s) before synchronization?

Use this setting to determine whether to schedule projects before a synchronization.
» Synchronize WBS Hierarchy

Use this setting to determine whether to synchronize a complete, partial, or a leveled WBS
hierarchy. The P6 setting for WBS will override the setting in Gateway.
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Default Destination Application Parameter Settings

The following destination application parameters are available by default. Each business flow will
have the same defaults for the parameters as follows. All parameters are set to Hidden in the
Gateway user interface. Only users with Gateway Administrator roles can access and change the
parameter display settings and indicate if each is Required, Optional, or Read-only.

» Workspace Location
Use this setting to specify the default workspace and populate it in the default synchronization.
If the value is set in Primavera Gateway, the Prime provider will check the Prime Workspace
field value for the project being exported in the P6 user interface.

P6 must send all global data assigned to the project with the project flow and all of that global
data must be assigned to the workspace where the project will be created in Prime.

Importing Project Data

To import data from Prime to P6, you can use the following default templates. You can also create
your own if these templates don't fit your needs.

Note: For Import Project flows to work, ensure that the PlannedBudget
UDF of type Cost is included P6. Otherwise, create this UDF before
running the flow.

Default Business Flows

These are the names of the default business flows with the appropriate default field mapping
template after the name:

» Use the "Create Projects from Prime to P6" business flow with the field mapping template
“Create Projects from Prime to P6” to create projects in Prime.

» Use the "Update P6 Project with Prime data" business flow with the "Update P6 Project with
Prime Data" field mapping template to update P6 projects with Prime data.

» Use the "Update P6 Project with Prime data" business flow with the "Update Activity Risk
results for P6" field mapping template to update P6 projects with Prime data.

» Use the "Synchronize Proposed Budget and Plan Dates from Prime to P6" business flow with
the field mapping template “Synchronize Proposed Budget and Plan Dates from Prime to P6”
to synchronize proposed budget and plan date from Prime in P6.

» Use the "Synchronize Approved Budget and Plan Dates from Prime to P6" with the field
mapping template "Synchronize Approved Budget and Plan Dates from Prime to P6” to
synchronize approved budget and plan dates from Prime in P6.
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Default Source Application Parameter Setting

The following source application parameter is available by default. All parameters are set

to Hidden in the Gateway user interface. Only users with Gateway administrator roles can access
and view all hidden parameters. You can also change these settings. and indicate if each

is Required, Optional, or Read-only.

»

Prime Project Filter (Required)

You can filter by Project ID, Workspace ID, Project Code Type Name, Project Code Value, and
Project Status. You can use the P6 Provider filter parameter for reference during
implementation.

Default Destination Application Parameter Settings

The following destination application parameters are available by default. All parameters are set
to Hidden in the Gateway user interface. Only users with Gateway administrator roles can access
and view all hidden parameters. You can also change these settings. and indicate if each

is Required, Optional, or Read-only.

Note: Unless specified in parentheses, all parameters listed below are
hidden from non-administration users.

EPS Location (Required)

You need to determine the default EPS node and populate it in the default synchronization for
P6.

Resource Destination

Use this setting to specify the location of the resource objects imported into P6.
Role Destination

Use this setting to specify the location of the role objects imported into P6.
Calculate Costs from Units

Use this setting to determine whether to calculate costs from the units.

Auto Compute Actuals

Use this setting to determine whether the actuals are to be auto-computed.
Delete data that no longer exists in 3rd party application?

Use this setting to determine whether data that no longer exists in a third-party application can
be deleted.

Schedule project(s) after synchronization?

Use this setting to determine whether to schedule projects after a synchronization.
Summarize project(s) after synchronization?

Use this setting to determine whether to summarize projects after a synchronization.
Save Data to P6 if there are errors

Use this setting to determine whether to save the imported data in P6 with errors.
Synchronize one project at atime

Use this setting to determine whether to synchronize one project at a time.

133



Primavera Cloud Service Administrator's Guide

Supported Field Mapping Templates for Capital Plan Management

These tables show supported field mappings:

Create Projects from Prime to P6

This is an import business flow that support projects starting in Prime then pushed to P6. This
business flow will create a new project in the destination application with project data such as
Status, Dates, Owner and Planned Budget.

Note: On the P6 side a UDF needs to be created to support the Prime
planned budget value. This can be done in the P6 setup utility in Gateway.

From Prime To P6

Projectld Id

ProjectName Name

Description Description

Status Status

Owner OwnerResourceld
PlannedStartDate PlannedStartDate
PlannedFinishDate MustFinishByDate

Planned Budget

*Planned Budget (UDF)

IntegratedType

IntegratedType

ParentEPSId

ParentEPSId

Create Projects from P6 to Prime

This is an export business flow that support projects starting P6 then pushed to Prime. This
business flow will create a new project in the destination application with project data such as

Status, Dates and Owner.

From P6 To Prime

Id Projectid

Name ProjectName
Description Description

Status Status
OwnerResourceld Owner
PlannedStartDate PlannedStartDate
MustFinishbyDate PlannedFinishDate
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Synchronize Proposed Budget and Plan Dates from Prime to P6

This is an import business flow that supports a top down budgeting process where proposed
budgets and dates are pulled from Oracle Primavera Prime and pushed to P6.

Note: If you want to use the change log functionality, you need to
manually move the UDF value to the change log with a Pending status.

From Prime To P6

Projectld Id

ProjectName Name

Description Description

Status Status

Owner OwnerResourceld
PlannedStartDate PlannedStartDate
PlannedFinishDate MustFinishByDate
ProposedBudget *ProposedBudget (UDF)

Synchronize Planned Budget and Plan Dates from P6 to Prime

This is an export business flow that supports a bottom up budget process where planned budgets
and dates are pulled from P6 and pushed to Oracle Primavera Prime.

From P6 To Prime

Id Projectld

Name ProjectName
Description Description

Status Status
OwnerResourceld Owner
PlannedStartDate PlannedStartDate
MustFinishByDate PlannedFinishDate

SummaryPlannedCost

PlannedBudget
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Synchronize Approved Budget and Plan Dates from Prime to P6

This is an import business flow where approved budgets are pushed from Oracle Primavera Prime
to P6.

From Prime To P6

Projectld Id

ProjectName Name

Description Description

Status Status

Owner OwnerResourceld
PlannedStartDate PlannedStartDate
PlannedFinishDate MustFinishByDate
ProposedBudget *ProposedBudget (UDF)
CurrentApprovedBudget CurrentBudget

Synchronize Project Actual Cost and progress from P6 to Prime

Once the P6 project is in the execution phase, progress data such as Actual cost, schedule
percent complete, and dates are transferred to Prime.

*You can modify this template to support duration or performance percent complete.

From P6 To Prime

Id Projectld

Name ProjectName
Description Description
Status Status
OwnerResourceld Owner
SummaryActualStartDate ActualStartDate
SummaryActualFinishDate ActualFinishDate
SummaryActualTotalCost ActualCost
SlummaryScheduIePercentCom *PercentComplete
plete
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Prime Project Planned Total Cost Spread from P6

You should include all necessary spread field mappings, such as, period start/finish dates.

From P6 To Prime
PeriodType PeriodType
StartDate StartDate

EndDate EndDate

Planned Total Cost Planned Total Cost

Prime Project Actual Total Cost Spread from P6

You should include all necessary spread field mappings, such as, period start/finish dates. This is
documented to just include the specific cost spread mapped from P6 to Oracle Primavera Prime.

From P6 To Prime
PeriodType PeriodType
StartDate StartDate
EndDate EndDate
ActualTotalCost ActualTotalCost

Prime Project At Completion Total Cost Spread from P6

All necessary spread field mappings must be included, such as period start/finish dates.

From P6 To Prime

PeriodType PeriodType

StartDate StartDate

EndDate EndDate
AtCompletionTotalCost AtCompletionTotalCost
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Supported Field Mapping Templates for All Prime Data

The following tables show field mappings supported in each field mapping template:

Synchronize Project Actual Cost and Progress from P6 to Prime

Once the P6 project is in the execution phase, progress data such as Actual cost, schedule
percent complete and dates are transferred to Prime.

P6 Prime

Id Projectid

Name ProjectName
Description Description
Status Status
OwnerResourceld Owner
SummaryActualStartDate ActualStart
SummaryActualFinishDate ActualFinish
SummaryActualTotalCost ActualCost
SummarySchedulePercentComplete PercentComplete

Synchronize Planned Budget and Plan Dates from P6 to Prime

This is an export project field mapping template that supports a bottom up budget process where
planned budgets and dates are pulled from P6 and pushed to Prime.

P6 Prime

Id Projectld

Name ProjectName
Description Description

Status Status
OwnerResourceld Owner
PlannedStartDate PlannedStartDate
MustFinishByDate PlannedFinishDate

PlannedFinishDate

PlannedFinishDate

SummaryPlannedCost

PlannedBudget
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Sync P6 Data to Prime

This is an export project field mapping template that supports projects starting in P6 then pushed
to Prime. This field mapping template will create a new project in the destination application with
project data such as Status, Dates, and Owner. For example, use this template for integrating

cost, scope, and risk data.

P6 Prime

Id Projectid
Name ProjectName
Description Description
Status Status
OwnerResourceld Owner

PrimeWorkspace

PrimeWorkspace

PlannedStartDate PlannedStartDate
MustFinishByDate PlannedFinishDate
SummaryPlannedCost PlannedBudget
SummaryActualTotalCost ActualCost
SummaryAtCompletionTotalCost AtCompletionCost
DataDate DataDate
StartDate StartDate
FinishDate FinishDate

SummaryPlannedDuration

PlannedDuration

SummaryRemainingDuration

RemainingDuration

LocationName

LocationName

LocationObjectld

LocationCode

CalculateFloatBasedOnFinishDate

CalculateFloatBasedOnFinishDate

ComputeTotalFloatType

ComputeTotalFloatType

CriticalActivityFloatThreshold

CriticalActivityFloatThreshold

IgnoreOtherProjectRelationships

IgnoreOtherProjectRelationships

MakeOpenEndedActivitiesCritical

MakeOpenEndedActivitiesCritical

MaximumMultipleFloatPaths

MaximumMultipleFloatPaths

MultipleFloatPathsEnabled

MultipleFloatPathsEnabled
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MultipleFloatPathsEndingActivityObje
ctid

MultipleFloatPathsEndingActivityObjectld

MultipleFloatPathsUseTotalFloat

MultipleFloatPathsUseTotalFloat

OutOfSequenceScheduleType

OutOfSequenceScheduleType

RelationshipLagCalendar

RelationshipLagCalendar

StartToStartLagCalculationType

StartToStartLagCalculationType

UseExpectedFinishDates

UseExpectedFinishDates

ActivityDefaultCalendarName

ActivityDefaultCalendarName

ActivityDefaultCalendarObjectid

ActivityDefaultCalendarObjectid

SummaryActualStartDate ActualStart
SummaryActualFinishDate ActualFinish
StrategicPriority StrategicPriority
WebsiteURL URL

SummaryStartDateVariance

VarianceStartDate

SummaryFinishDateVariance

VarianceFinishDate

NetPresentValue

NetPresentValue

PaybackPeriod

PaybackPeriod

ReturnOnlnvestment

Returninvestment

AnnualDiscountRate

AnnualDiscountRate

SummaryPlannedValueByCost

PlannedValueCost

SummaryEarnedValueByCost

EarnedValueCost

SummaryScheduleVarianceByCost

ScheduleVariance

SummaryTotalCostVariance

CostVariance

SummarySchedulePerformancelndex
ByCost

SchedulePerformancelndex

SummaryCostPerformancelndexByCo
st

CostPerformancelndex

SummaryEstimateAtCompletionByCo
st

EstimateAtCompletionCost

SummaryEstimateToCompleteByCost

EstimateToCompletionCost
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CriticalActivityPathType

CriticalActivityPathType

RiskMatrixName

RiskMatrixName

RiskMatrixObjectld

RiskMatrixCode

SummaryRemainingTotalCost

SummaryRemainingTotalCost

Update P6 Project with Prime Data

This is an import project field mapping template that support projects starting Primethen pushed to
P6. This field mapping template will create a new project in the destination application with project

data such as Status, Dates, Owner and Planned Budget.

Prime P6

Projectld Id

ProjectName Name

Description Description

Status Status

Owner OwnerResourceld
PlannedStartDate PlannedStartDate

PlannedFinishDate

PlannedFinishDate

PlannedBudget

PlannedBudget

StrategicPriority

StrategicPriority

LocationName

LocationName

URL

WebsiteURL

IntegratedType

IntegratedType

ParentEPSId

ParentEPSId
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Update Activity Risk Results For P6

This is an import project field mapping template that support projects starting Prime then pushed

to P6.

Prime P6
Projectld Projectld
Id Id

PostResponsePessimisticFinish

PostResponsePessimisticFinish

PostResponsePessimisticStart

PostResponsePessimisticStart

PreResponsePessimisticFinish

PreResponsePessimisticFinish

PreResponsePessimisticStart

PreResponsePessimisticStart

Synchronize Approved Budget and Plan Dates from Prime to P6

This is an import business flow where approved budgets are pushed from Prime to P6.

Prime P6

Projectld Id

ProjectName Name

Description Description

Status Status

Owner OwnerResourceld

PlannedStartDate

PlannedStartDate

PlannedFinishDate

PlannedFinishDate

CurrentApprovedBudget

CurrentBudget
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Sync Proposed Budget and Plan Dates from Prime to P6

This is an import business flow that supports a top down budgeting process where proposed
budgets and dates are pulled from Prime and pushed to P6.

Prime P6

Projectld Id

ProjectName Name

Description Description

Status Status

Owner OwnerResourceld
PlannedStartDate PlannedStartDate
PlannedFinishDate PlannedFinishDate
ProposedBudget ProposedBudget

Sync Activity Data for Risk for Prime

This is an export project as well as an import project business flow supports synchronizing activity
data for projects in P6 and Prime.

P6 Prime

Name Name

Projectld Projectid

Id Id

CalendarName CalendarName
CalendarObjectld CalendarObjectld
CalendarObijectld CalendarCode

MaximumDuration

MaximumDuration

MinimumDuration

MinimumDuration

MostLikelyDuration MostLikelyDuration
PlannedDuration PlannedDuration
EarlyStartDate EarlyStartDate
ActualDuration ActualDuration

RemainingDuration

RemainingDuration

SecondaryConstraintDate

SecondaryConstraintDate
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SecondaryConstraintType

SecondaryConstraintType

Type Type
EarlyFinishDate EarlyFinishDate
StartDate StartDate
FinishDate FinishDate
LateStartDate LateStartDate

LateFinishDate

LateFinishDate

ActualStartDate ActualStartDate
ActualFinishDate ActualFinishDate
PlannedStartDate PlannedStartDate

PlannedFinishDate

PlannedFinishDate

PrimaryConstraintType

PrimaryConstraintType

PrimaryConstraintDate

PrimaryConstraintDate

Status

Status

IsStarred

IsStarred

RemainingEarlyStartDate

RemainingStart

RemainingEarlyFinishDate

RemainingFinish

RemainingLateStartDate

RemainingLateStart

RemainingLateFinishDate

RemainingLateFinish

SuspendDate SuspendDate
ResumeDate ResumeDate
PercentComplete ActivityPercentComplete
WBSCode WBSCode
IsWorkPackage IsWorkPackage
ExpectedFinishDate ExpectedFinishDate
DurationType DurationType
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Sync Risk Matrix Score Data for Prime

This is an export project field mapping template which synchronizes risk matrix score data pulled

from P6 and pushed to Prime.

P6 Prime
RiskMatrixName RiskMatrixName
RiskMatrixObjectld RiskMatrixCode
ProbabilityThresholdLevel ProbabilityThresholdLevel
Severityl Severityl
SeveritylLabel SeverityllLabel
Severity2 Severity2
Severity2Label Severity2Label
Severity3 Severity3
Severity3Label Severity3Label
Severity4 Severity4
Severity4Label Severity4Label
Severity5 Severity5
Severity5Label Severity5Label
Severity6 Severity6
Severity6Label Severity6Label
Severity7 Severity7
Severity7Label Severity7Label
Severity8 Severity8
Severity8Label Severity8Label
Severity9 Severity9
Severity9Label Severity9Label

Primavera Gateway Setup Tasks
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Sync risk response action data for Prime

This is an export project field mapping template that pulls risk response data from P6 into Prime.

P6 Prime
Id Id
Name Name

RiskResponsePlanld

RiskResponsePlanid

Activityld Activityld
StartDate StartDate
FinishDate FinishDate
PlannedStartDate PlannedStartDate

PlannedFinishDate

PlannedFinishDate

RemainingCost

RemainingCost

ActualCost

ActualCost

PlannedCost

PlannedCost

Status Status
Riskld Riskld
Projectld Projectld

Prime Project Planned Total Cost Spread from P6

This is an export project field mapping template that pulls planned total cost data from P6 to Prime.

P6 Prime
PeriodType PeriodType
StartDate StartDate
EndDate EndDate

PlannedTotalCost

PlannedTotalCost
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Prime Project Actual Total Cost Spread from P6

This is an export project data field mapping template that pulls actual total cost data from P6 to
Prime.

P6 Prime
PeriodType PeriodType
StartDate StartDate
EndDate EndDate
ActualTotalCost ActualTotalCost

Prime Project At Completion Total Cost Spread from P6

This is an export project data field mapping template that pulls the At completion total cost data
from P6 to Prime.

P6 Prime

PeriodType PeriodType

StartDate StartDate

EndDate EndDate
AtCompletionTotalCost AtCompletionTotalCost
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Sync Risk Data for Prime

This is an export project data field mapping template that pulls the Response total cost data from

P6 to Prime.

P6 Prime

Id Id

Projectld Projectld
Name Name

Type Type

Status Status
Description Description
Effect Effect

Cause Cause
Identified Date IdentifiedDate
ResponseTotalCost ResponseTotalCost
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Sync Activity Data for Risk for Prime

This is an export project data field mapping template that synchronizes activity risk data between

P6 and Prime.

P6 Prime

Name Name

Projectld Projectld

Id Id
CalendarName CalendarName
CalendarObijectld CalendarObijectld
CalendarObjectld CalendarCode

MaximumDuration

MaximumDuration

MinimumDuration

MinimumDuration

MostLikelyDuration

MostLikelyDuration

PlannedDuration

PlannedDuration

EarlyStartDate

EarlyStartDate

ActualDuration

ActualDuration

RemainingDuration

RemainingDuration

SecondaryConstraintDate

SecondaryConstraintDate

SecondaryConstraintType

SecondaryConstraintType

Type

Type

EarlyFinishDate EarlyFinishDate
StartDate StartDate
FinishDate FinishDate
LateStartDate LateStartDate
LateFinishDate LateFinishDate
ActualStartDate ActualStartDate

ActualFinishDate

ActualFinishDate

PlannedStartDate

PlannedStartDate

PlannedFinishDate

PlannedFinishDate

PrimaryConstraintType

PrimaryConstraintType

PrimaryConstraintDate

PrimaryConstraintDate
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Status

Status

IsStarred

IsStarred

RemainingEarlyStartDate

RemainingStart

RemainingEarlyFinishDate

RemainingFinish

RemainingLateStartDate

RemainingLateStart

RemainingLateFinishDate

RemainingLateFinish

SuspendDate

SuspendDate

ResumeDate

ResumeDate

PercentComplete

ActivityPercentComplete

WBSCode WBSCode
IsWorkPackage IsWorkPackage
ExpectedFinishDate ExpectedFinishDate
DurationType DurationType

Synchronize UDF Fields From P6

This is an export master data field mapping template which synchronizes UDF fields from P6 to

Prime.

P6 Prime
DataType DataType
Title Title
SubjectArea SubjectArea
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This is an export project data field mapping template which synchronizes relationship data from P6

Primavera Gateway Setup Tasks

to Prime.

P6 Prime
Type Type
Lag Lag

PredecessorActivityld

PredecessorActivityld

PredecessorActivityType

PredecessorActivityType

PredecessorProjectID

PredecessorProjectlD

SuccessorActivityld

SuccessorActivityld

SuccessorActivityType

SuccessorActivityType

SuccessorProjectID

SuccecssorProjectlD

Sync Risk Threshold Level Data for Prime

This is an export project data field mapping template which synchronizes risk threshold level data

from P6 to Prime.

P6 Prime

Name Name

Code Code
RiskThresholdName RiskThresholdName
RiskThresholdObijectld RiskThresholdCode
Color Color

Level Level

Range Range

CostRange CostRange
ScheduleRange ScheduleRange

ToleranceRange

ToleranceRange

ProbabiliityRange

ProbabiliityRange

ThresholdType

ThresholdType
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Sync Risk Threshold Data for Prime

This is an export project data field mapping template which synchronizes risk threshold data from

P6 to Prime.

P6 Prime

Name Name

Code Code
ThresholdType ThresholdType

Sync Risk Impact Data for Prime

This is an export project data field mapping template which synchronizes risk impact data from P6

to Prime.

P6 Prime

Projectld Projectid

Riskld Riskld
RiskThresholdName RiskThresholdName
RiskThresholdObjectid RiskThresholdCode
RiskThresholdLevelCode RiskThresholdLevelCode

Sync Risk Matrix Data for Prime

This is an export project data field mapping template which synchronizes risk matrix data from P6

to Prime.

P6 Prime

Name Name

Code Code

Description Description
RiskScoringMethod ImpactThresholdLevel
ImpactThresholdLevel ImpactThresholdLevel
ProbabilityThresholdLevel ProbabilityThresholdLevel
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Sync Risk Matrix Threshold Data for Prime

This is an export project data field mapping template which synchronizes risk matrix threshold

data from P6 to Prime.

P6 Prime
RiskMatrixName RiskMatrixName
RiskMatrixObjectld RiskMatrixCode
RiskThresholdName RiskThresholdName
RiskThresholdObijectld RiskThresholdCode

Sync Risk Response Plan Data for Prime

This is an export project data field mapping template which synchronizes risk response plan data

from P6 to Prime.

P6 Prime

Id Id

Name Name
Projectld Projectld
Riskld Riskld

IsActive IsActive
ResponseType ResponseType

Sync Risk Response Action Impact Data for Prime

This is an export project data field mapping template which synchronizes risk response action

impact data from P6 to Prime.

P6 Prime
RiskResponseActionld RiskResponseActionld
RiskThresholdName RiskThresholdName
RiskThresholdObijectld RiskThresholdLevelCode
RiskThresholdLevelCode RiskThresholdLevelCode
Riskld Riskld

Projectld Projectld
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Sync Risk Response Action Data for Prime

This is an export project data field mapping template which synchronizes risk response action data

from P6 to Prime.

P6 Prime
Id Id
Name Name

RiskResponsePlanld

RiskResponsePlanld

Activityld Activityld
StartDate StartDate
FinishDate FinishDate
PlannedStartDate PlannedStartDate

PlannedFinishDate

PlannedFinishDate

RemainingCost

RemainingCost

ActualCost

ActualCost

PlannedCost

PlannedCost

Status Status
Riskld Riskld
Projectld Projectld

Sync Activity Risk Assignment Data for Prime

This is an export project data field mapping template which synchronizes activity risk assignment
data from P6 to Prime.

P6 Prime
Riskld Riskld
Activityld Activityld
Projectid Projectid
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This is an import master data field mapping template which synchronizes workspace location

codes from Prime in P6.

P6 Prime
CodeTypeName CodeTypeName
CodeValue CodeValue
Description Description
SequenceNumber SequenceNumber

Create ProjectCode Type Fields in P6

This is an import master data field mapping template which synchronizes project code types from

Prime in P6.

Prime P6
Name Name
Length Length

Sync WBS Structure For P6

This is an import project data field mapping template which synchronizes the WBS structure from

Prime in PG6.

P6 Prime

Code Code

Name Name

Projectld Projectld
IsWorkPackage IsWorkPackage
SequenceNumber SequenceNumber
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Business Objects

The Gateway Provider Reference Guide provides a comprehensive listing of all business objects
and all associated fields available with each Primavera provider delivered with Primavera
Gateway. Review the list of supported business objects in each application to determine the data
that needs to be supported for integration in Primavera Gateway.

To view these business objects in the Primavera Gateway user interface,log in to Gateway and
select the Data Dictionary menu. To view these business objects on Oracle Technical Network,
navigate to the Primavera Gateway Product Library on Oracle Technical Network and

expand User Content.
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Bl Publisher Setup Tasks

Oracle Bl Publisher is a reporting solution to efficiently author, manage, and deliver reports and
documents.

Use the General Reporting Tasks section of this chapter to learn about the general setup tasks
that you should perform in order to setup and maintain Bl Publisher in your cloud environment. For
specific information about the tasks that are required to use Bl Publisher in terms of a product,
such as Oracle Primavera Prime, Primavera Unifier, and P6 EPPM, refer to one of the following
sections:

» Reporting in Oracle Primavera Prime
» Reporting in P6 EPPM
» Reporting in Primavera Unifier
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Bl Publisher Setup Tasks

Before getting started, familiarize yourself with the way Bl Publisher handles reports. The
application populates its list of reports from the Report Definitions that load from Bl Publisher's
web services. When you need to create or modify a report, you will use Bl Publisher. The BI
Publisher documentation will help you understand how it works. Before continuing with the
following sections, you need to learn about the following Report Definitions from the Bl Publisher
documentation:
» Data Model

»  Writing SQL queries and data templates
» Parameters

» Include these types: Text, Menu, Date, Boolean

»  Work with the List of Values

» Include different settings that you can set
» Templates

This chapter will tell you:

» How to configure Bl Publisher for Oracle Primavera Prime
» About Parameters

In This Section

Understanding Bl Publisher Security Models ............ccoooviiiiiiiiiiiiieeeeeeee, 158
Reports in Bl PUDIISNEN ... 158
Why DO | Ne€d ParameterS?.......cooooeiiiiiiie e 159

Understanding Bl Publisher Security Models

Bl Publisher is configured to use the Oracle Fusion Middleware Security Model for maintaining
users and security.

In this model, Bl Publisher resides in an Oracle WebLogic Server domain, where all resources are
managed as a unit. Bl Publisher security is managed in the active security realm configured for the
domain in which it resides. Each security realm consists of a set of configured security providers,
users, groups, security roles, and security policies that are used to protect WebLogic resources.
When a user attempts to access a particular WebLogic resource, WebLogic Server tries to
authenticate and authorize the user by checking the security role assigned to the user in the
relevant security realm and the security policy of the particular WebLogic resource.
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Reports in Bl Publisher

Bl Publisher integrates with Oracle Primavera Prime, Primavera Unifier, and the P6 EPPM
Extended Schema to deliver on-demand web-based reporting.

Associating Reports in the Catalog with their Data Model
To add reports when using the catalog:

1) Log in to Bl Publisher as a user with administrator privileges.

2) Navigate to the catalog folder that has the sample reports.

3) Select areport.

4) Click Edit.

5) Inthe top left hand corner, click the magnifying glass icon next to Data Model.

6) Select the corresponding data model with the same name as the report, and and click Open.
7) Save the report.

8) Repeat for each report in the folder.

Why Do | Need Parameters?

Oracle Primavera Prime supports parameter keys in Bl Publisher. Users will populate these
parameters when running and scheduling custom reports. For most of the parameters you add,
lists will be available for users when they are entering the value. The default behavior for an
unrecognized parameter will be to provide a plain text box. The user will then need to type in the
correct value. If the value is not in the format the report expected, the report will fail to run.

Adding parameters to your reports allows users to run or schedule a report. They can select or
filter what data to include without having to first create additional reports or data templates for
reports. For example, consider this scenario:

» You have a report on projects and each project has a code value assigned to it to determine
the department of the team working on it.

» You want each team to be able to run the report, but they want to see only the capital plans for
their location.

Without parameters, you would need to create a different report and data template for each team.
All of these reports would be almost the same, except each statement pulling the report data
would have a different connection to the project code table to match the correct location. With
parameters, you can do this with one report and data template.
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Defining Parameters in Bl Publisher

When adding a new parameter in Bl Publisher you will see the following fields:

4

4

Identifier — The key for the parameter. Determines whether a list supports the parameter.
Data Type — String should be the default type. When using a supported parameter, select
String for the type.

Default Value — The value entered in this field will be the default for the parameter
whenever the report runs. Users will be able to see this value in P6.

Parameter Type — Text, Menu, and Date are the common types. Unless otherwise
specified, you should use Text as the default for the supported parameters. If you need to
select multiple values, use Menu.

Display Label — The text that displays in P6 for the parameter. If you do not set a display
label, the identifier displays instead.

Allowing for Multiple Values Returned Through a List

If you need a supported parameter to return a comma separated list of values for an IN clause in
the data template, do the following:

1) In BI Publisher, set the parameter type to Menu. This will allow you to link it to a list.

2) Create a hard coded list or a query to get the possible values for the parameter.
See examples of this in Bl Publisher's pre-packaged reports.

3) Select the list of values you just created for the parameter.

4) Check the Multiple Selection option for the parameter.

If a parameter allows for multiple selections, the application will allow selecting multiple values
from the list or allow users to continue to assign values without closing the list. Values will have
commas to separate parameters when the return value appears.
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Reporting in Oracle Primavera Prime

Running Reports

To test Oracle Primavera Prime reports, you must have a Bl Publisher user who matches your
Oracle Primavera Prime username and has the Reports role.

To test the sample reports:

1) Log into Oracle Primavera Prime.
2) Select Jf Home.
3) Onthe Home menu, select Browse.
4) In the Browse dialog box, in the Filter list, select Workspace.
5) Choose a workspace and select Select.
6) On the Workspace menu, select Reports.
7) On the Reports page, select the Advanced Reports tab.
8) Expand the list, select a report, and select Run.
9) Inthe Run Report dialog box:
a. Verify the correct report is listed in the Report Name field.
b. Select a template from the Template list.
c. Select how you would like the report to be delivered from the Delivery Type list.

Notes:

= Note: If you select Email from the Delivery Type list, you must select
## Email Options and supply an email address in the To field. You
can also specify CC and BCC addresses, the Subject line for the
email, and enter text for the body of the email.

= If you selected to have the report delivered by email, select whether
you want to receive notification by email when the report is run or if it
fails in the Select Notifications section.

d. Select a type of output for the report from the Format list.

e. Verify that the report provides the information you expect in the Report Parameters
section.

f. Select Run.
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Supported Parameters

You can use any parameter for Bl Publisher, but users will have to ensure they enter the value
correctly, or the SQL statements in the data template will fail. Using supported parameters will
allow you to provide a user interface to enter the values for parameters.

Parameter: WORKSPACE ID

Identifier: p_workspace_id

Details: Allows users to select workspace nodes
Values: Workspace names separated by comma

Maps to field:

» Table: CO_PROJECT and WS_WORKSPACE

» Field: PROJECT_CODE and PROJECT_NAME
Use case: Display all projects within a workspace node.

Parameter: PORTFOLIO ID

Identifier: p_portfolio_id

Details: Allows users to select portfolio names

Values: Portfolio names separated by comma

Maps to field:

» Table: CP_PORTFOLIO_ID

» Field: CP_PORTFOLIO_ID and PORTFOLIO_NAME
Use case: Display details about selected portfolios.

Parameter: PROJECT STATUS

Identifier: p_project_status
Details: Allows users to select project status
Values: Project status separated by comma
Maps to field:
» Table: FD_LIST_VALUE
» Field: LIST_KEY
where LIST_NAME=ProjectStatus
Use case: Display projects with only the selected project status.
Parameter: PROJECT ID
Identifier: p_project_id
Details: Allows users to select project ID
Values: Project names separated by a comma
Maps to field:
» Table: CO_PROJECT and WS_WORKSPACE
» Field: PROJECT_CODE and PROJECT_NAME
where NODE_TYPE=Project
Use case: Display details about selected projects.
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Parameter: PROJECT CODE ID

Identifier: p_projectcode_id

Details: Allows users to select project code ID
Values: Project codes separated by a comma
Maps to field:

» Table: CO_CODE_TYPE holds the code name and the CO_CODE_VALUE holds the
codes values. CO_CODE_VAL_PROJECT holds an association between a project and
the code values.

» Field: CO_CODE_VALUE.NAME
Use case: Display all projects with the selected project code assignments.

Parameter: CAPITAL PLAN ID

Identifier: p_cppplan_id

Details: Allows users to select capital plans
Values: Capital plan names separated by a comma
Maps to field:

» Table: CP_CAPITAL_PLAN

» Field: CAPITAL_PLAN_NAME

Use case: Display details for selected capital plans.

Parameter: CAPITAL PLAN TYPE

Identifier: p_cppportfolio_id

Details: Allows users to select capital plan types
Values: Capital plan type names separated by a comma
Maps to field:

» Table: CP_PORTFOLIO

» Field: PORTFOLIO_NAME

Use case: Display details for selected capital plan types.

Parameter: MANAGER

Identifier: p_owner_id

Details: Allows users to select project owner

Values: Project owners separated by a comma

Maps to field:

» Table: USERS

» Field: USER_NAME

Use case: Display a list of projects with the selected project owner assigned.

Parameter: PROJECT LOCATION

Identifier: p_location_id
Details: Allows users to select project locations
Values: Project locations separated by a comma
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Maps to field:

» Table: CO_LOCATION

» Field: LOCATION_NAME

Use case: Display a list of projects with the selected project location assigned.

Parameter: START YEAR

Identifier: p_startyear_id

Details: Allows users to specify start year

Values: Year in YYYY format

Maps to field: Does not map to any DB field

Use case: Display a list of projects that start in the specified start year.

Parameter: END YEAR

Identifier: p_end_id

Details: Allows users to specify end year

Values: Year in YYYY format

Maps to field: Does not map to any DB field

Use case: Display a list of projects that end in the specified end year.

Parameter: START MONTH

Identifier: p_startmonth_id

Details: Allows users to specify start month

Values: Date in Mon-YY format

Maps to field: Does not map to any DB field

Use case: Display a list of capital plans that start in the specified start month.
Parameter: END MONTH

Identifier: p_end_id

Details: Allows users to specify end month

Values: Date in Mon-YY format

Maps to field: Does not map to any DB field
Use case: Display a list of capital plans that end in the specified end month.

Parameter: PLANNED BUDGET (operand)

Identifier: p_budgetoperand_id

Details: Allows users to select an operand

Values: Is Greater Than, Is Less Than, Is Equal To, Is Between

Maps to field: Does not map to any DB field

Use case: Select the operand to use with the additional budget parameters.

Parameter: BUDGET AMOUNT

Identifier: p_budgetamount_id
Details: Allows users to enter a budget amount
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Values: Enter numeric value
Maps to field: Does not map to any DB field

Use case: When the Planned Budget (operand) parameter is “Is Equal To”, show all projects
with a Planned Budget equal to the specified Budget Amount.

Parameter: AND

Identifier: p_budgetand_id

Details: Allows users to enter a second Budget Amount
Values: Enter numeric value

Maps to field: Does not map to any DB field

Use case: When the Planned Budget (operand) parameter is “Is Between”, show all projects
with a planned budget between the specified Budget Amount (previous parameter) and
Budget And.

Assigning Permissions to the PrimeReports Folder

If you are using the Bl Publisher security model, you must add permissions to the PrimeReports
folder.

To assign permissions to the PrimeReports folder:

1)
2)
3)
4)
5)
6)
7)
8)
9)

Log in to Bl Publisher as an Administrator.

Click on Catalog Folders.

Under Shared Folders, highlight the PrimeReports folder.

In the Tasks pane, click Permissions.

Click + to add a role.

Click Search to list all available roles.

Highlight the PrimeReports role and click Move.

Click OK to close the Add Roles window.

In the Permissions window, select all permissions for the PrimeReports role.

10) Click OK to save.
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Reporting in P6 EPPM

P6 relies on Bl Publisher and the P6 EPPM Extended Schema to produce reports. To run reports
in P6, you must complete these tasks:

1) For Publication Services, you will need to configure publication settings for General Data,
Time Distributed Data, Blob Data, and Log retention. You can also configure publication
services settings for Project Arbiter, Projects, Enterprise Data, Enterprise Summaries,
Resource Management, and Security.

2) Configure and deploy the Publication Services required to populate the reporting views in the
P6 EPPM Extended Schema. See Working with Publication Services for Reporting (on
page 170) and Publishing P6 Data for Reports (on page 174).

3) Configure Bl Publisher to allow P6 to use parameter keys so users do not have to enter field
values for reports.

4) When you begin working in P6, you can configure your application settings and global
scheduled services.

5) Provide users with the 'Edit EPS Costs/Financials' project privilege if they need to view project
costs in a report generated from the P6 EPPM Extended Schema.

Publication Services

Data in the P6 Extended Schema is calculated and stored by Publication Services, which give
administrators control over when data is calculated and stored in the P6 Extended Schema.
Publication Services exist for project and global data. Global data includes enterprise data, as well
as resource and role, portfolio, and security data. Project data includes all information about
projects, including summaries and calculations.

The Publish Project service is dedicated to publishing project data to the P6 Extended Schema.

Note: The Publish Project service recalculates and publishes all project
business objects containing calculated or denormalized data including,
but not limited to: the WBS, activities, resource/role assignments,
high-level planning assignments, relationships, risks, documents,
expenses, steps, milestones, UDF values, notes, issues, budget change
logs, timesheets, code assignments, funding source assignments.

Four additional Publication Services publish global data to the P6 Extended Schema:

» Publish Enterprise Data

» Publish Enterprise Summaries
» Publish Resource Management
» Publish Security

The first time a data type is published to the P6 Extended Schema all data is recalculated and
published to the extended schema tables. After a data type has been published for the first time,
future publication services recalculate and publish only data that has changed since the last time
that data was published.
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When any of the publication services runs, each business object type processed by the service is
individually timestamped, and the timestamp stored in the database. The services can accurately
determine exactly which data has changed since the last time it was published using these
timestamps because they exist at the individual business object type level.

Configure Publication Services in P6 as follows:

» Set up automatic publication and enable P6 to publish project and global data on the Services
page in Application settings.
Enable the types of global data to be scheduled in Global Scheduled Services.

Disable or enable publication for a selected project on the Services page in Project
Preferences.

» Add, verify the status of, modify, or delete project management services on the Project
Scheduled Services page.

Tip
Run the global data services before turning on the Project Arbiter service.

To learn more about the Arbiter service see this article:
https://blogs.oracle.com/priminout/entry/px_services_project_publication_arbiter

Assigning Permissions to the P6Reports Catalog Folder

To read, run, schedule, and view reports, you must assign the BIConsumer role access to the
objects in the P6Reports catalog.

To assign permissions to the P6Reports catalog:

1) Log into Bl Publisher as an administrator.

2) Select Catalog Folders.

3) Under Shared Folders, highlight the P6Reports folder.
4) In the Tasks pane, click Permissions.

5) Select + to add a role.

6) Select Search to list all available roles.

7) Highlight the BIConsumer role and click Move.

8) Click OK to close the Add Roles window.

9) Inthe Permissions window, select Read, Run Report Online, Schedule Report, and View
Report Output.

10) Click OK to save.
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Running P6 Reports

To run P6 reports, you must:

» Assign Enterprise Reports module access to the P6 user.
» Have a Bl Publisher user who matches your P6 user name and has the P6 Reports role.
» Run publication services first to ensure the report executes successfully.

To run reports:

1) Loginto P6.
2) Click Reports.
3) Onthe Report page:
a. Click View and select Reports.
b. Select a report.
c. Click & Run Report.
4) In the Report Settings dialog box:
a. Inthe File Name field, enter a file name for the report.
b. Inthe Template list, choose a template to apply to the report.
c. Inthe Format list, choose a file format for the delivery of the report.
d. Inthe Delivery Type list, choose to have the report sent through e-mail or display the file
immediately.
= If you chose E-mail, click -] and enter or select e-mail addresses for the intended
report recipients.
= If you chose File, the report will display after you click Run.

e. If you chose E-mail, in the Notification section, choose to send yourself a status
notification of the report run.

f. Inthe Report Parameters section, specify values for the parameters in the Field Name

column. You can enter values directly in the field or double-click in the field and click = 1o
open a selection dialog box.

Note: When selecting Project parameters, if you choose to add an EPS to
the Selected Projects list, only the projects directly under the EPS are
added. If additional EPSs are under the parent EPS, these projects will
not automatically be included in the report; however, you can select
additional EPSs and add them to the Selected Projects list.

Caution: To avoid system performance issues, be as specific as possible
when entering values for reports. Narrow down your choices to include
only what is absolutely necessary.

g. Click Run.
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About Publication Services and Reporting

Before you can generate reports, data must be refreshed and calculations must be made in
precisely arranged tables and fields. Publication Services address these reporting needs
gathering and calculating data as close as possible to real-time. To make this happen, you can
configure P6 to automatically publish data to reporting tables. Depending on the type of data
published, P6 tables may still generate reports, or a combination of P6 and reporting tables may
generate them. An administrator must configure settings for Publication Services before
publishing reporting data.

Your organization's P6 EPPM data has two categories: project data and global data. Published
project data includes all information about your projects, including summaries and calculations.
Published global data includes enterprise data, resource and role data, portfolio data, and security
data.

To summarize the reporting process:

1) Users create new data or make changes to existing data in P6.
2) P6 global and project data publishes, automatically or manually, to tables for reporting.

3) Reports generate directly from the collective P6 EPPM database with the P6 Extended
Schema reporting tables.

Note:

The Bl Publisher sample reports were designed to be run against the
small data set included in the sample database. These reports are
provided as an example of the product’s capability only. Oracle provides
no guarantee, implied or explicit, that the Bl Publisher sample reports will
run against your database or will produce meaningful data when they are
run against your database. You may modify the Bl Publisher sample
reports to suit your own data set, including adding filter criteria to limit data
output or changing filter criteria to suit your data. You need a full Bl license
to modify sample reports.
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Working with Publication Services for Reporting

To achieve near real-time reporting, you can configure P6 to automatically publish to tables that
store updated data, including calculations and summary data. These tables also create views for
generating reports. The P6 data is split into two general categories: project data and global data.
Project data includes all information about your projects, including summaries and calculations.
Global data includes enterprise data, as well as resource and role, portfolio, and security data. The
image below summarizes the key concepts in the publication and reporting process.

@PPM

Global Data

° Project Data
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Table of Key Publication Services Concepts

Iltem Description

o EPPM Database: The EPPM database captures all the data your organization
generates every second of every day. However, the raw data in the EPPM
database is not structured for immediate reporting.

2] Project Data: You can configure P6 to automatically publish a project based on
publication thresholds. Based on the options you select, you can prioritize
projects for publication in a queue. If necessary, you can manually add a project
to the queue.

o Global Data: You can configure services in P6 to schedule the publication of
global data based on recurring intervals that you specify. If necessary, you can
also immediately publish this data manually.

0 Project Queue: Projects publish in sequential order based on priority. Your
administrator can control which projects are added to the publishing queue,
when, and in what order. These options ensure the project data you need most is
available for P6 reporting in near real-time.

o P6 Extended Schema Tables: The project and global services recalculate
certain logical fields in the P6 EPPM database and store them as physical fields
in the P6 Extended Schema tables so they are available for reporting and other
purposes. Some fields in P6, such as durations, are calculated in real time as
related field data is changed and are not stored in the database. Publication
services recalculate these fields and store their values in the extended schema
tables. Other fields, such as note fields, are not stored in the database in a format
suitable for reporting. For these fields, publication services will convert them to a
format more suitable for reporting.

Note: For information about which tables are updated by the Publication
Services for Reporting, see the following knowledge management document:
What PX tables are updated when running Global Scheduled Services or Publish
Project [ID 1491245.1]

https://support.oracle.com/epmos/faces/ui/lkm/DocumentDisplay.jspx?id=14912
45.1

o P6 Reports: You can run reports directly against P6 Extended Schema table
views.
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P6 administrators control project and global publication processes, which are summarized below.
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Table of Key Publication Services Elements

Iltem Description

o Application Settings for Publication Services: Located under the Administer
menu, begin by clicking Application Settings, and then choose Services. On
the Services page, specify the start date, period of time to add to the current
publication date to determine a finish date, and time-distributed interval for
publication. In the Project Publication section, you can enable the Publish
Projects services to refresh project data according to a time interval you set. You
can further determine a change threshold, time threshold, and even decide if idle
projects should be added to the queue, and if so, set a maximum limit to the
concurrent number of idle projects being published.

2] Project Preferences for Publication Services: Then, navigate to the EPS
page in the Projects section. Click a project and select Set Project Preferences
from the Actions menu. On the Services page, select the Enable Publication
option to indicate you want to include this project in the Publish Projects services.
All new projects are enabled for publication by default. Clear the option if you do
not want to publish the project's data. On this page, you can also set the project's
priority relative to other projects entering the publication queue.

© Global Scheduled Publication Services: Return to the Administer menu and
navigate to the Global Scheduled Services dialog box to enable the types of
global data services you want to schedule. Below each service you enable,
specify the recurring interval and start time in the detail window.
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Defining Publication Periods

Before publishing global or project data for reporting, define the publication period. The publication
period you define should be large enough to capture all the project data you need to include in
reports.

Caution: You can perform these steps again at any time to modify your
settings. However, if an Admin Superuser modifies the Start date, Time
distributed interval, or Finish date is current date plus fields, all data
will be fully recalculated. Oracle recommends that you only reconfigure
publication options on weekends or during off-peak hours to prevent the
disruption of other P6 features.

To define the publication period:

1) Click the Administer + menu and select Application Settings.
2) On the Application Settings pane, click Services.
3) Onthe Services page, in the Publication Periods section:

a. Inthe Start date field, click [Z1 to select the exact month, day, year, and time to mark the
initial start of the data publication period. Select any date in the past that represents a
reasonable amount of historical spread data for your organization. For example, in order for
users to be able to produce time-distributed reports for any date range, enter the earliest
project start date at your organization.

b. Inthe Finish date is current date plus field, select a numeric quantity and unit of time to
construct a dynamic period of time. Whenever a publication service runs, this period of time
is added to the current date to determine the finish date for the publication of data. For
example, if the value is 5 years, time-distributed data will always be published covering the
period of time that begins with the value in the Start Date field and extends five years into
the future each time a service runs.

c. Inthe Time distributed interval field, select the unit of time in which time distributed data
will be recalculated and published. Set this to Week if performance is of primary importance
and you do not need to see daily data.

d. Click Save.
Publishing P6 Data for Reports

Reports based on P6 data require timely access to the most current data in order to be accurate.
For example, report recipients expect to see updated enterprise data and project data including
any calculations. In order to provide this data, P6 generates and stores data in reporting tables
(the P6 Extended Schema). You can configure P6 to automatically publish essential data to the
tables or manually generate it so that the most current data is available for reporting.

The data is split into two general categories: project data and global data. Project data includes all
information about your projects, including baselines, summaries and calculations, and global data
includes enterprise data, resource and role data, and security data.
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Enabling Automatic Publishing of P6 Project Data for Reports

Perform the following procedure to enable projects for publication, and to set options for automatic
project publication. Then, as you work, P6 automatically detects the changes to your projects that
trigger the publication of their data.

To enable Publication Services for project data:

1) Click the Administer = menu and select Application Settings.
2) On the Application Settings pane, select Services.
3) Onthe Services page, in the Project Publication section:

a.

b.

=

Select Enable Publish Projects to enable automatic project publication based on defined
thresholds. Selecting this option also allows users to manually publish projects.

In the Publish projects every field, select an interval by which projects are polled to be
published.

Enter a number in the Number of changes exceeds field. This threshold setting
determines the number of edits users can make to the project data before P6 publishes its
data. Assuming a constant rate of change among projects, a lower value will result in more
frequent publication of project data. If you enter a value of 0, projects with tracked changes
will be automatically published.

Enter a time period for the Time since last publication exceeds field. This threshold
setting determines how often the publication of project data should occur. For example, if
you enter 12 hours, the project data will be published every 12 hours unless the threshold
for the number of changes has already been reached.

Select Publish idle projects to add projects to the service queue that are enabled for
publication but have not been changed during the time threshold. This setting is only valid
for the initial run of the service.

In the Maximum number to publish field, enter the maximum number of pending

idle Publish Project services that can be present at once in the service queue. This
prevents performance problems during peak demand when enabling the publication of a
large number of projects. For example, if the service runs and queues 40 projects that have
exceeded specified thresholds and must be published, or that have been manually
published, and you have set the maximum to 100, P6 will schedule up to 60 idle projects for
publication.

Select Enable Baseline Publication if you want to be able to publish baseline data.
Click Save.
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Tips

»

If your organization is upgrading to P6, select Publish idle projects to add your migrated
projects to the service queue after your database is upgraded. This will publish all your
projects in the queue and refresh the available data for reporting. After an upgrade, this setting
is no longer applicable, and projects will be submitted to the service queue based on threshold
values specified on the Application Settings page.

Clear the Publish idle projects option if your organization does not report against completed
projects.

The Maximum number to publish field is only applicable immediately following an upgrade,
when all projects are considered idle. When all projects have been published, the service
queue will no longer be constrained based on this setting.

A project will be automatically submitted to the service queue if you change the project
baseline, calendar, or data date. Projects are also automatically submitted to the queue if you
select or clear Calculate Activity % Complete from activity steps option, or modify the
default price/unit value for assignments without activities, from the Set Project

Preferences dialog box available from the Actions menu on the EPS page.

For threshold settings, projects are added to the service queue based on tracked changes to
data. Only changes to activities, resource/role assignments, relationships, and the WBS are
tracked.

Configuring Publication Service Settings for Projects

After enabling automatic publishing, perform the following procedure to configure settings for each
individual project in Publication Services. Then, as you work, P6 automatically detects the
changes to your project that trigger the publication of its data in the service queue.

To configure Publication Service settings for a project:
1) Click Projects.

2) On the Projects navigation bar, click EPS.

3) Onthe EPS page:

a. Select a project.
b. Click the Actions + menu and select L@ Set Project Preferences....

4) On the Project Preferences pane, select Services.
5) On the Services page, in the Publication section:

a. Select the Enable Publication option.

Note: By default, all projects are enabled for publication. The Enable
Publication setting only needs to be modified if you wish to disable
publication for a project or re-enable publication of a previously disabled
project.

b. Adjust the relative Publication Priority up or down between 1 and 100 with 50 being the
default priority value, 1 being the highest priority, and 100 being the lowest.

c. Click Save and Close.
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Tips
» If you wish to modify publication settings for many projects at one time, you can display

the Enable Publication, Last Published On, and Publication Priority fields as columns in
your EPS view.

» If you want to publish Baseline data, the project must be published.
Enabling Automatic Publishing of P6 Global Data for Reports

Perform the steps below to configure P6 to automatically publish any of the following types of
global data to reporting tables.

» Enterprise Data

» Enterprise Summary Data including portfolio data

» Resource Management Data

» Security Data

To automatically publish P6 global data:

1) Click the Administer = menu and select Global Scheduled Services.
2) Inthe Global Scheduled Services dialog box:

a. Select a service, then configure its settings in the Service Settings detail window. For
example, you might specify that the service runs daily on Wednesdays with a start time of
10:15 PM.

Note: Oracle recommends running the Publish Security service first if
the Run After Previous option is selected in the Run Service list for
other publication services. Running the Publish Security service first will
ensure that security data updates in the extended schema as soon as
possible and ensures that the security restrictions are in place before you
run the report.

b. Select the Enabled option for any of the four global services listed.

If you choose to run one or more services with the relative frequency value of After previous
service, click i Move Up (Ctrl+Alt+Up) or “» Move Down (Ctrl+Alt+Down) to arrange
the services in your preferred sequence.

d. Click B save.
e. Click Close.
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Manually Publishing P6 Project Data for Reports

Perform the steps below to publish the data from one or more projects to the reporting tables so it
is ready for reporting. Any of the projects' baselines which is enabled for publishing will also be
published when you perform these steps. P6 will automatically publish project data; however, you
may want to publish the data manually in special cases such as when generating an important
report at a specific time.

To manually publish P6 project data:

1)
2)
3)

4)

Click Projects.

On the Projects navigation bar, click EPS.

On the EPS page, select one or more projects, or select an EPS node to publish all of its
subordinate projects.

On the Actions menu, click i’? Publish Projects.

Tips

»

In order to manually publish project data from the EPS page, Publication Services must be
enabled and configured.

You can publish all open projects by clicking E? Publish Projects on the Run submenu on
the Actions menu of the Activities page. You can also publish projects by selecting one or
more projects on the EPS page, and then using the right-click menu.

Projects are not immediately published. Instead, they will be added to the queue of projects
being processed for publication the next time the Publish Projects service runs. View settings
for the Publish Projects service, including how often the service runs, on the Services page,
which is located on the Application Settings pane. Depending on your security privileges,
the Application Settings pane may not be accessible. You can check the status of the
Publish Projects service after it has been added to the service queue by selecting View
Service Status from the Actions menu on the Activities page.

If some of the selected projects are not enabled for publication, only those projects enabled for
publication will be submitted to the service queue. If none of the selected projects are enabled

for publication, you will not be able to click Ei' Publish Projects.

A project will be automatically submitted to the service queue if you change the project
baseline, calendar, or data date. Projects are also automatically submitted to the queue if you
select or clear the Calculate Activity % Complete from activity steps option, or modify the
default price/unit value for assignments without activities from the Set Project

Preferences dialog box available from the Actions menu the EPS page.
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Manually Publishing P6 Global Data for Reports

Perform the steps below to manually publish any of the following types of global data to the
reporting tables.

» Enterprise Data

» Enterprise Summary Data including portfolio data
» Resource Management Data

» Security Data

P6 will automatically publish global data; however, you may want to publish the data manually in
special cases such as when generating an important report at a specific time.

To manually publish P6 global data:

1) Click the Administer = menu and select Global Scheduled Services.
2) Inthe Global Scheduled Services dialog box:

a. Select any of the four global services listed.

b. Click @ Run Service on the Global Scheduled Services toolbar.
In the resulting message box, click OK.
Click & save.
Click Close.

® oo

Tips
» If the service listed under the manually selected service is configured to run After previous
service, it will run automatically when the selected service finishes.

» You must have the global security privilege, 'Administer Global Scheduled Services,' to run a
service from the Global Scheduled Services dialog box.
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Supported Parameters in P6

You can use any parameter for Bl Publisher, but users will have to ensure they enter the value
correctly, or the SQL statements in the data template will fail. Using supported parameters will
allow you to provide a user interface to enter the values for parameters. Supported parameters for
P6 fall into one of three categories:

» Enumeration parameters allow users to pick parameters from static lists.

» Dynamic parameters will generate the list at run time. For example, when focusing on Project
ID, users will see a Project list that pulls the current projects from the P6 EPPM database.

» Primitive parameters support basic selections. For example, if a parameter is a boolean, an
option will appear for users to select or clear a text box instead of typing true or false.

The following are the supported parameters for P6, grouped by category:

Enumeration Parameters
Activity Priority
Assignment Proficiency
Activity Status

Activity Type
Constraint Type
Duration Type

Percent Complete Type
Project Status

Rate Source

Rate Type

Resource Type

Risk Status

Risk Type

VvV VvV vV vV vV vV vV vV VvV vV v v v

Dynamic Parameters

Activity Code Value

User Defined Activity Code (type and value)
Cost Account

EPS

Expense Category

Funding Source

Portfolio

Project

Project Code Value

User Defined Project Code (type and value)
User Defined Resource Code

Resource Code Value

Resource Team

Resource 1D

Vv VvV VvV vV VvV VvV vV VvV VvV vV VvV v v Vv
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Responsible Manager
Risk Category

Role

Role Team
Timesheet Period
User

Primitive Parameters
» Date
» Boolean
» Integer
» Float

Custom Parameters
» List of Values

Enumeration Parameters

Enumeration parameters map to fields that have a set list of possible values. When running a
report with a enumeration parameter, P6 will offer a list to select one of the values. Users will see
the localized text for the enumeration value's description; however, the return value will be the
English description of the enumeration, which is the value the PX Views database stores.

Descriptions of enumeration parameters are in the following format:

Parameter: Name of the parameter.

4

Identifier: The value you must enter in the identifier field in Bl Publisher when creating the
parameter for the report.

Details: A description and technical details of the parameter.
Values: The values that will be available in P6.

Maps to field: The database field the return value maps to in the PX Views database. It
could match multiple fields in the database, so only the primary table is listed.

Use case: An example of how you might use the parameter in a report.
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Supported Enumeration Parameters

Parameter: Activity Priority

Identifier: p_activity_priority

Details: Allows users to select the leveling priority of an activity.
Values: Top, High, Normal, Low, Lowest

Maps to field: ACTIVITY.LEVELINGPRIORITY

Use case: Filter activity data by leveling priority.

Parameter: Assignment Proficiency

Identifier: p_assignment_proficiency

Details: Allows users to select a value for assignment proficiency.

Values: Master, Expert, Skilled, Proficient, Inexperienced

Maps to field: RESOURCEASSIGNMENT.PROFICIENCY

Use case: Filter resource assignment data by the proficiency of the assignment.

Parameter: Activity Status

Identifier: p_activity _status

Details: Allows users to select activity status.

Values: Not Started, In Progress, Completed

Maps to field: ACTIVITY.STATUS

Use case: Filter activity reports based on a certain status.

Parameter: Activity Type

Identifier: p_activity type
Details: Allows users to select the activity type.

Values: Task Dependent, Resource Dependent, Level of Effort, Start Milestone, Finish
Milestone, WBS Summary

Maps to field: ACTIVITY.TYPE
Use case: Filter activity reports based on the type of the activity.

Parameter: Constraint Type

4

Identifier: p_contstraint_type
Details: Allows users to select an activity constraint type.

Values: Start On, Start On or Before, Start On or After, Finish On, Finish On or Before,
Finish On or After, As Late As Possible, Mandatory Start, Mandatory Finish

Maps to field: ACTIVITY.PRIMARYCONSTRAINTTYPE and
ACTIVITY.SECONDARYCONSTRAINTTYPE

Use case: Filter activities in a report by the activity primary or secondary constraint type.

Parameter: Duration Type

4
4
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Identifier: p_duration_type
Details: Allows users to select the duration types of an activity.
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» Values: Fixed Units/Time, Fixed Duration & Units/Time, Fixed Units, Fixed Duration &
Units

» Maps to field: ACTIVITY.DURATIONTYPE
» Use case: Filter activities in a report based on their duration type.

Parameter: Percent Complete Type

» ldentifier: p_percent_complete_type

» Details: Allows users to select the percent complete type of an activity.

» Values: Physical, Duration, Units

» Maps to field: ACTIVITY.PERCENTCOMPLETETYPE

» Use case: Filter activities in a report based on the percent complete type of the activity.

Parameter: Project Status

» ldentifier: p_project_status
» Details: Allows users to select the status of a project.
» Values: Planned, Active, Inactive, What If, Requested, Template
» Maps to field: PROJECT.STATUS
» Use case: Filter the projects in a report based on the desired type. For example, you might
want to use this for a report that needs to display information only on planned projects.
Parameter: Rate Source

» ldentifier: p_rate_source
» Details: Allows users to select the rate source of an assignment.
» Values: Resource, Role, Override
» Maps to field: RESOURCEASSIGNMENT.RATESOURCE
» Use case: Filter resource assignments included in a report based on the rate source of the
assignment.
Parameter: Rate Type

» ldentifier: p_rate_type
» Details: Allows users to select the rate type of an assignment.
» Values: Price/Unit, Price/Unit 2, Price/Unit 3, Price/Unit 4, Price/Unit 5
» Maps to field: RESOURCEASSIGNMENT.RATETYPE
» Use case: Filter resource assignments included in a report based on the rate type of the
assignment.
Parameter: Resource Type

» ldentifier: p_resource_type

» Details: Allows users to select the resource type of an assignment.
» Values: Labor, Nonlabor, Material

» Maps to field: RESOURCEASSIGNMENT.RESOURCETYPE

» Use case: Filter resource assignments included in a report based on the resource type of
the assignment.
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Parameter: Risk Status

4

4

4

Identifier: p_risk_status
Details: Allows users to select the status of a risk.

Values: Proposed, Open, Active, Rejected (Closed), Managed (Closed), Impacted
(Closed)

Maps to field: RISK.RISKSTATUS
Use case: Filter risks in a report based on the status of the risk.

Parameter: Risk Type

Identifier: p_risk_type

Details: Allows users to select the type of a risk.

Values: Threat, Opportunity

Maps to field: RISK.RISKTYPE

Use case: Filter risks in a report based on the type of risk.

Dynamic Parameters

Dynamic parameters map to fields that have a varying list of possible values. When running a
report with a dynamic parameter, P6 will offer a list to select one of the available values.

Descriptions of dynamic parameters are in the following format:

Parameter: Name of the parameter.

4
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Identifier: The value you must enter in the identifier field in Bl Publisher when creating the
parameter for the report. In some cases, identifiers can pass in context by appending short
names to the end of the identifier. The character in quotations is the separator that the
code splits and <name> represents the context you are trying to pass in.

Details: A description and technical details of the parameter.
P6: What the editor for the parameter will be in the Reports section of P6.
Return Value: The values that will be available in P6.

Maps to field: The database field the return value maps to in the PX Views database. It
could match multiple fields in the database, so only the primary table is listed.

Use case: An example of how you might use the parameter in a report.
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Supported Dynamic Parameters

Parameter: Activity Code Value

4

4

Identifier: p_a_code_val__<short name>

Details: Enables users to select an activity code value via a list. Context passes into the
parameter by appending a colon™:" followed by the short name of the activity code type you
want to set.

P6: Provides a list that displays the Activity Code Values for the Activity Code type passed
in the context.

Return value: Short name of the Activity Code (unique per code type).
Maps to field: ACTIVITYCODE.CODEVALUE

Use case: Create a report that displays some basic information about activities. Users at
five locations need to run the report, but they only want to see the data for activities with
codes matching their location. Instead of creating five reports hard coding the location (for
example, location=L1) on each report, you can create one report and add this parameter to
it (for example, p_a_code_val__Location).

In the data template for the report, filter the activities based on this parameter. Hard code
the left side of the activity filter to match the activity code you selected, which in this case is
location.

Example query: CODETYPENAME="Location' &
CODEVALUE=:p_a_code_val__Location

If you did not have a parameter for this, you would need different templates for each
location.

Parameter: User Defined Activity Code

4

4

nn

Identifier: p_activity code_value "." <number> p_activity _code_type "." <number>

Details: Enables users to select a user defined Activity Code. The user defined Activity
Code is two parameters on the report in Bl Publisher, but will display only as one row in the
report settings parameter table.

P6: Provides a list that displays all global Activity Code types. When users expand a type,
the list shows the values for that type. By selecting a value, both the type and value will
return to the report.

Return value: Short name for the Activity Code Value, primary key for the Activity Code
type.
Maps to field:

* p_activity_code_value maps to ACTIVITYCODE.CODEVALUE

* p_activity_code_type maps to ACTIVITYCODE.CODETYPEOBJECTID

185



Primavera Cloud Service Administrator's Guide

4

Use case: Create a report that can have a variable Activity Code. The report pulls activities
and displays some basic statistics of the activities. The data template for the report must
accommodate setting both sides of the query. While a typical parameter just sets the IN
clause for a user defined field, this parameter must set both sides. The "Activity Code
Value" parameter Use case example shows where it hard codes the CODETYPENAME to
be Location. This parameter enables multiple user defined activity codes to be used on
the same report. For each parameter you use, you must add p_activity_code_value.1 and
p_activity_code_type.l. There must be a pair of numbers to ensure that the editor works

properly.

Parameter: Cost Account

4

4

Identifier: p_cost_account

Details: Enables users to select Cost Accounts. The P6 user must have access to view
Cost Accounts for the list to populate.

P6: Provides a list that displays all Cost Accounts in a hierarchical tree.
Return value: Short name of the cost account (unique).
Maps to field: COSTACCOUNT_FULL.NAME

Use case: Filter items using certain Cost Accounts or generate information on the Cost
Accounts.

Parameter: EPS

4

Identifier: p_eps_id
Details: Enables a user to select an EPS.
P6: Provides a list that displays all of the EPS nodes where the user has access.
Return value: The short name of the EPS.
Maps to field:
= EPS_FULL.NAME
= EPS_U.NAME

Use case: Use a parameter for EPS to filter a query to load all projects under an EPS for a
report.

Parameter: Expense Category
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Identifier: p_expense_category
Details: Enables a user to select Expense Category where the user has access.
P6: Will provide a list that displays all of the Expense Categories.
Return value: The short name of the Expense Category (unigue).
Maps to field:
= EXPENSECATEGORY_FULL.NAME
= EXPENSECATEGORY_U.NAME

Use case: Run a report filtered by assignments that use a certain Expense Category
associated with them.
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Parameter: Funding Source

Identifier: p_funding_source
Details: Enables a user to select a Funding Source.
P6: Provides a hierarchical list filled with Funding Sources where a user has access.
Return value: The short name of the Funding Source (unique).
Maps to field:
= FUNDINGSOURCE_FULL.NAME
* FUNDINGSOURCE_U.NAME

Use case: Filter the report data to include only projects that have the selected Funding
Source assigned.

Parameter: Portfolio ID

Identifier: p_portfolio_id

Details: Enables a user to select a Portfolio where the user has access.
P6: Provides a list of Portfolios where the user has access.

Return value: The portfolio short name (unique).

Maps to field: PROJECTPORTFOLIO_FULL.NAME

Use case: Filter the report data to include only the projects in a Portfolio.

Note: If there is a user portfolio that shares the same name as one of the
global portfolios, then the report will return data for both when you run it.
You'll need to use the Portfolio Name and User ID to make a unique
constraint.

Parameter: Project ID

4

4

4

4

4

4

Identifier: p_project_id
Details: Enables a user to select one or more projects where the user has access.

P6: Click the Projects = menu, and select Open Project to display the Project list.
Enables switching between Template and Regular projects.

Return value: The project short name (unigue).
Maps to field: PROJECT_FULL.ID
Use case: Run a report where the data comes from selected projects.

Parameter: Project Code Value

4

4

Identifier: p_p_code_val__<short name>

Details: Select a Project Code value. Note that underscores (_) are the only special
character allowed. Do not use other special characters.

P6: Provides a list containing the project code values for the Project Code whose short
name matches the second part of the parameter. For example: If the short name was
Scope, and there were four values — Local, Regional, Country, and Global — the list would
display Local, Regional, Country, and Global in the list.

Return value: Activity code value short name (unique per code type).

Maps to field: PROJECTCODE_FULL.CODEVALUE
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Use case: Filter the set of projects loaded to those projects that have the user-selected
Project Code Value assigned to them.

Parameter: User Defined Project Code

4

4

Identifier: p_project_code_value"."<number> p_project_code_type"."<number>

Details: Similar to the User Defined Activity Code, this parameter consists of two
parameters in Bl Publisher: One parameter returns the selected Project Code Value, and
the other parameter returns the Project Code type ID. For each parameter you use, you
must add both p_project_code_value.# and p_project_code_type.#. There must be a
pair of numbers for the editor to work properly. You can have multiple sets to allow for more
than one User Defined Code Value.

P6: Provides a list populated with all the global Project Codes as the first level. Expanding
a Project Code type will list all the values for the type. In the parameter table, only one row
will represent both parameters. After you select a Project Code Value, both parameters will
be set.

Return value: The short name for p_project_code_value and the object id for
p_project_code_type.
Maps to field:

* p_project_code value maps to PROJECTCODE_FULL.CODEVALUE

* p_project_code_type maps to PROJECTCODE_FULL.CODETYPEOBJECTID

Use case: Create a report that enables the projects to filter based on a Project Code that
the user defines. Unlike the Project Code Value parameter, the report creator should not
hard code the Project Code type. Instead, they should write the query to enable the
p_project_code_type.1 parameter to determine the Project Code type. This lets a report be
more flexible in the filter criteria.

Parameter: User Defined Resource Code
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Identifier: p_resource_code_value "." <number> p_resource_code_type "." <number>
Details: Similar to the other user-defined codes this parameter consists of two parameters
on the report in Bl Publisher: One parameter returns the selected Resource Code Value,
and the other parameter returns the Resource Code type ID. For each parameter you use,
you must add both p_resource_code_value.# and p_resource_code_type .# There
must be a pair of numbers in order for the editor to work properly. You can have multiple
sets to allow for more than one user-defined code value.
P6: Provides a list populated with the Resource Codes as the first level. Expanding a
Resource Code type will list all the values for the type. In the parameter table, only one row
will represent both parameters. After you select a Resource Code Value, both parameters
will be set.
Return value:

= p_resource_code_value: short name for the code value

= p_resource_code_type: object id for the code type
Maps to field:

= p_resource_code_value maps to RESOURCECODE_FULL.CODEVALUE

* p_resource_code_type maps to
RESOURCE_CODE_FULL.CODETYPEOBJECTID
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Use case: Create a report that allows for the resources to be filtered based on a Resource
Code Value and type that the user defines. Unlike the Resource Code Value parameter,
the report creator should not hard code the resource code type. Instead, they should write
the query to enable the p_resource_code_type.1 parameter to determine the resource
code type. This allows a report to be more flexible in the filter criteria.

Parameter: Resource Code Value

4

4

4

Identifier: p_r_code_val__<short name>

Details: Select a Resource Code value to use for filtering loaded resources for a report.
P6: Provides a list populated with the resource code values for the resource code type
indicated by the <short name> at the end of the parameter. For example: If the short name
was Department, the list would display Engineering, Marketing, Research, and
Development as the values in the list.

Return value: The short name of the Resource Code Value (unique per code type).
Maps to field: RESOURCECODE_FULL.CODEVALUE

Use case: Create a report where the resources filter based on the resources that match
the user-selected Resource Code Value for a particular Resource Code type. The report
data query must hard code the Resource Code type for matching resources to the returned
code value.

Parameter: Resource Team

Identifier: p_resource_team

Details: Enables resource team selection.

P6: Provides a list populated with resource teams that the user has access to view.
Return value: The short name of the resource team (unique).

Maps to field: RESOURCETEAM_FULL.NAME

Use case: Filter a report to load resources that are on the selected resource team.

Parameter: Resource ID

Identifier: p_resource_id

Details: Select a resource to filter a report.

P6: Provides a list populated with resources that the user has access to view.
Return value: The short name of the resource (unique).

Maps to field: RESOURCES_FULL.NAME

Use case: Filter the activities in a report based on the user-selected resource assigned to
the activity.

Parameter: Responsible Manager

Identifier: p_responsible_manager

Details: Select a responsible manager (OBS).

P6 GUI: Provides a list populated with the OBS structure that the user has access to view.
Return value: The short name of the OBS (unique).

Maps to field: PROJECT_FULL.OBSNAME and OBS_FULL.NAME
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Use case: Filter a report to load only the projects that have the user-selected responsible
manager.

Parameter: Risk Category

Identifier: p_risk_category

Details: Select a Risk Category.

P6: Provides a list populated with all the Risk Categories that the user has access to view.
Return value: The name of the Risk Category (unique).

Maps to field: RISK_FULL.RISKTYPE

Use case: Filter a report to load only the Risks of the user-selected category.

Parameter: Role Team

Identifier: p_role_team

Details: Select a Role Team.

P6: Provides a list populated with all the Role Teams the user has access to view.
Return value: The name of the Role Team (unique).

Maps to field: ROLLTEAM_FULL.NAME

Use case: Filter a report of Resources to include only the Resources that are assigned to
the user-selected Role Team.

Parameter: Role

Identifier: p_p6_role_id

Details: Select a Role.

P6: Provides a list populated with all the Roles the user has access to view.
Return value: The short name of the Role (unique).

Maps to field: ROLL_FULL.ID

Use case: Filter a report of Resources to include only the Resources that have the
user-selected Role.

Parameter: Timesheet Period
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Identifier: p_timesheet_period_start and p_timesheet_period_end

Details: This parameter consists of two parameters on the report in Bl Publisher, but is
represented by a single row in parameter list for P6. The user will select a timesheet
period, and it will set the Start Date to p_timesheet_period_start and the End Date to
p_timesheet_period_end.

P6: Drop down menu of the Timesheet Periods in the database. Selecting a Timesheet
Period will return the Start Date and End Date in the parameters.

Return value: The Start Date and End Date of the Timesheet Period selected by the user.
Maps to field: N/A

Use case: Filter a report to look for a date between two dates of a Timesheet Period.
Instead of adding two date parameters and making the user manually enter the Start and
End of the period, the user can use a drop down with the Timesheet Periods in the
database.



Bl Publisher Setup Tasks

Parameter: User
» ldentifier: p_p6_user_id
» Details: Select a P6 EPPM user name.
» P6: Provides a list populated with the P6 users that the logged-in user has access to view.
» Return value: The user name (unique).
» Maps to field: USERS_FULL.NAME

Primitive Parameters

In Bl Publisher, when you create a parameter, a field Data Type allows the following options:
String, Integer, Boolean, Float. The default type is String, and you should use it for all the
supported enumeration and dynamic parameters. For primitive parameters, select the appropriate
option for the parameter that you are configuring.

Type: Date
» Editor: P6 will use the date picker to select the date.
» Return: The date string in the format entered in Bl Publisher.

Type: Boolean
» Editor: Will use a check box editor.
» Return: Either true (selected) or false (cleared).

Type: Integer
» Editor: Will use a default text box without validation.
» Return: The text entered in the box.

Type: Float
» Editor: Will use a default text box without validation.
» Return: The text entered in the box.

Allowing for Multiple Values Returned via a List

If you need a supported parameter to return a comma separated list of values for an IN clause in
the data template, do the following:
1) In BI Publisher, set the parameter type to Menu. This will allow you to link it to a list.
2) Create a hard coded list or a query to get the possible values for the parameter.
See examples of this in Bl Publisher's pre-packaged reports.
3) Select the list of values you just created for the parameter.
4) Check the Multiple Selection option for the parameter.
If a parameter allows for multiple selection, P6 will allow selecting multiple values from the list or

allow users to continue to assign values without closing the list. Values will have commas to
separate parameters when the return value appears.
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Reporting in Primavera Unifier

The Oracle Business Intelligence Publisher (Bl Publisher) integrates with Unifier Cloud Service to
deliver on-demand web-based reporting.

The following sections describe how to configure Oracle Business Intelligence Publisher (BI
Publisher) for Primavera Unifier Cloud Service.

Creating a Bl Publisher Report in Unifier

To create a new Bl Publisher report:

1) Sign in to your Unifier environment.
2) Click the Company Workspace tab.
3) Inthe left pane:
a. Switch to Administration Mode.
b. Expand Configuration.
c. Select Custom Prints and Reports.
4) In the right pane:
a. Select the New (drop-down arrow).
b. Choose Report with Internal Data Model or Report with External Data Model.

If you choose Report with External Data Model, you will continue using the steps in the
section.

Notes:

= Internal data model: Unifier maintains the data model file internally.
Any changes in the data views, data links, query parameters, and
additional parameters are being applied and saved in the data model
when the BIP report is saved.

= External data model: Users need to upload the data model (.xdm) file
and maintain it externally. This means that the user may modify the
.XDM file manually or by using the BIP data model editor.

5) Inthe General tab of the Custom Report dialog box:
a. Inthe Name field, enter a name for the report.

b. Inthe Description field, enter a brief description about the report (maximum 250
characters and non-ASCII characters are permitted).

c. The Data Model Type field is a pre-populated and read-only field with values that can be
internal or external based on the option selected at the time of creating the custom print.

d. Inthe Report Level field, select a type for the report.
e. Inthe Main View field, select a type of view for the report.

Note: The administrator can create these user-defined views. Refer to
the Unifier Administrator's Guide for more information on creating data
views.
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6) Inthe Views tab, click Add or Remove to edit the views for the report.

7) Click Apply.

8) When the Sample Data tab opens, you can download the sample XML data for creating or
modifying report layouts:

© oo oD .

v

If you are using the Internal Data Model:
Select a project/shell.

Select a number of rows to return.

Click Generate.

Click Download.

Save the XML file.

If you are using the External Data Model:

Note: You cannot download sample data until after you define and publish
the report.

a. Select a project/shell.
b.

c. Click Download.

d.

Click Generate.

Save the XML file.

If you haven't already installed the Bl Publisher plug-in for Microsoft Word, install it now. You can
find it here: http://www.oracle.com/technetwork/middleware/bi-publisher/downloads/index.html.
Use one of the following:

Note: Refer to the Tested Configurations document for the list of
applications and supported version levels.

» Oracle Bl Publisher Desktop for 32 bit Office on Windows (245 MB)
» Oracle Bl Publisher Desktop for 64 bit Office on Windows (245 MB)

Refer to the documentation included with Bl Publisher for more information on using this plug-in.

1) Create a report layout in Microsoft Word to have templates available in Microsoft Word when
you publish reports:

a.
b.
c.

Open Microsoft Word.

Create an RTF file.

In the BI Publisher tab:

1. Select Sample XML in the Load Data section.

2. Upload the XML file you created above.

3. Create a table for the layout using the Table Wizard included with the Bl Publisher
plug-in.

4. Save and close the RTF file.

2) Return to the Custom Report dialog box.
3) Inthe Template File tab (consisting of Add, Modify, Remove, and Download options)
a. Click Add to open the template window.
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4)
5)

6)
7

b. Enter information in the following fields: Template Name, Template Type, and Report
Layout File.

» To localize the Custom Report output for different languages, you can provide
XLIFF files for RTF-type templates here.

» The Template Name field accepts spaces and other characters.
c. Click Browse to select the template file for uploading.
d. Click OK to confirm the upload.
Return to the Company Workspace tab.
In the left pane:
a. Expand Configuration.
b. Select Custom Reports.
In the right pane, select the report you want to publish.
Click the Status dropdown on the toolbar and select Published.

Making New Reports Appear in Unifier

To make newly defined reports appear:

1)
2)

3)
4)

5)
6)

Go to the Company Workspace tab and switch to the Administrator mode.
Navigate to Configuration (User Mode Navigator).

Note: If the company does not use User Mode Navigator, you will be able
to the report name under Access Control of Project or Program.

Open the project/shell User Mode Navigator.

In the dialog box, find the newly created BIP reports on the right side and move them to the left
side under Reports->Custom.

Save the changes and close the popup window.

Select the project/shell User Mode Navigator and click the Deploy button to ensure the
changes take effect.

Note: Bl Publisher User Group requirement: To be able to create reports,
Users must be added to Bl Publisher Author user group through OIM.

Setting Permissions for Custom Reports

To set permissions for Custom Reports:

1)
2)
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Go to the Company Workspace tab and switch to Admin mode.

Click Access Control in the left Navigator. In the Access Control log window, there are two
modules: Administration Mode Access and User Mode Access.

» If the reports are at the Program level, in the right pane, select User Mode Access
> Programs > Reports > Custom > <report name>.

» If the reports are at the Project level, in the right pane, select User Mode Access
> Shells/Projects (Standard) > Reports > Custom > <Report Name>
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3) Select the access for the appropriate user.
4) Click OK.

Note: A user with the "configure" permission to the Custom Report node,
can configure custom print templates. There are no separate permissions
for performing actions on the custom print templates.

Creating Data Views
You will create data views to operate as data sources for custom reports.
To create a data view:

Note: Refer to the Primavera Unifier Administrator's Guide for more
information.

1) Sign in to your Unifier environment.
2) Click the Company Workspace tab.
3) In the left pane:
a. Switch to Administration Mode.
b. Select Data Structure Setup > Data Views.
4) In the User-Defined Data Views window, click New.
5) Enter the information needed for your data view. See Tips for more information.
6) Click Apply and OK.
7) Highlight the new view and select Status, Published.

Tips
The SQL definition will consist of the SQL query used to populate the report with specific data

based on the desired output.

Note: If using the data view as a Main view in a Project level report, you
must have a column named project_id. If using the data view in a
Program level report, you must have a column named program_id.

For example, a Project level data view for a company registry "companyReg" can be like this
below:

SELECT  pu.PID as PROJECT_ID,

-PROJECTNUMBER as PROJECTNUMBER,

.COMPANYNAME as COMPANY_NAME,

-.SHORTNAME as COMPANY_SHORT_NAME,

.DESCRIPTION as COMPANY_DESCRIPTION,

.CONTACTNAME as COMPANY_CONTACT_NAME,

-.FULLNAME as USER_FULL_NAME,

cC O 0O O O T
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u.USERID as USER_ID,
u.USERNAME as USER_NAME,
u.EMAIL as USER_EMAIL

FROM companyReg_SYS_USER_INFO_VIEW u,

companyReg_SYS_COMPANY_INFO c,
companyReg_SYS_PROJECT_INFO p,
companyReg_SYS_ PROJECTUSER pu

WHERE c.COMPANYID = p.COMPANYID

AND p-PID = pu.PID
AND u.userid = pu.userid

Creating Custom Reports in Unifier

Unifier integrates with Bl Publisher to deliver on-demand web-based reporting through Unifier.

Custom Reports, built in Bl Publisher, enable the Company Administrator (or power user) to build
visually stunning, detailed reports.

Examples

A report that combines information from multiple (and possibly non-linked) Business
Processes (BPs)

A report that needs professional looking graphics, charts, images, or clip arts

The following sections explain the steps you need to take for creating Custom Reports in Unifier
with Bl Publisher.

Download and Install Bl Publisher Desktop for Microsoft Office

1)

2)

Note: For the full list of system requirements, supported software, and
versions, refer to the Tested Configurations document under “Installation
and Configuration Documentation” in the Primavera Unifier Online
Documentation Library.

Download Oracle Bl Publisher Desktop for Microsoft Office
from: http://www.oracle.com/technetwork/middleware/bi-publisher/downloads/index.ht
ml http://www.oracle.com/technetwork/middleware/bi-publisher/downloads/index.html

Ensure that you choose the Bl Publisher Desktop version (32bit vs. 64bit) based on your
version of Microsoft Office 32 bit or 64 bit.

Tip: If your Microsoft Word executable is found at C:\Program Files (x86)\Microsoft
Office\OTTicel2\WINWORD_.EXE, then you have the 32 bit version).

Run the installer.

No additional setup is required after running the installer. To ensure that the installation was
successful, check to see that the plug-in has been added to your Microsoft Word user
interface. The Bl Publisher ribbon appears after launching Microsoft Word.
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(Optional) SQL Text Editor

Once you start to write more complex reports, having a text editor that highlights SQL keywords
can make a big difference. For your needs, a simple editor such as Notepad++ would suffice.
Ensure that you set the Language to SQL. You can copy the queries developed through the text
editor and paste them into the Data View window.

(Optional) SQL Developer

You can download Oracle SQL Developer

from: http://www.oracle.com/technetwork/developer-tools/sqgl-developer/downloads/index.
html http://www.oracle.com/technetwork/developer-tools/sql-developer/downloads/index.
html

1) Download the first option in the list: Windows 64-bit - zip file includes the JDK 7

2) Extract the file onto your computer (for example, C:\Oracle\sqgldeveloper\)

3) Run sqgldeveloper.exe

Review Unifier Database Table Structure
Before building your SQL statement, review the Unifier database table structure.
You can find the Unifier database table name in two ways:

1) Using Entity Reference (ER) Views

1. Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Data Structure Setup > ER
Views.

2. Open Business Processes View.

3. Use your browser search function and search for a BP you want to report against (for
example, Invoices).

4. The name of the table appears under the BP Name, in blue (for example, UNIFIER_UI.
The word "unifier" is the prefix and common to all BP tables. The Ul is the ID of the Invoices
BP).
2) Using BP IDs

1. Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > uDesigner > Business
Processes.

2. Locate the BPs that you want to use in the report and find the IDs (first column).

3. Add your deployment prefix and add an underscore ( _ ) to get the table name (for
example, UNIFIER_UI).

Note: To access the Line Items of a BP, add _LINEITEM to the table name (for
example, UNIFIER_UI_LINEITEM).

The following lists the column names:

» Field Name
» Definition
» SQL Type
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» Label
» Description

Connect to Unifier Database

A direct connection to the Unifier database using SQL Developer is not possible. The creation of
SQL queries must be done in Unifier Data Views, or by pulling rows down from Unifier into a local
database.

If you need to pull the data into a local database for the purpose of SQL development, Oracle
offers Oracle Database 11g Express Edition (XE) free of charge. You can install this lightweight
DB on your computer and use it for development purposes.

To download the Oracle Database 11g Express Edition (XE) free of charge, go
to: http://www.oracle.com/technetwork/database/database-technologies/express-edition/o
verview/index.html

Refer to the XE documentation for instructions on how to install the software and create a local
database.

(Optional) Pulling Down the Data

In Unifier, once you know the table names, you can export 200 lines so it can be inserted into your
local Database (DB). To pull down the data:

1) Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Data Structure Setup > Data
Views.

2) Click New to create a new Data View.
3) Enter a name (for example, Export DV) and a Label (for example, Export Data View).

4) In the SQL Definition field, enter the following for a particular table: SELECT * FROM
<tablename>

5) Click OK.
6) Click the Status drop-down list and set the newly created Data View to Published.
7) Highlight the Data View you just created and click Data on the toolbar.

8) In the window, click Export as SQL on the toolbar to save the .sql file locally. This SQL file
includes the CREATE and INSERT commands required to get your data into your local XE
database.

At this point, you can create the table and insert the exported rows into your local XE database
using tools like SQL Developer.

Repeat the steps above for any tables that you like to access offline.
Note: You can reuse the same Data View multiple times; however, you
need to do find and replace in the downloaded SQL to ensure that the
table names match the names that are in Unifier.

Since you have a subset of the database locally, you can use SQL Developer to write complex
queries, offline, before bringing them into Unifier.
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Writing Your First Statement

1) Create a new SQL file in your text editor of choice.
2) Write the following SQL statement: SELECT * FROM unifier_ui

3) To manage the amount of data generated, select only the columns you want to include in your
report.

» See Review Unifier Database Table Structure for a list of all column names.

» Instead of using the asterisk, or star, ( * ) operator, specify which fields you want to include
in our query result.

4) Replace the asterisk, or star, ( * ) operator in your statement with a few column names (for
example, SELECT project_id, ID, record_no, title, status, UVEVENDORNAMETB50, amount
FROM unifier_ui)

5) Assign an alias to your table to limit the typing that you need to do.
Example

Name you Invoice table "inv" by adding "inv" after the table name. You can then refer to
each column using the alias, instead of the full name. Your statement should look like the
following:

Note: The Query Builder re-formats the layout of your SQL.
SELECT inv.PROJECT_ID,

inv.ID,

inv.RECORD_NO,

inv.TITLE,

inv.STATUS,

inv.UVEVENDORNAMETB50,

inv.AMOUNT
FROM unifier_ui inv

6) Add aliases to the column names to make the column names easier to understand when
building the Bl Publisher report

Example

SELECT inv.PROJECT_ID,
inv.ID AS inv_ID,
inv.RECORD_NO AS inv_record_no,
inv.TITLE AS inv_title,
inv.STATUS AS inv_status,
inv.UVEVENDORNAMETB50 AS vendor,
inv.AMOUNT AS inv_amount

FROM unifier_ui inv

7) (Optional) Choose any other columns from the invoice table that you want to include in your
report.
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Note: Unifier requires a field called "PROJECT _ID" since Unifier uses the filed for data filtering
(for example, Only the Invoices from the project that you are running the report from are
shown). Always leave a field called PROJECT _ID in your main Data View to prevent receiving
an error message when creating the Custom Report.

SQL JOIN

The following scenario describes how use JOIN to combine rows from two or more tables based
on a common column between them.

Scenario

Information is missing in your Invoice report and you cannot find the information in the Invoices
table. Furthermore, you have a column called CREATOR_ID, but the column contains a
number pointing to an ID in another table where all the User information is stored. You also
have a column called PROJECT _ID which points to another table where all the Project
Information is stored.

Solution

To find the table, follow these steps:
Note: You can use other SQL Joins to conduct the following.

Use a LEFT JOIN since this option returns all the rows from the left table (for example,
Invoices) even if there are no matches in the right table (for example, User info table, Project
info table, etc.).

To add the Invoice creator's name, match your CREATOR _ID column from the Invoices table
to you Users table (unifier_sys_user_info_view). You can do so by using a LEFT JOIN on the
USERID column of the User table. Assign an alias (sysuser) to add the information to the end
of your statement:
Example

LEFT JOIN unifier_sys user_info_view sysuser

ON (inv.CREATOR_ID = sysuser .USERID)
Look at the ER Views (System Models View) to see what options are available in your sysuser
table.
Grab the following columns from the table: sysuser.FULLNAME, sysuser .EMAILL,
and sysuser .WORKPHONE.
Add the columns to the end of the SELECT section of your query. Each column specified in the
SELECT portion must have a comma after it, except for the last one.
Access the information about the Project or Shell (name, number, start/end dates, etc.). You
can find this information in the table unifier_us_p, with the column proj -PID that is used to
join the two tables.

Example

LEFT JOIN unifier_us_p proj

ON (inv.PROJECT_ID = proj-PID)
Grab the following columns from the table. and add the columns to the end of the SELECT

section, before the FROM, of your query. Each column specified in the SELECT portion must
have a comma after it, except for the last one.

Example
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proj - UGENPROJECTNAME --> AS ProjectName,
proj . UGENPROJECTNUMBER --> AS ProjectNumber,
proj.UUU_PROJECT_ START_DATE --> AS ProjectStartDate,
proj - UGENPROJENDDATEDO --> AS ProjectEndDate,
proj -UGENINITBUDGETCA --> AS InitialBudget,
proj .UGENREVBUDGETCA --> AS RevisedBudget
Ensure that you see the following codes:
Example
SELECT inv.PROJECT_ID,
inv.ID AS inv_ID,
inv.RECORD_NO AS inv_record_no,
inv.TITLE AS inv_title,
inv.STATUS AS inv_status,
inv.UVEVENDORNAMETB50 AS vendor,
inv.AMOUNT AS inv_amount,
sysuser.FULLNAME,
sysuser.EMAIL,
sysuser. WORKPHONE,
proj.UGENPROJECTNAME --> AS ProjectName,
proj. UGENPROJECTNUMBER --> AS ProjectNumber,
proj.UUU_PROJECT_START_DATE --> AS ProjectStartDate,
proj.UGENPROJENDDATEDO --> AS ProjectEndDate,
proj.UGENINITBUDGETCA --> AS InitialBudget,
proj.UGENREVBUDGETCA --> AS RevisedBudget
FROM unifier_ui inv
LEFT JOIN unifier_sys_user_info_view sysuser
ON (inv.CREATOR_ID = sysuser.USERID)
LEFT JOIN unifier_us_p proj
ON (inv.PROJECT_ID = proj.PID)
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SQL WHERE

The SQL WHERE Clause is used to filter records. Once you attain the the columns that you want,
you can filter the data on any column.

The following scenario describes how use WHERE to filter records.

Scenario
You only want to report on Invoices in an Approved or Pending state.

Solution
Use the following WHERE clause at the end of our statement: WHERE 1nv.STATUS =
"Approved® OR inv.STATUS = "Pending”

Note: You can add multiple filters using the OR and AND operators.

SQL ORDER BY Keyword
The ORDER BY keyword is used to sort the result-set by one or more columns.

You can sort the data in the SQL to save the time it takes for Bl Publisher to generate the report.
Note: The Bl Publisher can also sort the data.

You can use the ORDER BY operator.
Scenario

You want to sort your data first by Project ID and then by Invoice Record Number since that is
the order the data will be reported on.

Solution

Add this to the end of our statement:
ORDER BY inv.PROJECT_ID,
inv_RECORD_NO
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SQL Final Statement
When done with JOIN, WHERE, and ORDER BY, you can save your statement locally.
Example based on the scenarios presented in the previous topics:

SELECT
inv.PROJECT_ID,

inv.ID AS inv_ID,

inv.RECORD NO AS
inv_record _no,

Invoice _
Upper inv_TITLE AS
Form Data| INV_title,

inv.STATUS AS
inv_status,

inv.UVEVENDORNAMET
B50 AS vendor,

inv.AMOUNT AS
inv_amount,

Invoice sysuser . FULLNAME,

Creator
Data sysuser . EMAIL,
sysuser .WORKPHONE,
proj .UGENPROJECTNA |AS
ME ProjectN
ame,
proj .UGENPROJECTNU |AS
. MBER ProjectN
Project umber,
Data
proj.UUU PROJECT S |AS
TART_DATE ProjectS
tartDate,

proj .UGENPROJENDDA |AS
TEDO ProjectE
ndDate,
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proj -UGENINITBUDGE |[AS
TCA InitialBu
dget,
proj -UGENREVBUDGET |AS Note: No comma (, ) on the last line of
CA Revised |the SELECT section.
Budget

FROM unifier_uil inv

LEFT JOIN
unifier_sys user_i
nfo_view sysuser

ON (inv.CREATOR_ID
= sysuser.USERID)

LEFT JOIN
unifier_us_p proj

ON (inv.PROJECT_ID
= proj.PID)

List of tables we’re getting data from,
including the fields we’re using to
match up the tables.

WHERE 1nv.STATUS =
"Approved® OR
inv_.STATUS =
"Pending*

Filtering of the data

ORDER BY
inv.PROJECT_ID,

inv.RECORD_NO

Sorting of the data
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Adding Line Items

When you gathered all the information that you need, from the Upper form and associated tables
(see Writing Your First Statement), you need to add the Line Items to your query results (for
example, Invoice Line Items). The Line Items are stored in the UNIFIER_UI_LINEITEM table.

Example
There are two ways to match the Invoice to the Invoice Line Items:

1) JOIN the Line Items DB Table

By using a LEFT JOIN since it returns all the rows from the left table (Invoices) even if there are
no matches in the right table (Invoice Line Items).

2) Add Line Items

Add the Line Items as a second (separate) SQL statement and have Unifier combine the two
as two separate data views. Invoice Line Items will be a Sub Report View to the Invoices Main
Report.

JOIN the Line Items DB Table

This method of matching the Invoice to the Invoice Line ltems generates duplicate data (by the
number of Line Items in the Invoice) in Bl Publisher. As a result, this method is not recommended.

Add Line Items

This method creates a new SQL query for the Invoice Line Items. This will result in a nested XML
file, where all the Invoices Line Items are nested within their respective Invoice.

To add Line Items as a second (separate) SQL statement follow these steps:

1) Create a new SQL statement in your SQL Text Editor (you can save the new file as
Invoice_LlI.sqgl) and add the following to begin your SQL query: SELECT * FROM
unifier_ui_lineitem inv_li
That is to say, you are going to select all the columns from the unifier_ui_lineitem table and
give the table an alias of inv_li.

2) Specify which columns you want to include in your results.

SELECT inv_I11.RECORD_ID,

inv_1i_LI_NUM,

inv_1i.SHORT DESC,

inv_I1i._.UUU_UNIT_PRICE,

inv_I11._UUU_QUANTITY,

inv_1i_AMOUNT
FROM unifier_ui_lineitem inv_li
This is a Sub Report View in Unifier; therefore, you do not need to include a PROJECT_ID
column. Since Unifier needs to match the Invoice Line Items to the Invoices, you need to
include the field that Unifier can use for the JOIN. You must include the inv_Ii.RECORD_ID

column. If you look at the two tables (and compare it to the data in Unifier), you notice that the
RECORD_ID column in the line item table matches up with the ID column of the Invoice table.

205



Primavera Cloud Service Administrator's Guide

3) Add aliases to these column names so they are easier to understand when you are building
your Bl Publisher report.

SELECT inv_11.RECORD _ID AS inv_li_record no,
inv_Lli.LI_NUM AS inv_li_no,
inv_1i.SHORT DESC AS inv_li1_desc,
inv_1i_UUU _UNIT_PRICE AS inv_li_unit_price,
inv_1i_UUU_QUANTITY AS inv_Ili_quantity,
inv_1i.AMOUNT AS inv_li_amount

FROM unifier_ui_lineitem inv_li

SQL JOIN

Use this method when some data is not stored in the Invoices Line Item table.The following
scenario describes how use JOIN to combine rows from two or more tables based on a common
column between them.

Scenario
You need to find the "unit of measure" name for each line item.
Solution

This appears to be in the table SYS_DATA_OPTION.

Note: Replace "unifier" with your table prefix. See Review Unifier Database Table Structure
for information about finding a table name.

LEFT JOIN SYS_DATA_OPTION sdo

ON inv_1i_.UGENUNITOFMEASUREPD = sdo.OPTION_VALUE
AND (sdo.DATA NAME = "Unit of Measure-

AND sdo.REGISTRY = “unifier"®)

1. Grab the following column from the table: sdo.OPTION_NAME AS inv_Ili_uom and add
them to your SELECT. The goal is to be able to access the cost code number and
description for each line item, which can be found in the table unifier_budgetitem:

LEFT JOIN unifier_budgetitem bi
ON inv_li_BITEMID = bi.BITEMID
AND inv_I11_.BUDGETID = bi.BUDGETID

2. Grab the following columns from the table: bi. CODE & bi.ITEM and add them to
your SELECT.
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SQL ORDER BY Keyword
The ORDER BY keyword is used to sort the result-set by one or more columns.
You can sort the data in the SQL to save the time it takes for Bl Publisher to generate the report.

You can sort the data by Invoice (inv_1i_record_no) and then by Invoice Line Item Number
(inv_Li_LI_NUM): ORDER BY inv_li_record_no, inv_li_LI1_NUM

Note: Since Unifier nests the Line Items within the Invoices and in the
processes making your table easier to read when troubleshooting, sorting
by Invoice is not necessary.

SQL Final Statement

When done with JOIN and ORDER BY, you can save your statement locally.
Example based on the scenarios presented in the previous topics:

Example of a final Invoice Line Item SQL Statement:

SELECT inv_li_RECORD_ID AS inv_li_record_no,
inv_Li.LI_NUM AS inv_li_no,
inv_I1i_.SHORT_DESC AS inv_li_desc,
inv_1i_UUU _UNIT_PRICE AS inv_li_unit_price,
inv_1i_.UUU _QUANTITY AS inv_li_guantity,
inv_1i_AMOUNT AS inv_li_amount,
sdo.OPTION_NAME AS inv_li_uom,
bi.CODE,
bi.ITEM

FROM unifier_ui_lineitem inv_li

LEFT JOIN SYS_DATA_OPTION sdo

ON inv_1i.UGENUNITOFMEASUREPD = sdo.OPTION_VALUE

AND (sdo.DATA_NAME = "Unit of Measure-

AND sdo.REGISTRY = “unifier”®)

LEFT JOIN unifier_budgetitem bi

ON inv_Li.BITEMID = bi.BITEMID

AND inv_I1i.BUDGETID = bi.BUDGETID

ORDER BY inv_li_record no, inv_li.LI_NUM
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Creating a New Custom Report

1)

2)
3)
4)
5)

6)
7)
8)
9)

Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Configuration > Custom
Reports.

Click New to create a new Custom Report (With Internal Data Model).

Enter a name (for example, Invoices) and a description.

For Report Level, choose Project since this report will be run at the Project level.
For Main View, select the Data View that you created.

Note: An error message appears if you do not add PROJECT_ID as one
of the columns in your SQL statement. You can always go back to the
Data View, mark the PROJECT _ID as Draft, correct the SQL statement,
and re-publish.

Click the View tab.
Click Add, on top, to add a new view.
For Main View, select the Data View that you created.

Enter a name and a tag for your data set (for example, Inv for Name and Inv for tag. The same
name for both fields.).

For the Line Items view:

1)
2)
3)

Click Add, on top, to add a new view.
For Main View, specify the View Type as a Sub Report View.

Enter a name and a tag for your data set (for example, Inv for Name and Inv for tag. The same
name for both fields.).

Row

View Name

View Type

Data Set Name

Data Set Tag

0

Invoices

Main View

inv

inv

1

InvoicesLI

Sub Report View

Lineltem

Lineltem

At this point, set the relationship between the Main View and the Sub Report View that you have
added.

1)
2)

3)
4)

Go to the Data Links section and click Add.

Link the ID field, from the Invoices Data View, to the RECORD_ID field, from the Invoices Line
Item Data View.

Example
Source Data Set: inv
Source Element Name: INV_ID
Target Data Set: Lineltem
Target Element: INV_LI_RECORD _NO
Click OK to add to add the link.
Click Apply.
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Building Report Template

Before you begin building a report template, you must have completed the steps in the preceding
sections: SQL statement: Writing Your First Statement > Creating Data Views, Building Custom
Report: Building Report Template >

You can build a Rich Text Format (RTF) template and upload the template to your Custom Report
in Unifier, and generate live reports.

Using Invoice as an example, the following explains how to build a simple RTF template
(non-tabular report).

To create a simple RTF template:

1)

2)
3)

4)

5)

6)

7)
8)

9)

Open Microsoft Word.

The application must have the Microsoft Word Bl Publisher plug-in installed. See Download
and Install Bl Publisher Desktop for Microsoft Office.

Click the Word BI Publisher ribbon.
Click Sample XML to import your sample data and wait until the data is loaded successfully.

Note: Alternatively, you can use a template file (for example, A Word
template file from your customer).

Click Repeating Group to generate a loop on each Invoice. The Repeating Group window
opens.

In the For Each field, enter a value in the Data Set Name for each of the Invoices that you
chose, when defining your Custom Report (for example, inv). This does not apply to the
Invoices Line Items.

In the Group By field, select a field for your Invoice loop. Use the INV_ID because itis a
unique identifier for each Invoice.

(Optional) Insert a page break after each Invoice to keep your report formatted.

(Optional) Select the Data already sorted option. You can select this option because you have
already sorted your data in your SQL statement, using: ORDER BY.

Click OK.

The Bl Publisher plug-in application adds a code to the document which includes: a start
(for-each), a page break (page break), and an end (end) for your Invoice loop.

10) Add a blank line after "for-each" operator to make room for your Invoice information.
11) Click the field icon (ab|Field) to open the field browser.

The field browser window enables you to add fields from you XML sample data file.

12) After each "for-each" operator, double-click Inv_Record_No in the field browser.
13) Add a hyphen ( —) [n-dash] after the record number.
14) Double-click Inv_Title to add the Invoice title.

Example
for-eachINV_RECORD_NO-INV_TITLE

page breakend
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15) (Optional) Run the report by clicking PDF on the Word Bl Publisher Ribbon (Word will prompt
you to save your RTF file if you have not, already).

The first report is now ready.

The report only has the Invoice record number and title for each Invoice in your sample XML (the
approved and pending ones because: WHERE i1nv.STATUS = "Approved” OR inv.STATUS
= "Pending” in our SQL statement).

You can continue to build on the generated report by adding additional fields from the Upper Form
of the Invoices BP, as well as headers, footers, formatting, and so forth.

Creating a Report with Line Items

You can use the Table Wizard to create a report with all the Line Items.

Using Invoice as an example, the following explains how to create a report with Line Items:

1) Add a blank line after for-eachINV_RECORD_NO - INV_TITLE operator and leave your
cursor.

2) Click Table Wizard on the Word Bl Publisher Ribbon.

3) Select Table as your Report Format and click Next.

4) Select /DATA_DS/Inv/Lineltem as your Data Set (or the nhame that you had given your Line
Item data set).

5) Select the fields that you want to add to the table. Since this is for the Invoice line items, you
must only add fields that are specific to the line items.

If you need to add a field for "group on" (for example, Inv_Li_Record_No), the grouping
process is similar to the process explained in the preceding section. Since you have grouped
the records by Invoice in the preceding section, you can leave the value blank.

The order of the selected columns must match the order that you want in your table, except for
the column that you use for grouping, which is outside the table. In the "Which fields do you
want to show in your report" window, match the order as shown here:

Inv Li Record No -->InLiRecord
Inv Li No-->Inv LiNo

Inv L1 Desc -->Inv Li Desc

Inv LT Unit Price -->Inv Li Unit Price
Inv Li Quality --> Inv Li Quality

Inv Li Amount --> Inv Li Amount

Inv LT Uom-->LiUom

Code --> Codelnv

Item --> Item

6) Inthe "How would you like to group your report" window, leave every option as is because you
have already grouped your data by Invoice in the preceding section.

7) Inthe "Which fields would you like to user to sort the data" window, within each table, sort the
lines by Inv_Li_No (Invoice Line Iltem Number). Specify that this is a Number so that it is sorted
correctly.
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8) Click Finish.
The Table Wizard inserts the table and the necessary code:
for-eachINV_RECORD_No - INV_TITLE

Inv Li No Inv Li code |item Inv Li Inv Li Inv Li Unit Inv Li
———|Desc Quantity Uom Price Amount

F INV_LI_ D |CODE |ITEM |INV_LI_ QU |INV_LI_ |INV_LI_UNI|INV_LI_AM
INV_LI_ |E SC ANTITY UOM T PRICE OUNT E
NO

page breakend

You must run the report to see what information is generated. While the data is correct, you need
to work on formatting the data. See the following topic.

Formatting Data
To format the data generated:

» Provide a descriptive text (not SQL column names) for Column titles.

» Adjust the Column widths.

» Apply general table coloring (borders and shading, font sizes, cell alignment, etc.).
4

Ensure that the "dollar” format is used for the two price columns (for example, $110.00). See
the details that follow.

» Add useful information, from the Upper Form of the Invoice, above the table. See the details
that follow.

» Provide a "Total" for the amount column. See the details that follow.
Once finished, generate a PDF and repeat the process if necessary.
To change the formatting of the Price & Amount columns (for example, 110.0 > $110.00):

1) Double-click on INV_LI_UNIT_PRICE (the code under the Unit Price field) to launch its Bl
Publisher properties.

2) Change the Formatting Type to Number.

3) Set the Formatting Format to $#,##0.00; ($#,##0.00) (paste in the blue text).

4) Repeat the preceding steps for the Amount column.

To add useful information, from the Upper Form of the Invoice, above the table:

Note: Tables are efficient formatting tool for organizing data from the
Upper Form. Include separate columns for the field name (align right) and
the field value (align left). You can also hide the borders if you prefer.

1) Create a 4-row and 2-column table and add field names.
2) Place your cursor where the first inserted field value must be entered.
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3)
4)

5)

Click the field icon (ab|Field) to open the field browser and add fields from your XML sample
data.

Add useful information such as Creator, Email, and Status (or other fields you added to your
SQL statement) above our Line Item Table.

Double-click on the correct field value from the Field window to add the Title to the report (for
example, add Invoice title in the Title field).

To provide a "Total" for the amount column, using Invoice as an example:

1)
2)

3)
4)
5)
6)

7)
8)
9)

Right-Click somewhere in the last row of your Invoice Line Item table and
select Insert > Insert Rows Below.

Highlight all the columns in the new row, except for the last one, and Merge the cells (from the
right-click menu).

Click in the newly created cell and enter: Total
Right-align the cell.
Place your cursor into your last column of the new row.

Click the field icon (ab]|Field) to open the field browser and add fields from your XML sample
data.

Click Inv_Li_Amount column to highlight.
Set the calculation (at the bottom) to Sum.
Click Insert to add the calculation into the table.

10) (Optional) Select the Total row and make the text bold.
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Adding Summary Page to Report

Your report lists details. The Summary page contains a table with a summary of all the details (for
example, Invoices) as well as charts to add graphical information.

To add a summary page to your report, using Invoice as an example:

1) Add Project information.

In preceding sections, you have set your template to loop through each Invoice. In order to
create a summary page, you need to include the following information:

2)

a.

b.
C.

e.

Using Word, insert a page break before the "for-each code" at the top of the document. Do
not use the page break command in Bl Publisher.

Add a title to the Summary page (for example, Invoice Report).

Click the field icon (ab|Field) to open the field browser and add information about the
project, if you have not done so in your SQL statement.

Add additional information about the Project below the title (in a table) such as the Project
number, Project name, Start/End dates and Initial/Revised budgets.

Format dollar values as numbers with the formatting $#,##0.00; ($#,##0.00). You can
format dates as type Date using date formatting options such as: MM/dd/yyyy

Add Summary table.

A summary table contains the Invoice data that goes in the report. You can use the Table
Wizard, similar to the process in the "Creating a Report with Line Items" section.

a.

®ooo

Place the cursor on a new line under the table on the title page, where you want your table
of Invoices to appear.

Click Table Wizard on the Word BI Publisher Ribbon.
Select Table as your Report Format and click Next.
Select /DATA_DS/Inv as your Data Set (or the name you used in your Invoice data set).

Select the fields that you want to add to the table. Since this is for the Invoice, you must
only add fields that are specific to the Invoices and not the Invoices Line Items.

You do not need to group because your SQL statement provides one line per Invoice.

Sort by Invoice Record Number, in the "Which fields would you like to use to sort the data?"
window.

Click Finish. The Table Wizard inserts the table and the necessary code.
Format the data. See Formatting Data for details on how to format the data.
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Adding a Chart

Using Invoice as an example, you can include a chart in the summary page to demonstrate how
the Invoices are split.

There are several chart types available in Bl Publisher. The following is for creating a Pie-chart.

To add a pie chart:

1)

2)
3)
4)
5)

6)

7)

8)
9)

Place the cursor above the summary table. The goal is to include the chart between the Project
summary table and Invoice summary table because the table can get long and expand to the
next page.

Click Chart on the Word BI Publisher Ribbon.
Set the Chart Type (on the right) to Pie Chart.
(Optional) Select one of the Chart Styles.

Drag Inv_Amount from the Data tree to the Values box to ensure that the size of each pie slice
is determined by the dollar amount of the Invoice.

Drag Inv_Title from the Data tree to the Labels box to ensure that the:
» Pie slices are determined by Invoice
» Invoice Title appears in the legend

(Optional) Click Preview (top right corner) to see a preview of the chart and make changes if
necessary.

(Optional) Use the Properties table on the right side to set Chart Title, Legend properties, etc.
Click OK. You change the chart settings by double-clicking the chart in the template.

10) (Optional) Add spacing between the chart and the two tables and center-align the chart.

Adding Headers and Footers

Use a 3-column table in the header and footer of your template to allow for a uniform adjustment of
items such as titles, logos, and page numbers. Use Microsoft Help to learn how to add the first
page to your document that does not include Header or Footer.
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Adding Images from Unifier

Note: Microsoft Word does not support form fields in the header and
footer. If need to add an image to the header or footer of your Custom
Report and you want the image to repeat on each page, see the "Adding
Bl Fields to the RTF Header or Footer" section.

To add an image (Examples: Company logo, Shell image, or image picker from a BP record: jpg,
gif, or png) from Unifier into your Custom reports, use the Sample XML file (Sample Data) that you
have created and exported into Unifier.

Note: Company logo cannot be displayed in Unifier interface. Create a
company-level business process to place your Company logo.

The following shows the procedure by using an example:

1)
2)

3)

Open the XML file.
On top, identify the XML elements that are blank (shown in bold in the following code).
<?xml version="1_.0" encoding="UTF-8"7>
<DATA_DS>
<uuu_p_reportByF></uuu_p_reportByF>
<uuu_p_timeZoneF></uuu_p_timeZoneF>
<uuu_p_diffMinutesF>0</uuu_p_diffMinutesF>
<uuu_p_sysyTimeZonelD></uuu_p_sysyTimeZonelD>
<uuu_p_searchConditionF></uuu_p_searchConditionF>
<uuu_p_urlF></uuu_p_urlF>
<uuu_p_sessionldF></uuu_p_sessionldF>
<uuu_p_companyRegistryF></uuu_p_companyRegistryF>
<inv>
<PROJECT_1D>1012</PROJECT_ID>
<INV_ID>1</INV_ID>
<INV_RECORD_NO>INV-001</INV_RECORD_NO>
<INV_TITLE>Lumber Contract - Initial Invoice</INV_TITLE>
<INV_STATUS>Approved</INV_STATUS>

Note: At runtime, these blank elements are fully populated with
information about the Unifier server base URL, the User’s session ID, and
the Unifier company registry.

Using the included parameters, plus the ID of a specific image (the image that you want),
construct a URL of the format:

<uuu_p_urlF>CompanyRegistry=<uuu_p_companyRegistryF>&sessionld=<uuu_
p_sessionldF>&id=<image_ID>
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Note: To build a similar URL in your Bl Publisher report, ensure that you
have the Image ID because the other three parameters have already been
identified.

4) Access the Image ID of the image that you want and:

a.

Note: If applicable, you can find the Company logo Image ID in the
companylogo column of the table sys_company_info.

JOIN the information into your existing Data Views.
or

Add the information as a new Data View, which you can add as a Sub-Report View to any
Custom Report. The SQL to create a new Data View:

SELECT companylogo
FROM sys company_info
WHERE companyregistry = “unifier”;

5) Define the variables:

Once you have an Image ID, you must define the variables needed to build the image URL by
hiding the variables in a Data Field:

a.

b.
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Add a data field somewhere at the top of your report. This can be any field. You only need
a placeholder for your variables.

Double-click on the newly added data field and click the Advanced tab. Delete the text in
the code box, if any.

Add the following text into the code box:

<?variable@begin:zuuu_p urlF;(.//uuu_p_urlF)[1]?>
<?variable@begin:uuu_p companyRegistryF;(.//uuu_p_companyRegistryF
d[1]?>

<?variable@begin:uuu_p_ sessionldF;(.//uuu_p_sessionldF)[1]?>
<?variable@begin: image;(/DATA_DS/co/COMPANYLOGO)?>

Notes:

= [f you are adding a Shell image or Image Picker Data Element, you do
not need that last line. Add the last line only if you have created a
Company log Data View (If applicable, you can find the Company logo
Image ID in the companylogo column of the table sys_company_info).

= The example code presumes that you added an unlinked Sub Report
View with the Data Set Tag “co” (for Company). You can change the
Data Set Tag “co” (for Company) to the value that you have in the last
column of Company Logo row in the Views used as data sets table on
the Views tab of the Custom Report dialog.

= If you want to insert the Project Shell ID, you must access that
variable. Depending on where you are in your grouping, the variable
can be: <?variable@begin: image; (SHELLIMAGE) [1]?>
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To access the Project or Shell Image ID:

1) Go to table: unifier_shell_info.
2) ldentify the shellimage column of the table. The Project or Shell Image ID is in the shellimage
column.

You can JOIN this table to your main report view based on the unifier_shell_info.pid column,
which contains the project ID.

After you defined your variables, you can add an image. The Bl Publisher leverages the
Alternative Text of an image to dynamically set the image source. For more information, refer to
the BI Publisher Report Designer’s Guide.

To add a dummy image:

1) Create an image (for example, Dummy_Image.jpg) and size it appropriately (for example, 300
x 200 px).

2) Right-click on the image and select Size...

3) Click the Alt Text tab of the Size dialog

4) Paste the following into the Alternative Text
box: url:{concat($uuu_p_urlF, "companyRegistry=",%uuu_p_companyRegistr
yF, "&sessionld=",%uuu_p_sessionldF, "&id=",$image)}

Note: The last parameter ($image) was set as a variable to either the
Company logo or the Project or Shell image. You must adjust the
parameter if you want to include both images. Ensure that you use
separate variable names for each.

To test an image:

The three parameters that you used to build your URL to the image are not downloaded as part of
the sample data:

uuu_p_urlF
uuu_p_sessionldF
uuu_p_companyRegistry

You must upload your RTF template to Unifier, publish the Custom Report, and then run the report
to ensure that your image was inserted successfully.
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Adding Bl Fields to RTF File Header or Footer

Microsoft Word does not support form fields in the header and footer. As a result, you need to
populate the headers and footers with text or images from Unifier. Refer to the Bl Publisher Report
Designer’s Guide for more details.

To populate the headers and footers with text or images from Unifier, follow these steps:

1)

2)

3)

4)

At the top of our RTF template (in the body, not the header), place the following tags:
<?template:header?>

<?end header?>

These tags form the start and end of our header. In between them, place the text and images

want to include in the report header. Use a 3-column table in the header and footer of your
template to allow for a uniform adjustment.

Double-click into the header of the document. Ensure that none of the Bl Publisher fields are
highlighted.

Add the text: <? call@:header?> to place everything in the tags added above into the header
at report runtime.

Importing Template into Unifier

After you have completed creating your Template, you can upload your template into Unifier.

To upload your template into Unifier:

1)

2)
3)

4)
5)
6)

Note: Invoices is used as an example.

Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Configuration > Custom
Reports.

Open your Invoices Custom Report.
In the Report File tab (consisting of Add, Modify, Remove, and Download options)
a. Click Add to open the template window.

b. Enter information in the following fields: Template Name, Template Type, and Report
Layout File.

= To localize the Custom Report output for different languages, you can provide
XLIFF files for RTF-type templates here.

= The Template Name field accepts spaces and other characters.
c. Click Browse to select the template file for uploading.
d. Click OK to confirm the upload.
Click Browse and upload the RTF file.
Click OK to close the window.

Publish your report by selecting your report from the log and
selecting Status > Published from the toolbar.

Your report is added to list and Users can access the report from Projects, if they have the
appropriate permissions.
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Adding Report to Navigator
To add your report to the Navigator:

1) Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Configuration > Navigator (User
mode).

2) Open your Project or Shell Navigator. You must be able to see your Custom Report on the
right-hand side. If you do not see your Custom Report ensure that you have published the
report. See Importing Template into Unifier.

3) Add your Custom Report to the Reports section on the left-hand side (in the Navigator, you can
create a new subfolder under Reports called Advanced Reports).

4) Click OK to close the window.
5) Deploy the Navigator by highlighting it and clicking Deploy from the toolbar.

Setting Permissions on Report

You (Company Administrator) must give permissions to the Users so the Users can run the new
Custom Report.

You can give permissions using a Project template (to distribute the permission to all projects), or
do it on case-by-case bases, one Project at a time.

To set permissions:

1) Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Company Sponsored Shells
> Projects.

2) Find your Project (the project that you want to add the Custom Report to) and open.
3) Click Access Control.
4) Go to the Custom Report, click the report to open the Permission Settings window.

5) Add View access for any Users or Groups that you want to be able to run the Custom Reportin
your Project.

Repeat the preceding steps if you wan to add your Custom Report to other Projects.

Running the Report
To run your Custom Report:

1) Navigate to you Project that has your Custom Report (for example, The Project with Invoice
BPs created and in an approved or pending state)

2) Run the report.
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Advanced Bl Publisher Functions

The following topics explain the advanced functions of the Bl Publisher.

Conditional Formatting

With BI Publisher, it is easy to use conditional formatting to highlight table cells or entire table rows
using conditional formatting.

Example

Highlight invoices with an amount over $10,000.

Highlighting a Table Cell
1) After you create atable, place the cursor in the cell where want to apply conditional formatting.

Note: The cell must be be either text or a Data Field.

2) Click Conditional Format. The Bl Publisher Properties window open on the Properties tab.

3) From the Data field drop-down list select the data element that you want to evaluate to
determine the conditional highlighting. This does not need to be the same data field in the cell
that you are trying to highlight.

4) Specify whether that Data Field is a Number or Date/Text Field.

5) Enter the conditions for this Data Field using the pertinent drop-down list.

6) For each condition, specify the formatting that you want to be applied when that condition is
met.

Only two conditions can be entered by using this window. If you have more than two conditions,
you can click on the Advanced tab and copy/paste the conditions already entered to create

additional conditions. Ensure that you copy an entire “if” statement, up to and including the “<?end
if2>"

Example

<?if:number(INV_AMOUNT)>10000?><?attribute@incontext:background-colo
r; "#FFBO9B9"?><?end ift?>

Highlighting an Entire Table Row

To highlight an entire table row, follow the preceding instructions; however, ensure that you
select Apply to Entire Table Row.
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Search Parameters and Additional Parameters
When creating, you can specify two types of parameters before running a report:

» Search Parameters

Use these to filter the SQL results. Data View result rows that do not match the filter will not be
sent from Unifier to Bl Publisher.

» Additional Parameters

Use these to pass additional parameters for Bl Publisher to consume at runtime. All values are
sent from Unifier to Bl Publisher for further operation.

Search Parameters

Search parameters allow the report runner to filter the data that gets sent to Bl Publisher. For
example, a Contract Report may need to be filtered by Vendor or Contract Type. A Ball-in-court
report may be filtered for a specific task assignee, or task type.

At runtime, the report runner can select or multi-select from a list of values based on the search
parameters specified in the report configuration. This means that Unifier basically runs the Data
View before the report is run to give the report runner a list of the SQL results. He can then select
or multi-select values from this initial run to filter what will appear in the report output. For more
information on the Search Parameters,refer to the Unifier Help topic: Add query parameters to
custom report (Query tab).

Example
The following are instructions for filtering your Invoices Report on Invoice Vendor:

1) Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Configuration > Custom
Reports.

2) Put your Invoices Custom Report in Draft mode and open the report.
3) Click on the Query tab.
4) Click Add.
5) Populate the field as follows:
» Element Name: VENDOR
» Label: Vendor
» Operator: Equals
» Source Type: View
» Select View: Invoices
» Value Column: VENDOR
» Label Column: VENDOR
» Selection Type: Multiple
6) Click OK to add the Query.
7) Click OK to save your changes.
8) Publish the report.
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Note: You can only add queries on your Main View (not Sub Report
Views).

Upon running the report, the report runner display the Invoice Query window. When you click
Select, Unifier runs the Data View that you selected (Invoices) to get a list of all the VENDORS that
would be returned if there were not filters. Multi-select your Vendors by using the Ctrl key. Enter
text in your report to indicate that it was run using a query. We can access the value specified by
the report runner via a top-level field.

Additional Parameters

Additional parameters allow the report runner to specify parameters that can be used at report
runtime to alter how the data is displayed.

Unlike Search Parameters:

» Additional Parameters only support entering text. You cannot select or multi-select values
from Unifier.

» Additional Parameters allow us to specify a default value so that the user only needs to change
the value if needed.

A good example of where to use Additional Parameters is for calculations, for example, when you
enter a target future exchange rate. You can also use Additional Parameters for conditional
highlighting so that only rows over/under a certain value are highlighted.

Note: In the section Conditional Formatting, You need to hard-code a
value (for example, 10,000).

The following are instructions for conditionally highlighting Invoices based on amount in our
Invoices Report:

1) Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Configuration > Custom
Reports.

2) Put your Invoices Custom Report in Draft mode and open the report.
3) Click the Parameters tab.
4) Click Add.
5) Populate the field as follows:
» Row: 0
» Editable: [Select]
» Hidden: [Do not select]
» Name: Amount
» Label: Highlight Amount
» Default: 20000

Note: When running the report, the selections add parameter called

‘Amount’, with label ‘Highlight Amount’ and an editable value of 10000 in
the Additional Parameters box.
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Click OK to save your changes.
Publish the report.

If you run the report at this stage, you see no changes because unlike Search Parameters, all the
same data is passed to Bl Publisher. You need to add some additional logic to your RTF template
to use this new ‘Amount’ parameter.

1)
2)
3)

4)
5)

Sign in to Unifier as a Company Administrator and go to the Company tab (Company
Workspace), ensure that you are in Administration mode > Configuration > Custom
Reports.

Put your Invoices Custom Report in Draft mode and open the report.

Download the new Sample Data for your project. A new top-level parameter is generated in
your Sample XML: <uuu_p_Amount>10000</uuu_p_Amount>

Open your RTF template and import the new Sample XML file so you can add the logic.

Define a new variable somewhere at the top (as we did in Defining the Variables) as
follows: <?variable@begin:uuu_p_Amount; (.//uuu_p_Amount)[1]?>

To use the variable, you can call Suuu_p_Amount instead of your hard-coded 10000 in our
conditional statement (assuming you already followed the instructions in Conditional Formatting).

1)

2)

3)

4)

Double-click on the ‘C’ Conditional Formatting field that you added to the Amount cell in the
Conditional Formatting section

Ensure that you see the following on the Advanced
tab: <?1f@row:number (INV_AMOUNT)>10000?><?attribute@incontext:backgrou
nd-color; "#F8DADB"?><?end if?>

Replace the ‘10000’ with ‘$uuu_p_Amount
‘. <?i1f@row:number (INV_AMOUNT)>$uuu_p_Amount?><?attribute@incontext:ba
ckground-color; "#F8DADB"?><?end if?>

Click OK.

If you run the report, you see the same behavior as before because the value in your Sample XML
is the same as the value you hard-coded before (10000).To test:

1)

2)
3)
4)
5)
6)

Open the Sample XML file that you have downloaded (in notepad) and update the value
of uuu_p_Amount to a value lower (for example, 5000).

Save the XML file and re-run the report. The Invoices over $5,000 are now highlighted in red.
Upload the new RTF template into your Custom Report in Unifier.

Click OK to save your changes.

Publish the report.

Proceed to test the Custom Report in Unifier. Since the ‘Amount’ parameter is editable, you
can update the parameter before running the report.
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Adding Permissions to Run Bl Publisher Reports

These steps apply to sample custom reports and may not apply for every report.
To add permissions to run reports:

1) Go to the Company Workspace tab and switch to Admin mode.
2) Select the User Mode Navigator.

3) Open the Project / Shell navigator.

4) Under Reports, create a Custom Reports node.

5) Change the icon to u_report_select.gif.

6) Under the Custom Reports node, add the new report.

7) Click OK.

8) Highlight the Project / Shell navigator.

9) Select Deploy to apply changes.

10) Go to the Company Workspace tab and switch to Admin mode.
11) Navigate to Company Sponsored Shells, All Projects.

12) Highlight All Projects in the right window pane and select Open.
13) Select Access Control.

14) Navigate to User Mode Access, Reports, Custom Reports.
15) Select the custom report.

16) Add users to allow access to reports.

17) Click Apply and OK.

Running the Bl Publisher Report in Primavera Unifier

To run the BI Publisher Report in Unifier:

1) Sign in to your Unifier environment.

2) Select a Project or Shell.

3) Ensure you are in User mode.

4) Under the Project/shell navigation tree, select Reports, Custom node.
5) Select a report and a dialog box will open.

6) In the dialog box, enter the search conditions and click Report to run the report.
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User Productivity Kit Setup Tasks

User Productivity Kit (UPK) is an Oracle product that you can purchase and use to create
instructions (tutorials) to demonstrate how to perform tasks in other Oracle products. You can
create published player files to demonstrate Primavera product functionality in the cloud.

To connect UPK and a Primavera product in the cloud:
» Submit a service request in My Oracle Support.
To access your published player files in the cloud:

» Upload your published player files to a locally hosted web server and then submit a service
request in My Oracle Support to configure its connection to the cloud.

» Submit a service request in My Oracle Support with your published player files. Oracle will host
your published player files and provide you access to them in your cloud environment.
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Where to Get Documentation

The complete documentation set that you will need for your cloud solution can be found on the
Oracle Technology Network (OTN) at:

http://docs.oracle.com/en/

From this location you can view the latest product documentation which can be updated to contain
critical corrections and enhancements. Since this guide has been designed for cloud
administrators, cloud administrators can ignore the installation, system configuration, and system
administration documentation that they might find in the product libraries on OTN.

The following table lists the product libraries that are associated with your cloud solution, the
release level for the products that you are using, and the URL of the product library:

Product Library Release Level URL

Oracle Primavera 15 R2 http://www.oracle.com/tech
network/apps-tech/primaver
a/documentation/index.html

Oracle Fusion Middleware |11g R2 (11.2.2) http://www.oracle.com/tech

(Oracle Identity Manager) network/middleware/id-mg
mt/documentation/index.ht
mi

Bl Publisher 11g (11.1.1) http://www.oracle.com/tech

network/middleware/bi-publi
sher/documentation/index.h
tml

BPM 12c (12.1.3) http://www.oracle.com/tech
network/middleware/bpm/d
ocumentation/index.html
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Distributing Information to the Team

You can copy the online documentation to a network drive for access by project participants.
Team members can then view or print those portions that specifically relate to their roles in the
organization. However, Oracle recommends that you always use the online documentation since it
can be updated to include critical corrections and enhancements.

Where to Get Training

To access comprehensive training for all Primavera products, go to:

http://education.oracle.com

Oracle Learning Library

The Oracle Learning Library (OLL) provides online learning content covering Primavera products.
Content includes whitepapers, videos, tutorials, articles, demos, step-by-step instructions to
accomplish specific tasks, and self-paced interactive learning modules.

To access the learning library’s Primavera content, go to:

http://www.oracle.com/oll/primavera

To access UPK content for Primavera Cloud Administration on the learning library, go to:

http://www.oracle.com/webfolder/technetwork/tutorials/primavera/OnlineLearning/Tutorials/Cloud
Users/index.html

Where to Get Support

If you have a question about using the Oracle products that you or your cloud administrator cannot
resolve with the information in the documentation or help, click http://support.oracle.com/. This
page provides the latest information on contacting Oracle Global Customer Support, knowledge
articles, and the support renewals process. For more information about working with Support, visit
https://support.oracle.com/epmos/faces/DocumentDisplay?id=888813.2 to view Support Tools
& Tips.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information,
visit http://www.oracle.com/us/support/contact-068555.html or visit
http://www.oracle.com/us/corporate/accessibility/support/index.html if you are hearing impaired.
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Using Primavera's Support Resource Centers

Primavera’s Support Resource Center provides links to important support and product
information. Primavera's Product Information Centers (PICs) organize documents found on My
Oracle Support (MOS), providing quick access to product and version specific information such as
important knowledge documents, Release Value Propositions, and Oracle University training.
PICs also offer documentation on Lifetime Management, from planning to installs, upgrades, and
maintenance.

Visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=1486951.1 to access links to
all of the current PICs.

PICs also provide access to:

» Communities which are moderated by Oracle providing a place for collaboration among
industry peers to share best practices.
News from our development and strategy groups.
Education via a list of available Primavera product trainings through Oracle University. The
Oracle Advisor Webcast program brings interactive expertise straight to the desktop using
Oracle Web Conferencing technology. This capability brings you and Oracle experts together
to access information about support services, products, technologies, best practices, and
more.
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The information contained herein is subject to change without notice and is not warranted to be
error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone
licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated
software, any programs installed on the hardware, and/or documentation, delivered to U.S.
Government end users are “commercial computer software" pursuant to the applicable Federal
Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication,
disclosure, modification, and adaptation of the programs, including any operating system,
integrated software, any programs installed on the hardware, and/or documentation, shall be
subject to license terms and license restrictions applicable to the programs. No other rights are
granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management
applications. It is not developed or intended for use in any inherently dangerous applications,
including applications that may create arisk of personal injury. If you use this software or hardware
in dangerous applications, then you shall be responsible to take all appropriate failsafe, backup,
redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates
disclaim any liability for any damages caused by use of this software or hardware in dangerous
applications.

This software or hardware and documentation may provide access to or information on content,
products and services from third-parties. Oracle Corporation and its affiliates are not responsible
for and expressly disclaim all warranties of any kind with respect to third-party content, products,
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or
damages incurred due to your access to or use of third-party content, products, or services.
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